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Введение

Сегодня невозможно представить процесс разработки лекарства без использо-
вания компьютерной химии. Молекулярный докинг, QSAR (англ. Quantitative Struc- 
ture-Activity Relationship), структурно-ориентированный виртуальный скрининг, вир- 
туальные библиотеки – понятия, прочно закрепившиеся в современной медицин-
ской химии.

Данный лабораторный практикум направлен на ознакомление с основными 
инструментами молекулярного моделирования, а также приобретение некоторых 
навыков работы в этой области, которые могут пригодиться вам в собственных ис-
следованиях.

В ходе выполнения лабораторных работ вы сможете ознакомиться с протокола-
ми подготовки структур белков и лигандов, различными методами конформационного 
поиска, фармакофорного моделирования и скрининга. В практикуме подробно разо-
браны процедуры выполнения молекулярного докинга (а также ковалентной и инду-
цированной стыковки).

Практические указания к каждой лабораторной работе предваряются небольшим 
теоретическим введением со ссылками на оригинальные источники. Для успешной за-
щиты работы настоятельно рекомендуется ознакомиться с источниками, приведенны-
ми в списке литературы.
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Лабораторная работа 1

ОСНОВЫ РАБОТЫ В MAESTRO. 
ПОДГОТОВКА СТРУКТУР 
ЛИГАНДОВ И БЕЛКА

Цель работы: освоение основных подходов к подготовке структур биологической 
мишени и лиганда для задач молекулярного моделирования. 
Вам предстоит:
1)	 получить начальные навыки работы с графическим интерфейсом Maestro;
2)	 познакомиться со стандартным протоколом подготовки моделей белков, полу-

ченных методом рентгеноструктурного анализа (РСА), с помощью инструмента 
Protein Preparation Workflow [1, 2];

3)	 познакомиться со стандартным протоколом подготовки структур лигандов с по-
мощью инструмента LigPrep [1, 3];

4)	 получить начальные навыки поиска структур белков в Банке данных белковых 
структур (англ. PDB, Protein Data Bank) [4].
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Теоретическое введение

Для выполнения большинства задач CADD (англ. Computer-Aided Drug Design), 
будь то виртуальный скрининг, моделирование молекулярной динамики или фарма-
кофорный поиск, требуются качественные и готовые к работе структуры белков и ли-
гандов. Данная лабораторная работа посвящена ознакомлению с общими подходами 
к их подготовке. 

Долгое время рентгеноструктурный анализ являлся единственным способом по-
лучения моделей протеинов. Однако использование РСА таит в себе несколько недо-
статков, в частности сложности кристаллизации белка, а также неточности и ошибки, 
возникающие из-за фазовой проблемы. В структурах белков, решенных рентгенострук-
турным анализом, отсутствуют атомы водорода, связи не имеют корректного порядка, 
а некоторые боковые цепи белка и вовсе могут отсутствовать. Кроме того, конформа-
ция белка в кристалле – совсем не то же самое, что конформация белка в среде био-
логической жидкости (здесь, однако, стоит отметить, что ячейка кристалла содержит 
большое количество молекул растворителя, а белки удалены друг от друга, так что 
для большинства глобулярных протеинов серьезных конформационных отклонений 
наблюдаться не будет) [4]. Процесс определения структуры с помощью методов РСА 
будет рассмотрен более подробно.

Обязательное условие для проведения РСА – наличие кристалла, и в этом скры-
вается первый существенный недостаток данного метода определения структуры. 
На качество получаемых кристаллов оказывает влияние большое число факторов: рН, 
температура, концентрация соосадителей, концентрация, степень очистки и размер 
самого белка, тип буфера. Путь к выращиванию пригодного для анализа образца в пер-
вом приближении требует оптимизации всех этих параметров и условий, и не зря отме-
чают, что кристаллизация белков – больше искусство, чем наука [4]. Примеры «хоро-
ших» кристаллов представлены на рис. 1.1.

Рис. 1.1. Кристаллы человеческого инсулина, выращенные в условиях микрогравитации [5]

Облучение образца сфокусированным пучком мощного монохроматического 
рентгеновского излучения (получаемого на синхротронных ускорителях) приводит 
к дифракции лучей на кристаллической решетке. Отраженные на электронах регуляр-
но расположенных атомов лучи формируют дифракционную картину (рентгенограмму), 
интенсивность рефлексов на которой фиксируют с помощью детекторов (рис. 1.2).
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Рис. 1.2. Упрощенная схема установки и дифракционная картина мембранного белка [6]

Из обработанных данных рентгенограммы можно получить карту электронной 
плотности 𝜌(r) в элементарной ячейке кристалла: 

, 

, 

где 𝜌(r) – функция электронной плотности, V – объем элементарной ячейки, r – век-
тор координат, h (h, k, l) – вектор, описывающий расположение атомных плоскостей  
в кристалле (и характеризующий рефлексы на дифракционной картине), а коэффици-
ент Fh – так называемый структурный фактор, который может быть представлен в виде 

, 

, 

где 𝜑h – фаза.
Квадрат модуля структурного фактора |Fh|2 связан с интенсивностью отражения,  

и с его помощью можно было бы вычислить электронную плотность в объеме элемен-
тарной ячейки, однако информация о фазе теряется в ходе проведения эксперимента.  
О методах решения фазовой проблемы можно узнать подробнее в [4].

Следующий этап заключается в интерпретации и уточнении полученной карты 
электронной плотности, а также попытке построения приближенной атомной моде- 
ли белка на ее основе. Построение модели требует внимания со стороны оператора, 
и, наверное, самым важным фактором, который может привести к ошибкам, является 
разрешение (англ. Resolution) – мера уровня детализации, с которой рассматривается 
белок. При разрешении 4 Å можно различить общую форму макромолекулы и некото-
рые элементы вторичной структуры, при разрешении 3 Å становится очевидна главная 
цепь и формы боковых цепей; при разрешении 1 Å можно распознать отдельные атомы 
и даже идентифицировать их тип (рис. 1.3) [7]. На практике рекомендуется использовать 
структуры, обладающие разрешением ≤ 2.5 Å.

Рис. 1.3. Наглядная иллюстрация легкости интерпретации данных карт электронной плотности 
при различном разрешении на примере остатка триптофана [7]



7

Лабораторная работа 1. ОСНОВЫ РАБОТЫ В MAESTRO. ПОДГОТОВКА СТРУКТУР ЛИГАНДОВ И БЕЛКА

Для оценки качества интерпретации на основе модели вновь рассчитывается 
карта электронной плотности, которая сравнивается с полученной экспериментально. 
Степень их соответствия друг другу описывается с помощью такой метрики качества 
структуры белка, как R-фактор:

, 

где F obs(h) и F calc(h) – модули структурных факторов из эксперимента и рассчитанные 
на основе модели, соответственно.

Еще одной метрикой является Rfree-фактор, который рассчитывается точно так же, 
за тем лишь исключением, что для сравнения используется та часть эксперименталь-
ных данных, которая не была использована при построении моделей (контрольная 
выборка).

Для совершенно случайного набора атомов R будет равен 0.63, для модели, кото-
рая идеально описывает данные эксперимента, разумеется, 0, но на практике для хоро-
шо решенных структур R обычно принимает значения до 0.2, а Rfree – до 0.26 [8].

Мерой локальной конформационной подвижности атомов в полученной модели 
белка является В-фактор (или температурный фактор), отражающий степень делока-
лизации электронной плотности атомов из-за температурно-зависимых атомных ви-
браций. Чем выше значение В-фактора, тем выше подвижность остатка или атома.

Очевидно, что решить структуру белка можно не только с помощью РСА. Разви-
тие методов двумерной спектроскопии ядерного магнитного резонанса (2D ЯМР) позво-
лило использовать методы магнитного резонанса для определения третичных структур 
протеинов, причем, в отличие от РСА – в растворе [9] (рис. 1.4).

Рис. 1.4. Ансамбль конформаций белка цинкового пальца 126 (англ. RNF126), 
определенный с помощью ЯМР в растворе (PDB ID: 2P2M [10])

Недостатки ЯМР в роли инструмента для определения структур белков связаны 
с необходимостью выращивания бактерий, используемых в качестве систем экспрес- 
cии, на изотопно-обогащенных средах, слишком большими временами релаксации 
и трудностью интерпретации спектров для крупных белков [9].
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Криоэлектронная микроскопия (англ. Cryo-EM) является сравнительно новым ме-
тодом, который может работать с довольно широким диапазоном размеров белков, 
включая очень крупные комплексы (на самом деле, с помощью Cryo-EM получают 
модели даже целых органоидов и вирусов). В основе метода лежит применение про-
свечивающей электронной микроскопии при низких температурах и последующий 
анализ полученных изображений. До недавнего времени ограничением была низкая 
разрешающая способность, однако сейчас и эта проблема является решенной [11].

Если белок трудно кристаллизовать, а методами ЯМР и Cryo-EM определить его 
структуру невозможно, то помочь может моделирование de novo на основе последова-
тельности и структур известных гомологичных протеинов. Такой подход имеет место 
быть, однако получаемые модели содержат много ошибок [12].

Так или иначе, решенные структуры молекул помещаются в ту или иную базу 
данных со свободным доступом. Информация об органических и неорганических мо-
лекулах размером до 500 атомов хранится в Кембриджской базе структурных данных 
(англ. Cambridge Structural Database, СSD) [13]. Структуры белков, нуклеиновых кис-
лот, фрагментов вирусов и т. д. содержатся в Банке данных белковых структур (англ. 
Protein Data Bank, PDB) [14].

Каждая запись PDB имеет свой идентификационный номер (PDB ID), состоящий 
из четырех символов, и заголовок. Страница записи содержит информацию о виде орга-
низма, из которого выделен белок, качестве модели, массе белка и числе атомов, выход-
ные данные оригинальной публикации, в рамках исследований которой данная струк-
тура была определена и использована, данные о симметрии и стехиометрии структуры, 
простейшие средства визуализации (рис. 1.5).

На рис. 1.6 можно найти информацию о макромолекулах. Раздел Entity 1, в дан-
ном случае, описывает цепь А фактора свертывания крови ХА длинной 234 остатка. 
Имеются ссылки на соответствующие записи в базе UniProt [15]. Раздел аннотации по-
следовательности позволяет перейти к записям PDB, содержащим белки с различными 
уровнями гомологии последовательности, а также данные о гидрофобности/гидрофиль-
ности остатков (HYDROPATHY) и упорядоченности структуры (DISORDER).

Малые молекулы, к которым относятся как лиганды, так и неорганические 
ионы, органический растворитель, содержащийся в элементарной ячейке, также 
описываются. Их аннотация включает в себя указание систематического названия,  
брутто-формулы, нотации InChi, а также имени цепи. Запись E [auth A] для молекулы 
Z34 на рис. 1.7 означает, что при обработке структуры авторами данной молекуле 
было присвоено имя «А», но при загрузке файла .pdb имя цепи будет изменено на «E». 
Также страница записи PDB может содержать ссылки на данные о биологической 
активности (рис. 1.7).

Очевидно, что первоначально структуру белка нужно найти. Банк данных бел-
ковых структур позволяет осуществлять поиск с помощью внушительного набора 
атрибутов, среди которых имеются аминокислотная последовательность, ключевые 
слова из заголовка записи/статьи, название самого белка (гена или классификаци- 
онного семейства), структуры связанного лиганда. Поисковый запрос можно уточ-
нить с помощью указания метода определения структуры, диапазона значений раз-
решения, R и Rfree, системы экспрессии и т. д. Для выполнения расширенного поиска 
следует раскрыть меню Advanced Search рядом с поисковой строкой на главной стра-
нице. На рис. 1.8 показан пример с указанием РСА в качестве метода определения 
структуры.
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PDB ID 

Заголовок  

Исходный организм 

Параметры качества 
структуры 

Библиографические данные 

Данные о содержащемся 
контенте: масса, число 
атомов и т. д. 

Число мутаций 

Стехиометрия: данная 
запись содержит 
гетеродимер (две цепи) 

Модуль визуализации 

Рис. 1.5. Запись структуры в PDB
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Область работы с идентичностью последовательности 

Цепь 

Мутации, ген и классификационный 
код фермента 

Ссылка на UniProt 

Аннотация последовательности 

Длина 
Имя макромолекулы 

Рис. 1.6. Аннотация макромолекул, содержащихся в записи PDB

 

Имя/ID 

Цепь Систематическое название, нотация 

3D-визуализация 

Данные о биологической активности 

Рис. 1.7. Аннотация малых молекул и ионов, содержащихся в записи PDB



11

Лабораторная работа 1. ОСНОВЫ РАБОТЫ В MAESTRO. ПОДГОТОВКА СТРУКТУР ЛИГАНДОВ И БЕЛКА

Рис. 1.8. Расширенный поиск PDB

Основная информация, хранящаяся в PDB, состоит из файлов координат, в кото-
рых перечислены атомы в каждой структуре и их 3D-местоположение в пространстве,  
а также сводная информация о структуре, последовательности и эксперименте. Эти 
файлы доступны в нескольких форматах (.PDBx/mmCIF, .PDB, .XML). Чтобы пол- 
ностью изучить структуры в PDB, полезно узнать несколько понятий о файлах коорди-
нат. Кроме того, эти знания помогут в использовании программ визуализации. Открыв 
файл .pdb в текстовом редакторе, можно увидеть следующую картину (рис. 1.9).

Первые 1000–2000 строк содержат информацию об авторах, названии, PDB ID, 
разрешении, эксперименте и т. д., которая не будет интересовать нас в рамках работы  
с данным практикумом.

Каждый атом в файле PDB имеет идентификатор (ATOM – для атомов белка, 
HETATM – для атомов лиганда, ионов, растворителя), порядковый номер, тип (СA – 
𝛼-атом углерода главной цепи и т. д.), код аминокислотного остатка, имя цепи, к ко-
торой он принадлежит, номер в последовательности, и, наконец, х, y, z координаты.  
Последние два столбца соответствуют значениям занятости (англ. Occupancy) и B-фак-
тора (мера локальной подвижности) (рис. 1.10).

Стоит сказать несколько слов о таком параметре, как занятость. Кристаллы бел-
ков состоят из множества отдельных симметрично упакованных молекул. В некоторых 
кристаллах есть небольшие различия между конформациями макромолекул, выра-
женные, например, в ориентации боковых цепей на поверхности белков. Когда иссле-
дователи строят атомную модель этих частей, они могут использовать занятость для 
оценки количества каждой конформации. Для большинства атомов занятость задается 
значением 1, что указывает на то, что этот атом находится во всех молекулах в одной  
и той же конформации. Однако если, предположим, ион металла связывается только  
с половиной молекул в кристалле, исследователь увидит слабое изображение иона 
на карте плотности электронов и может назначить заполняемость как 0.5.
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Рис. 1.9. Содержимое файла .pdb

Рис. 1.10. Содержимое файла .pdb, аннотирование атомов
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В этой работе мы будем использовать структуру белково-лигандного комплек-
са, модель которого получена методом РСА и депонирована в Банк данных белковых 
структур (PDB). Основные этапы подготовки будут включать:

–	 добавление атомов водорода и корректировку направления водородных связей;
–	 назначение связям корректных порядков;
–	 прогнозирование состояний протонирования для гетероатомов;
–	 добавление отсутствующих атомов;
–	 очистку структуры: удаление ненужных макромолекул, молекул воды, крис- 

таллографических артефактов;
–	 жесткую минимизацию структуры белка;
–	 конвертацию в приемлемый для дальнейшей работы формат.
Структуры лигандов также требуют подготовки. Представляемые в основном 

в виде линейных нотаций SMILES или графов (.sdf), они нуждаются:
–	 в создании стабильной конформации (получении 3D-координат атомов);
–	 прогнозировании состояний протонирования;
–	 конвертации в приемлемый для дальнейшей работы формат;
–	 создании стереоизомеров и таутомеров;
–	 нейтрализации, десольватации.
Кроме того, библиотеки лигандов нуждаются в фильтрации для отсеивания не-

желательных структур, дубликатов и т. д., однако данные операции будут выполняться  
в рамках других лабораторных работ [1, 16].

Экспериментальная часть

1.1. Создание проекта и импорт структуры белка

1.1.1. Поиск структуры белка в PDB

Перейдите на официальную страницу PDB (https://www.rcsb.org). В данной ра-
боте мы попробуем подготовить структуру фактора свертывания крови Ха, относяще-
гося к классу сериновых протеаз. В поисковой строке вбейте «Factor XA» и нажмите 
Search. Через несколько секунд ваш запрос будет обработан поисковой машиной PDB, 
результаты загрузятся в виде карточек, содержащих краткую информацию о записях. 
В разделе Search Summary вы можете увидеть, что запросу соответствует около 90 000 
структур. При беглом просмотре записей видно, что сейчас результаты содержат ком-
плексы трипсина или фактора Х кроме искомых структур фактора Ха, а также имеют 
низкое обогащение моделями человеческих белков (рис. 1.11).

Уточним параметры поиска. Частично вы можете сделать это в левой панели 
Refinements. В разделе Experimental Method поставьте галочку напротив пункта X-RAY 
DIFFRACTION, в разделе Scientific Name of Source Organism – напротив Homo sapiens 

и нажмите на значок .

Теперь будут показаны только структуры человеческих белков, полученные мето-
дом РСА (рис. 1.12).
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Рис. 1.11. Результаты поиска

Рис. 1.12. Уточнение результатов поиска
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Чтобы избежать выдачи ненужных структур других протеинов, уточним назва-
ние белка. В поле Advanced Search Query Builder в разделе Structure Attribute нажми-
те Add Attribute и в появившемся поле вбейте «Macromolecule Name», установите has 
exact phrase в качестве логического оператора, а в поле значения атрибута напечатайте 
«COAGULATION FACTOR XA», затем нажмите Search (рис. 1.13).

Рис. 1.13. Инструмент расширенного поиска

Важно: данная лабораторная работа будет посвящена подготовке структуры фактора 
свертывания крови Ха (PDB ID: 1FJS [17]), активатора тромбина. Фактор Ха, содержа-
щийся в данной записи PBD, включает ингибитор ZK-807834 (CI-1031) в своем актив-
ном сайте. Выбранный комплекс определен методом РСА, характеризуется приемле-
мыми значениями разрешения (1.75 Å) и Rfree-фактора (0.26).

1.1.2. Создание проекта и указание рабочей директории

Создайте папку с именем LW1 в своем личном каталоге. Дважды щелкните 
по ярлыку Maestro на рабочем столе. Любой запуск начинается со Scratch Project (про-
екта по умолчанию); все расчеты и результаты выполнения заданий, произведенные 
в Scratch Project, не сохраняются, поэтому начинать каждую сессию Maestro следует 
с указания пути к своей рабочей директории и создания/открытия своего проекта. 
Проекты Maestro имеют расширение .prj, а в рабочей директории хранятся все импор-
тированные/экспортированные структуры, файлы заданий и т. д.

На верхней панели перейдите на вкладку File > Change Working Directory. В от-
крывшемся окне укажите путь к рабочей директории LW1 в своем личном катало- 
ге (рис. 1.14).
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Рис. 1.14. Указание пути к рабочей директории

Затем перейдите File > Save Project As, задайте проекту имя LW1 в графе File name, 
укажите путь к рабочей директории в графе Location.

1.1.3. Знакомство с интерфейсом Maestro
Теперь, когда проект создан, директория указана и мы не рискуем потерять про-

гресс сессии и важные нам файлы, давайте познакомимся с рабочей средой Maestro 
подробнее.

Основную часть окна занимают две важные области: слева располагаются столб-
цы Entry List и Structure Hierarchy, а справа от них – Workspace. Каждой импортиру-
емой или создаваемой структуре (будь то белок или малая молекула) соответствует 
отдельная запись (Entry) в Entry List. Нужные пользователю записи могут быть ото-
бражены средствами молекулярной графики в Workspace с помощью кнопки Include. 
Для того чтобы просто выбрать запись без отображения в рабочей области, нужно один 
раз кликнуть по соответствующей строчке. Если выбранная запись содержит несколь-
ко подструктур, как, например, в случае белок-лигандного комплекса, то в разделе 
Structure Hierarchy будут отображаться все эти подструктуры (рис. 1.15).

Ниже Workspace располагается окно Sequence Viewer, где отображается аминокис-
лотная последовательность белка, показываемого в рабочей области (нажата кнопка 
Include). Нажатие на блок Tasks в верхней правой части окна откроет доступ ко всем 
модулям Maestro, с помощью которых можно запускать различные задания (например, 
молекулярный докинг или квантово-химический расчет переходного состояния). Блок 
Jobs соответствует модулю Monitor, через который можно наблюдать за выполнением 
заданий и контролировать их прогресс. Table ведет к Project Table, где отображаются 
не только заголовки записей проекта, но и доступные для них свойства (например, 
значения скоринговых функций или ADMET-параметры).
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Выбрать структуру без отображения  

Structure Hierarchy 

Workspace 

Entry List 

Include – 
отобразить 
структуру в  
Workspace  

Выделение Project 
Table 

Monitor 

Sequence Viewer 

Фокус 

Задания 

Визуализация 

Рис. 1.15. Основные элементы рабочего окна Maestro

Панели Style, Presets и Build отвечают за персонализацию визуального оформле-
ния (например, изменение цвета атомов или сокрытие атомов водорода), применение 
предопределенных визуальных пресетов, а также построение/модификацию (добавле-
ние/удаление атомов и связей) отображенных в Workspace структур.

Панель Fit позволяет фокусироваться на необходимых пользователю деталях 
структур, например быстро приблизить камеру к лиганду, расположенному в сайте свя-
зывания белка.

Расположенная слева панель Select отвечает за выбор определенных элементов 
структуры, отображенной в Workspace.

Не стоит пугаться такого множества элементов интерфейса, с каждым из них мы  
в той или иной степени разберемся в ходе выполнения данной и всех последующих 
лабораторных работ.

1.1.4. Импорт структуры белка

Для того чтобы импортировать структуру белка для подготовки и дальнейшей ра-
боты, воспользуемся модулем Protein Preparation Workflow. Кликните на кнопку Protein 
Preparation Workflow в строке, расположенной над Workspace (в этой строке отобража-
ются часто используемые и избранные модули).

Заметка: в случае необходимости вы можете импортировать отдельную цепь интерес-
ного вам белка, а также дополнительно загрузить данные об электронной плотности. 
Импорт происходит автоматически при подключении к сети Интернет. Однако любая 
структура (библиотека лигандов, файл PDB) может быть импортирована оффлайн  
с помощью File > Import (для этого необходимый файл необходимо предварительно 
загрузить и переместить в рабочую директорию).



18

А.Ю. Кудинов, А.С. Бунев Основы молекулярного моделирования биологически активных веществ

Добавить любой модуль в «Избранное» вы можете самостоятельно в разделе Task. 
В открывшемся окне в разделе Specify Protein нажмите Get PDB. Введите PDB ID 1FJS 
в соответствующей строке, нажмите Download (рис. 1.16).

Рис. 1.16. Импорт структуры с помощью Protein Preparation Workflow

Sequence Viewer 

Рис. 1.17. Вид рабочего окна Maestro после импорта
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В случае завершения загрузки без ошибок, структура комплекса Xa с ингибито-
ром будет отображена в Workspace, а соответствующая запись появится в Entry List. 
В верхней части Workspace вы увидите баннер, сообщающий об успешном импорте. 
Обратите внимание, что в Structure Hierarchy теперь в виде отдельных групп содержит-
ся информация о лигандах, самом белке, молекулах воды и других атомах (ионах ме-
таллов и т. д.), которые содержатся в данной записи PDB. Sequency Viewer отображает 
последовательность фактора Ха (рис. 1.17).

1.2. Подготовка структуры белка

Панель Protein Preparation Wizard позволяет полностью выполнить подготовку 
белка для дальнейшей работы, например для выполнения молекулярного докинга. 
В случае нажатия кнопки Interactive подготовка пройдет в автоматическом режиме, од-
нако мы не рекомендуем использовать его при работе с ранее неизвестным белком.

В разделе Preprocess раскройте меню More Options. Убедитесь, что напротив пунк- 
тов Fill in missing side chains (добавление отсутствующих атомов в боковых цепях), 
Assign bond orders using CCD database (уточнение порядков связей с помощью CCD 
(англ. Chemical Component dictionary)) [18], Replace hydrogens, Create zero-order bonds 
to metals (создание корректных координационных связей металлов), Create disulfide 
bonds (создание дисульфидных связей) проставлены галочки. Также проверьте, чтобы 
был выбран пункт Generate het states, а диапазон pH соответствовал 7.4±2. Последний 
пункт отвечает за предсказания состояния протонирования гетероатомов с помощью 
алгоритма Epik [19]. Пункт Fill in missing loops позволит предсказать конформацию от-
сутствующих коротких петель в структуре белка с использованием Prime [20], требует 
дополнительного времени для выполнения расчета и обычно не обязателен, но в этой 
лабораторной работе выберем также и его, поставив галочку рядом. Затем нажмите на 
кнопку Preprocess. Расчет займет ориентировочно 1–5 минут.

По завершении препроцессинга вы увидите, что теперь в вашу структуру добавлены 
отсутствующие ранее атомы водорода, а двойным/координационным связям назначен 
корректный порядок. В Entry List была автоматически создана группа 1FJS-proteinprep_1  
и в ней сохранена соответствующая структура 1FJS - 2-preprocessed (рис. 1.18).

Далее необходимо проверить структуру после начального этапа подготовки. 
В разделе Diagnose and Analyze нажмите на кнопку Сheck Structure. Произойдет авто-
матическое переключение на вкладку Diagnostics, в которой отображаются все обнару-
женные в структуре белка проблемы.

Заметка: нарушения валентных возможностей атомов отображаются во вкладке 
Valences, отсутствующие боковые цепи и остатки основной цепи – в Missing, проблемы  
с чрезмерным перекрыванием атомных радиусов (англ. clashes) – в Overlapping, а спи-
сок остатков, для которых возможны альтернативные ориентации – в Alternates.

Как мы можем увидеть, в нашей структуре присутствует только одна проблема: 
атомы водорода остатков ASN117 и THR136 находятся на расстоянии ближе допусти-
мого. Нажатие на строчку приведет к тому, что в Workspace вы сможете сфокусировать-
ся на этих проблемных атомах.
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Maestro автоматически создает 
новую структуру на каждом этапе 
подготовки 

Рис. 1.18. Preprocess. Начальный этап подготовки белка

Важно: проблемы перекрывания атомных радиусов атомов водорода чаще всего 
некритичны и решаются на дальнейших этапах подготовки. 

Из вкладки Overlapping перейдите на вкладку Reports и выберите View: Ramachandran 
Plot. Ознакомьтесь с картой Рамачандрана и сделайте выводы о том, какие элементы 
вторичной структуры присутствуют в данном белке. Закройте окно Ramachandran Plot 
(рис. 1.19).

Теперь перейдите на вкладку Substructures, чтобы подробнее ознакомиться 
со всем содержимым структуры PDB, которая была загружена. В верхней части ок- 
на вы можете ознакомиться со всеми малыми молекулами и ионами (напротив тех 
из них, которые являются лигандами, стоит соответствующая отметка), в левой ниж-
ней содержится информация о кристаллографической воде, а в правой нижней – 
о цепях белка.

Заметка: для каждой малой молекулы в панели Ligands, Metals, Other может быть 
сгенерировано несколько вариантов в зависимости от состояния протонирования 
или таутомерии. По умолчанию выбирается состояние, обладающее наибольшей ста-
бильностью. 
Однако вы можете выбрать любое из них или же сохранить сразу несколько вари-
антов для дальнейшего моделирования. Сейчас мы продолжим работать с первым 
(выбранным по умолчанию) состоянием лиганда.
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Рис. 1.19. Получение карты Рамачандрана

Молекулы глицерина (GOL), а также иона хлора (CL) явно являются кристалло-
графическими артефактами, никак не влияют на биологическую активность факто-
ра Хa и могут привести к неверным результатам дальнейшего моделирования, так что 
должны быть удалены.

Выберите их путем нажатия ЛКМ с зажатым Ctrl (строчки будут подсвечены жел-
тым), а затем нажмите Delete from Entry. Таким же образом поступим и с цепью L фактора 
Ха. При нажатии на каждую строчку на вкладке Substructures фокус в Workspace будет 
автоматически смещаться для удобного осмотра выбранной подструктуры (рис. 1.20).

Важно: будьте осторожны при удалении подструктур. Часто белки, депонированные 
в PDB, содержатся в одной элементарной ячейке кристалла в виде ди-, три-, тетра- 
или олигомеров, в каждой из цепей которых содержится один и тот же лиганд. Ра-
бота с такими избыточными структурами может занимать много машинного вре-
мени, поэтому оставляют только одну цепь. Однако необходимо четко понимать 
структурные особенности, механизм действия и функции мишеней при удалении 
цепей! Например, если вы разрабатывайте ингибитор PPI и работайте с гетеродиме-
ром, удаление какой-либо цепи может быть однозначно опрометчиво. То же самое 
касается подготовки структур для белок-белкового докинга. Изучите информацию 
о белке еще до его загрузки из PDB.

Нажмите на зеленую кнопку Workflow для возврата к вкладке Preparation Workflow  
и перейдите в раздел Optimize H-Bond Assigments. Перекрытие радиусов, вызванное до-
бавлением атомов водорода на этапе предварительной обработки, будет исправлено, 
а ориентация боковых цепей скорректирована при запуске этого задания.
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Рис. 1.20. «Очистка» структуры

Проверьте pH для оптимизации: значение должно быть зафиксировано в диапа-
зоне pH, выбранном на этапе предварительной обработки. Нажмите Optimize. Расчет 
займет 3–6 минут (рис. 1.21).

Рис. 1.21. Оптимизация сетки водородных связей

Последний этап включает ограниченную релаксацию структуры белка и удале-
ние молекул кристаллографической воды. Перейдите в раздел Minimization and Delete 
Waters, проверьте, чтобы настройки были такими же, как указано на рис. 1.22. Запусти-
те процесс. Расчет займет 4–6 минут.
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Рис. 1.22. Минимизация и удаление воды

Включите в Workspace структуру, полученную после минимизации. В строке из-
бранных модулей выберите Ligand Interaction и дождитесь загрузки 2D-диаграммы вза-
имодействий лиганда в сайте связывания белка. Для доступа к легенде нажмите на зна-

чок и выберите LID Legend (рис. 1.23).

Рис. 1.23. 2D-диаграмма взаимодействий лиганда

Молекулы воды, которые участвуют в «передаче» водородных связей от лиганда к бел- 
ку, в общем случае должны быть сохранены, а такой способ связывания внимательно про- 
анализирован. Сейчас мы видим две такие молекулы и не будем их удалять. Закройте окно 
Ligand Interaction Diagram. Не забудьте также закрыть окно Protein Preparation Workflow.

Подробнее познакомимся со способом связывания ингибитора в сайте Xa. Выбе-
рите Presets > Legacy > Ligand Site Cartoon. Давайте скроем неполярные атомы водоро-
да для облегчения визуального осмотра. В панели Quick Select нажмите на …, выбери-
те Binding Sites+Ligands. Обратите внимание, что теперь стала активна строка Current 
Selection в панели Structure Hierarchy.

Справа от Current Selection нажмите на значок 
 
и в меню управления отобра-

жением атомов водорода выберите Show Polar Hydrogens (рис. 1.24).
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Рис. 1.24. Настройки визуального представления

Рис. 1.25. Генерация поверхности электростатического потенциала сайта
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Давайте отобразим поверхность молекулярного электростатического потен-
циала сайта. Выберите Surface (Binding Site) в строке избранных заданий, в открыв-
шемся окне выберите Interaction Map напротив Surface Type, а также Solid напротив 
Style. Раскройте список рядом с Color Scheme и выберите Electrostatic Potential, затем 
ОК. Расчет займет 2–3 минуты. Когда поверхность будет отображена, изучите спо-
соб связывания лиганда в сайте. Колесико мыши может быть использовано для при-
ближения/отдаления, а движение мышью при зажатом Alt – для вращения. Скрыть

молекулярные поверхности всегда можно нажатием на значок 
 
 рядом с записью 

в Entry List (рис. 1.25).

1.3. Подготовка структуры лиганда

Нажатием ПКМ на строку 1FJS - 5-removed waters в Entry List откройте контекст-
ное меню, в котором выберите Split > Into ligands, Waters, Other. Затем включите струк-
туру 1FJS - 5-removed waters_ligand в Workspace, а в строке избранных заданий выберите 
LigPrep – модуль для подготовки лигандов (рис. 1.26) [1].

Рис. 1.26. Сплитирование структуры комплекса

Модуль LigPrep позволяет подготовить для работы структуры лигандов: произ-
вести конвертацию форматов, сгенерировать наиболее выгодную конформацию, по-
лучить таутомерные формы и т. д.

В графе Use structures from: выберите Workspace. Проверьте, чтобы используе-
мым силовым полем было именно поле OPLS4 (англ. Optimized Potentials for Liquid 
Simulations) [21]. В разделе Ionization выберите Generate possible states в диапазоне 
рН: 7.4±0.2, используйте алгоритм Epik. Поставьте галочки напротив пунктов Desalt  
и Generate tautomers. Выберите пункт Determine chiralities from 3D structure в разделе 
ниже. В качестве формата вывода выберите Maestro (.mae). Графа Job Name отвечает 
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за название задания. Назовите задание «ligprep_LW1». Нажмите Run. Расчет займет 
2–5 минут (рис. 1.27).

Рис. 1.27. Подготовка структуры лиганда с помощью LigPrep

Заметка: выбранные нами настройки LigPrep являются стандартным способом под-
готовки лигандов. Раздел Ionization отвечает за назначение зарядов и учет состоя-
ний протонирования. Учет хиральности и создание стереоизомеров также возмож-
но. Нами был выбран путь создания такой конфигурации, как указано в структурной 
формуле (см. модуль 2D Sketcher). Однако в конкретном случае хиральность, оче-
видно, не важна: в молекуле отсутствуют центры хиральности.

В случае успешного запуска задания в панели Jobs появится зеленая индикация, 
сообщающая о наличии активной задачи. Модуль Monitor позволит вам контролиро-
вать выполнение задач. Двойной щелчок по строчке с нужной работой (или нажатие 
кнопки Monitor) открывает доступ ко вкладкам Details и File для конкретного зада-
ния (рис. 1.28).

Двойной щелчок по имени того или иного файла позволяет посмотреть его 
содержимое (доступно не для всех файлов). Полезным может являться просмотр 
log-файлов. Щелкните по файлу ligprep_LW1.log для открытия. Как показано ни- 
же, файл log содержит всю информацию об имени задания, используемых подпро-
граммах, директориях, занимаемых расчетом процессорах, ошибках, а также теку-
щей стадии.
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Рис. 1.28. Панель Monitor

,

Monitoring job: ligprep_LW1 
---------------------------------------------------------------- 
JobId : 218F-0-65478e29 
Name : ligprep_LW1 
Program : LigPrep 
Version : 2023-1 build 128 
Host : 218F 
Dir : \\Mac\Home\Documents\Schrodinger\ligprep_LW1 
HostEntry : localhost 
JobHost : 218F 
JobDir : C:\Users\andrejkudinov\AppData\Local\Schrodinger\tmp\ligprep_LW1 
JobSchrodinger : C:\Program Files\Schrodinger2023-1 
Commandline : C:\Program Files\Schrodinger2023-1\ligprep.exe -inp ligprep_LW1.inp -HOST 
localhost:6 -NJOBS 1 -PROJ "\\mac\Home\Documents\Schrodinger\MCC_Education\Andrey 
Kudinov\LW_1\LW_1.prj" -DISP append -VIEWNAME ligprep_gui.LigPrepPanel -TMPLAUNCHDIR 
StartTime : 2023-11-05-16:44:28 
---------------------------------------------------------------- 
LigPrep: preparing subjobs 

Running subjobs on hosts: 
localhost (Max: 6) 
Number of jobs: 1 
Max retries per job: 2 
Max allowed failures: unlimited 
Verbosity: normal 

Starting JobDJ... 

Keep one job on driver host: False 
JobDJ columns: 
C: Number of completed subjobs 
A: Number of active subjobs (e.g., submitted, running) 
W: Number of waiting/pending subjobs 

C A W | Activity JobId JobName JobHost 
- - - | --------- -----------------------
0 1 0 | launched 218F-0-65478e31 ligprep_LW1-1 localhost [218F]



28

А.Ю. Кудинов, А.С. Бунев Основы молекулярного моделирования биологически активных веществ

Monitoring job: ligprep_LW1 
---------------------------------------------------------------- 
JobId : 218F-0-65478e29 
Name : ligprep_LW1 
Program : LigPrep 
Version : 2023-1 build 128 
Host : 218F 
Dir : \\Mac\Home\Documents\Schrodinger\ligprep_LW1 
HostEntry : localhost 
JobHost : 218F 
JobDir : C:\Users\andrejkudinov\AppData\Local\Schrodinger\tmp\ligprep_LW1 
JobSchrodinger : C:\Program Files\Schrodinger2023-1 
Commandline : C:\Program Files\Schrodinger2023-1\ligprep.exe -inp ligprep_LW1.inp -HOST 
localhost:6 -NJOBS 1 -PROJ "\\mac\Home\Documents\Schrodinger\MCC_Education\Andrey 
Kudinov\LW_1\LW_1.prj" -DISP append -VIEWNAME ligprep_gui.LigPrepPanel -TMPLAUNCHDIR 
StartTime : 2023-11-05-16:44:28 
---------------------------------------------------------------- 
LigPrep: preparing subjobs 

Running subjobs on hosts: 
localhost (Max: 6) 
Number of jobs: 1 
Max retries per job: 2 
Max allowed failures: unlimited 
Verbosity: normal 

Starting JobDJ... 

Keep one job on driver host: False 
JobDJ columns: 
C: Number of completed subjobs 
A: Number of active subjobs (e.g., submitted, running) 
W: Number of waiting/pending subjobs 

C A W | Activity JobId JobName JobHost 
- - - | --------- -----------------------
0 1 0 | launched 218F-0-65478e31 ligprep_LW1-1 localhost [218F]

После завершения расчета Maestro автоматически импортирует полученные 
структуры в группу ligprep_LW1-out. Давайте сравним нативную конформацию ли-
ганда из белка и конформации, выданные LigPrep. Для этого выделите все элементы 
в группе ligprep_LW1-out. После чего нажмите на значок кастомизации в верхней пра-
вой части Entry List. Выберите All Atoms > Color Atoms > Element + Custom Carbons > 
Faded Orange (рис. 1.29).

Рис. 1.29. Изменение цвета атомов углерода в молекуле

Теперь конформации надо наложить друг на друга. Выделите также 1FJS - 5-removed 
waters_ligand. Перейдите в Task > Superposition. В открывшемся окне выберите нативный 
лиганд в качестве шаблона, а тип наложения – согласно максимальной общей подструк-
туре. Нажмите Superimpose Structures. Расчет займет примерно минуту (рис. 1.30).

Дважды щелкните по кнопке Include напротив строки нативного лиганда, закре-
пив его в Workspace. Используя Ctrl, включите остальные лиганды. Оцените, насколько 
иногда генерируемые методами конформационного поиска/минимизации конформа-
ции могут отличаться от биологически активной!
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Рис. 1.30. Наложение молекул с помощью модуля Superposition

Отчет к данной лабораторной работе не требуется, однако в качестве тренировки 
выполните подготовку белковых структур, представленных в таблице ниже, с помощью 
модуля Protein Preparation Workflow. Вариант уточните у преподавателя (табл. 1.1).

Таблица 1.1

Комплексы для подготовки

PDB ID, 
Комплекс 1

Дальнейшее использование 
подготовленной структуры

PDB ID, 
Комплекс 2

Дальнейшее использование 
подготовленной структуры

Вариант I 6BOY Молекулярный докинг 
молекул PROTAC 
в комплекс POI-E3

5DXH Поиск АТФ-конкурентных 
ингибиторов

Вариант II 5FL5 Разработка селективных 
ингибиторов CA IX

6BVB Разработка пептидомиметика 
на основе дегрона HIF, 
связанного с Е3 лигазой VHL

Вариант III 4WNP Поиск АТФ-конкурентных 
ингибиторов

5UBR Поиск АТФ-конкурентных 
ингибиторов

Вопросы к защите

1.	 Какие уровни структурной организации белков вам известны?
2.	 Какие методы определения трехмерной структуры белков существуют? Пере-

числите их основные достоинства и недостатки, область применимости.
3.	 Что описывает фактор Rfree, определяемый для структур, полученных методом 

РСА, и чем отличается от R-фактора?
4.	 Какую структуру – обладающую большим или меньшим значением R-фактора – 

следует выбрать для работы?
5.	 Что такое разрешение кристаллографической структуры?
6.	 Какие проблемы могут быть обнаружены в структуре, полученной методом РСА?
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7.	 Углам между какими атомами основной цепи белка соответствуют углы 𝜑 и 𝜓?
8.	 Каким областям на карте Рамачандрана соответствуют право- и левозакручен-

ные альфа-спирали?
9.	 Перечислите основные функции модуля LigPrep.
10.	Перечислите основные функции модуля Protein Preparation Wizard.
11.	Почему не всегда стоит удалять «лишние» цепи из структуры белков?
12.	Какие молекулы воды следует сохранять при подготовке белково-лигандных 

комплексов?
13.	Какие свойства атомов белка характеризует В-фактор?
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КОНФОРМАЦИОННЫЙ АНАЛИЗ 
МАЛЫХ МОЛЕКУЛ

Цель работы: освоение основных подходов к конформационному поиску малых мо-
лекул.
Вам предстоит: выполнить систематический и стохастический поиск конформаций 
малых молекул с помощью таких инструментов, как MacroModel и ConfGen, а также 
проанализировать результаты.
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Теоретическое введение
Конформационный поиск – это важный метод в молекулярном моделировании, ко-

торый направлен на генерацию различных конформаций молекулы (исследование кон-
формационного пространства), определение их энергии и нахождение низкоэнергетичес- 
ких конформеров. Области применения конформационного поиска представлены ниже:

–	 определение наиболее энергетически стабильной конформации: конформацион-
ный поиск позволяет выявить набор самых энергетически стабильных кон-
формаций. Это полезно для понимания фундаментальных свойств структуры 
и определения ее активности;

–	 определение способа связывания лиганда с мишенью: конформационный поиск 
может использоваться для определения оптимальной ориентации/конформа-
ции лиганда в связанном состоянии с белком в ходе молекулярного докинга;

–	 уточнение при определении структуры белка: конформационный поиск играет 
важную роль в уточнении результатов определения структуры макромолекул 
такими методами, как рентгеноструктурный анализ или ядерно-магнитный 
резонанс. Сравнение экспериментальных данных с конформациями, найден-
ными с помощью конформационного поиска, помогает сопоставить экспери-
ментальные и модельные структуры.

Зависимость энергии молекулы от тех или иных геометрических параметров ато-
мов удобно представлять графически в виде кривой или поверхности потенциальной 
энергии. В качестве таких геометрических параметров могут выступать декартовы (х, у, 
z) или так называемые внутренние координаты (значения длин связей, валентных и ди-
эдральных углов). На рис. 2.1 представлены примеры кривых и поверхностей потенци-
альной энергии различных молекул. Как вы можете увидеть, реальный энергетический 
ландшафт молекулы довольно сложен и характеризуется большим числом стационар-
ных точек – наиболее интересными для нас будут являться минимумы энергии.

По способу «перемещения» в пространстве конформаций выделяют методы сис- 
тематического и стохастического поиска.

Процедура систематического поиска заключается в последовательном изменении 
какого-либо геометрического параметра, чаще всего вращение вокруг торсионных 
углов с заданным шагом. Если он достаточно мал, то достижим полный охват конфор-
мационного пространства.

Однако расчет конформационного пространства для структуры, содержащей 
всего шесть вращающихся связей, предполагает создание и минимизацию около трех 
миллионов конформаций с учетом шага в 30°. Данная ситуация называется «комби-
наторным взрывом», а такой конформационный поиск стал бы чрезвычайно долгой 
и затратной процедурой [1–3].

В ходе стохастического поиска новые конформации создаются путем случайного 
изменения геометрических параметров (внутренних координат). Энергия каждой но-
вой конформации сравнивается с энергией предыдущей. Если энергия ниже, то новая 
структура становится «текущей» и минимизируется, в противном случае вероятность

принятия конформации в качестве «текущей» пропорциональна
 

�� 𝑒𝑒𝑒𝑒𝑒𝑒 �− ���.  . Таким

образом алгоритм моделирует тепловое поведение молекулы, стремясь отдавать пред-
почтение стабильным конформерам, но допуская случайные флуктуации в состояния 
с более высокой энергией, что затем может привести к глобальному минимуму. Обыч-
но используются эвристические подходы, такие как генетические алгоритмы или ме-
тод Монте-Карло. Он быстрее, чем систематический поиск, но не гарантирует полный 
обход всего пространства конформаций (рис. 2.2) [1].
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Рис. 2.1. Кривые и поверхности потенциальной энергии

Рис. 2.2. Стохастический поиск

В данном практикуме не будут подробно описаны такие методы, как моделирова-
ние отжига, генетические алгоритмы и геометрия расстояний. Настоятельно рекомен-
дуем вам ознакомиться с материалами лекций и источниками из списка литературы 
к данной работе, чтобы подробнее узнать об этих подходах.

Большое значение в вопросе конформационного поиска играют также подходы 
к минимизации энергии конформаций. Весь процесс минимизации сводится к простой 
математической задаче – поиску точек минимума функции потенциальной энергии 
U(q), где q – геометрические параметры системы.

Метод скорейшего спуска относится к градиентным методам минимизации. В об-
щем случае градиент некоторой функции φ (x, y, z) является вектором, направление 
которого совпадает с направлением возрастания функции, а его компоненты равны 
частным производным по переменным.
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Иногда градиент удобно представлять в матричном виде g (особенно актуально 
для метода сопряженных градиентов):

. 

Движение против градиента, соответственно, приводит к уменьшению значения 
функции. На этом принципе и основан метод скорейшего спуска. Алгоритм произво-
дит: (1) вычисление энергии начальной конфигурации р0; (2) расчет градиента в дан-
ной точке; (3) линейный поиск против градиента в попытках найти точку с минималь-
ным значением энергии p1 путем изменения значений координат атомов (декартовых 
или внутренних); (4) расчет градиента уже в точке p1 и т. д. (рис. 2.3).

Рис. 2.3. Градиентный спуск

Метод наискорейшего спуска интуитивно понятный, не требовательный с аппа-
ратной точки зрения, однако обладает плохой сходимостью в окрестностях минимума. 
Метод сопряженных градиентов является современной модификацией наискорейше-
го спуска и сейчас повсеместно используется в соответствующем ПО; суть его заклю-
чается в уточнении направления поиска в текущей точке относительно направления 
на предыдущем шаге:

, 

. 

где k – текущий шаг, V (k) – направление на текущем шаге k, g(k) – градиент, рассчитан-
ный в точке p(k), V (k – 1) – направление на предыдущем шаге, а γ(k) – корректирующий 
направление скаляр, рассчитанный как

, 

. 
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Метод сопряженного градиента позволяет достичь минимума за кратно меньшее 
число шагов, чем наискорейший спуск (рис. 2.4).

Рис. 2.4. Метод сопряженных градиентов 
в сравнении с наискорейшим спуском

Метод Ньютона-Рафсона позволяет приблизиться к минимуму с помощью вы-
числения первых и вторых частных производных. Как мы уже знаем, взятие частных 
производных энергии по координатам соответствует операции градиента, а компонен-
ты градиента удобно размещаются в матрице g; матрицу же вторых производных раз-
мерности pхp (где р – число переменных) принято называть Гессианом Н [4]:

. 

Конформационный поиск в Maestro представлен модулями MacroModel [5, 6] 
и ConfGen [7, 8]. Задание MacroModel может быть запущено из Task > MacroModel > 
Conformational Search. Алгоритм MacroModel включают в себя следующие методы по-
иска (табл. 2.1).

Таблица 2.1

Методы поиска, реализованные в MacroModel

Метод поиска Комментарий

Monte Carlo Multiple Minimum
(англ. MCMM, Стохастический поиск 
множественных минимумов методом Монте-Карло)

Данный метод очень эффективен при выполнении 
глобального поиска. В ходе расчета производятся 
случайные изменения торсионных углов. Хотя 
количество углов, изменяющихся при поиске, 
не ограничено, наличие их в количестве 10 
или 15 значительно увеличивает сложность/время 
и ухудшает сходимость поиска [9]

Systematic Pseudo-Monte Carlo
(англ. SPMC, Систематический поиск 
методом псевдо-Монте-Карло)

Если задача состоит в том, чтобы найти все 
возможные конформационные минимумы 
на поверхности, систематический метод MacroModel 
сможет это обеспечить. SPMC демонстрирует 
высокую эффективность на протяжении всего поиска, 
даже в конце, когда другие методы имеют 
тенденцию повторно обращаться к уже найденным 
конформерам. Метод поиска SPMC наиболее 
эффективен для небольших молекул [10]
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Окончание табл. 2.1

Метод поиска Комментарий

Low-Mode Conformational Search Methods
(англ. LMCS, Конформационный поиск 
методом низкочастотных нормальных колебаний)

Данный подход позволяет обнаруживать 
седловые точки и минимумы 
на гиперповерхности потенциальной 
энергии путем градиентного слежения 
за значениями собственного вектора 
молекулярной системы (следованием за модой, 
англ. mode-following), полученными с помощью 
анализа нормальных колебаний. Если у вас 
мало или вообще нет предварительных знаний 
о системе, которую нужно найти, то этот метод 
позволяет выполнять автоматический поиск 
без необходимости определения параметров, 
которые нужно варьировать [11]

В этой работе мы не будем выполнять полноценный поиск с использованием 
MacroModel, а ограничимся систематическим сканированием нескольких торсион-
ных углов небольшой молекулы с помощью модуля Coordinate Scan.

ConfGen, другой оригинальный алгоритм Schrödinger, на первом этапе раз- 
деляет молекулу на фрагменты, разрывая экзоциклические вращающиеся связи,  
позволяет получать конформационные массивы для всех фрагментов с проведе- 
нием грубой минимизации и затем в определенном порядке соединяет их в еди- 
ную систему, которая финально оптимизируется. ConfGen параметризован таким 
образом, чтобы как можно чаще приводить к биологически активным конфор- 
мациям.

Экспериментальная часть 

Рис. 2.5. Разделение молекул на фрагменты с помощью ConfGen

Показано, что в режиме высокой производительности алгоритм позволяет обра-
батывать 12–15 лигандов в секунду без минимизации и порядка 0.4 лиганда в секунду 
с оптимизацией геометрии с помощью силового поля OPLS (рис. 2.5).



38

А.Ю. Кудинов, А.С. Бунев Основы молекулярного моделирования биологически активных веществ

Экспериментальная часть

2.1. Создание проекта

В своем личном каталоге создайте папку LW2. Дважды щелкните по ярлыку 
Maestro на рабочем столе. На верхней панели перейдите на вкладку File > Change Work- 
ing Directory. В открывшемся окне укажите путь к рабочей директории LW2 в своей 
личной папке.

Затем перейдите File > Save project as, задайте проекту имя LW2 в графе File name, 
укажите путь к рабочей директории в графе Location.

2.2. Конформационный анализ с помощью MacroModel

2.2.1. Подготовка структур

Откройте модуль 2D Sketcher, для этого перейдите Task > 2D Sketcher. Открыв-
шееся окно представляет собой обычный химический редактор. Нарисуйте представ-
ленную ниже структуру (если данное пособие открыто на ПК, просто скопируйте 
и вставьте SMILES). После чего нажмите Save as New, назовите новую запись «Ddrive» 
(рис. 2.6).

SMILES: Cc1c(=O)[nH]c(=O)n(COCC)c1Sc2ccccc2 

Рис. 2.6. Структура для работы

Выделите структуру Ddrive в Entry List. Откройте модуль LigPrep (кликните на 
значок модуля LigPrep в строке избранных заданий или перейдите Task > LigPrep), вы-
ставьте настройки по умолчанию (OPLS4, Desalt, Generate tautomer, Generate possible 
states at target pH 7.4±0.2, Epik, Determine chiralities from 3D structure) и выполните под- 
готовку структуры Ddrive.

2.2.2. Выполнение сканирования торсионных углов

Выделите в Entry List и включите в Workspace структуру, полученную в резуль-
тате расчета LigPrep. Отобразите в Workspace номера атомов в виде меток: в верх- 
ней части окна нажмите на панель Style, далее Apply Labels > Element + Atom Number 
(рис. 2.7).
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Рис. 2.7. Добавление меток атомам

Откройте инструмент конформационного поиска MacroModel. Перейдите Task > 
Macromodel > Coordinate Scan. В открывшемся окне выберите Workspace (Inducted Entry) 
напротив Use structure from, затем перейдите на вкладку Scan, где в качестве типа коор-
динат (Coordinate Type) выберите Dihedral (рис. 2.8).

Рис. 2.8. Настройки конформационного поиска
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Появившийся баннер в верхней части Workspace сообщает, что теперь необходи-
мо определить искомые торсионные углы. Используя Alt для вращения, выделите ато-
мы 1, 14, 15 и 16. Вокруг выделенных атомов будут появляться метки в виде кубиков. 
Торсионный угол № 1 будет определен (связи, его образующие, подсветятся зеленым). 
В зависимости от версии ПО и настроек нумерации номера атомов могут не совпадать – 
выделите атомы, показанные на рис. 2.9.

Рис. 2.9. Определение торсионного угла № 1

Используя Alt для вращения, выделите атомы 1, 6, 25 и 26. Вокруг выделенных 
атомов будут появляться метки в виде кубиков. Торсионный угол № 2 будет определен 
(связи, его образующие, подсветятся зеленым) (рис. 2.10).

Рис. 2.10. Определение торсионного угла № 2
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Вернитесь к окну Coordinate Scan. Обратите внимание, что выбранные углы по-
явились на вкладке Scan. Перейдите на вкладку Potential. Проверьте, чтобы OPLS4 
было выбрано в качестве силового поля. Установите None напротив типа растворителя 
(Solvent) (в этом случае расчет будет происходить в вакууме). Остальные настройки ав-
томатически выставляются по умолчанию (как показано на рис. 2.11).

Рис. 2.11. Запуск задания

Перейдите на вкладку Mini, установите PRCG в качестве метода минимизации. 
Назовите работу «mmod_Ddrive» и нажмите Run. Расчет на одном процессоре займет 
примерно минуту.

Заметка: в этой работе мы запустим расчет без учета растворителя. Вы можете запу-
стить эту работу в воде, а затем в хлороформе, чтобы сравнить внутримолекулярные 
взаимодействия в конформациях. MacroModel также имеет существенные возмож-
ности для управления силовыми полями, ограничениями и настройками, связанны-
ми с навигацией по поверхности потенциальной энергии.

2.2.3. Анализ поверхности потенциальной энергии

Отобразите рассчитанные значения потенциальной энергии в Entry List. Для это-
го в верхней правой части Entry List нажмите Show Property > Choose > Relative Energy-
S-OPLS, потом Choose > Potential Energy-S-OPLS, затем Choose и ОК. Относительные 
энергии конформаций малых молекул играют решающую роль в определении формы  
и активности лиганда (рис. 2.12).

Последняя структура в группе mmod_Ddrive-out – mmod_Ddrive-out Minimum E. 
structure during drive – конформация с самой низкой энергией, обнаруженная в ходе 
сканирования пространства по двум торсионным углам. Переименуйте начальную 
структуру Ddrive (находящуюся в группе ligprep_Ddrive-out): дважды щелкните ЛКМ 
по строчке в Entry list и введите имя «Ddrive Starting Structure».
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Рис. 2.12. Отображение рассчитанных значений энергии в Entry List

Щелкните ПКМ по переименованной структуре, в контекстном меню выберите 
Duplicate > As Ungrouped Entry. Ddrive Starting Structure теперь содержится в Entry List 
как отдельная запись в конце (строка 1373). Переместим ее в группу mmod_Ddrive-out 
на первую позицию: либо просто перетащите запись, зажав ЛКМ, либо вызовите кон-
текстное меню нажатием ПКМ > Move to > Other row и в открывшемся окне напротив 
номера строки введите 3. Структура будет перемещена.

Наложите структуры друг на друга с помощью модуля Superposition (не забудь-
те выделить их все; выделить всю группу можно, щелкнув ЛКМ по заголовку груп-
пы). В окне Superposition напротив строчки Superimpose entries from выберите Project 
Table (selected), в качестве референсной выберите структуру Ddrive Starting Structure, 
поставьте галочку у пункта Add property to Project Table в RMSD options. Используйте 
метод совмещения подструктур (Substructures) и нотацию SMARTS в качестве способа 
их определения (рис. 2.13).

Рис. 2.13. Настройки наложения структур

Теперь необходимо получить выражение SMARTS. Нажмите А на клавиатуре: 
режим выделения атомов будет активирован. Включите первую структуру в Workspace 
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и с зажатым Ctrl выделите все атомы пиримидинонового ядра. Выражение SMARTS 
после выделения должно принять вид:

SMARTS: [#7]1:[#6]:[#7H]:[#6]:[#6]:[#6]:1 

В окне Superposition нажмите Get from selection, затем – Superimpose structures. 
Расчет займет меньше минуты (рис. 2.14).

Рис. 2.14. Выбор шаблона SMARTS для наложения структур

Не снимая выделения со всех структур в группе, дважды щелкните по кнопке 
Include напротив Ddrive Starting Structure, закрепив ее в Workspace. Используя клавиши 
«стрелка вправо» и «стрелка влево», вы будете поочередно включать в Workspace выде-
ленные структуры. Также вы можете включить любое количество структур в Workspace, 
чтобы оценить результаты генерации конформаций. На рис. 2.15 показаны 300 самых 
низкоэнергетических конформаций.

Рис. 2.15. 300 самых низкоэнергетических конформаций
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Получим поверхность потенциальной энергии для сгенерированных конформа-
ций. Проследуйте Task > MacroModel > Plot Coordinate Scan. В открывшемся окне наж- 
мите Load Results для загрузки результатов конформационного поиска. Выберите файл 
mmod_Ddrive-out.grd. Раскройте меню напротив Settings и выберите Scale: Absolute. До-
ждитесь загрузки карты (рис. 2.16).

Рис. 2.16. 2D-карта потенциальной энергии

Отразите в отчете:
1)	 структуру исследуемого соединения;
2)	 снимок Workspace с наложением десяти самых низкоэнергетических конфор-

маций (выделите серым цветом) и конформации с наибольшей энергией (вы-
делите желтым цветом);

3)	 ответьте на вопрос: какие значения торсионных углов соответствуют наибо-
лее низкоэнергетическим конформациям? Добавьте изображение 2D-кар- 
ты в отчет. Включите в Workspace структуру с самой низкой энергией, ис- 
пользуя инструмент Measure > Dihedrals, отобразите значения углов в Work- 
space. Сохраните снимок Workspace (Workspace > Save Image As), добавьте его  
в отчет;

4)	 ответьте на вопрос: чем обусловлено различие в энергиях между самой низ-
ко- и самой высокоэнергетической конформациями? Для ответа – включите 
обе в Workspace, затем Show Workspace Configuration Panel > Workspace Layout > 
Title By > Entry. В меню кастомизации (Style или значок кастомизации справа 
от Current Selection в Structure Hierarchy) выберите тип отображения атомов 
CPK representation. Через меню управления свойствами добавьте в Entry List 
значения Van der Waals Energy-S-OPLS и Bend Energy S-OPLS (энергия из-
гиба валентного угла), щелкните по заголовку столбца ПКМ > Show property 
in Workspace > Add (рис. 2.17).
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Рис. 2.17. Настройки Workspace

Снимок Workspace вставьте в отчет. Покажите на рисунке области, которые могут 
объяснять различия в энергии.

2.3. Конформационный анализ с использованием алгоритма ConfGen

Заметка: часто при SAR-оптимизации структуры полезно варьировать линкеры, сое-
диняющие циклические (особенно ароматические) ядра для оценки влияния на ак-
тивность. В этом упражнении вам будет предложено оценить различия в энергиях 
конформаций для следующих молекул (рис. 2.18). 

Рис. 2.18. Структуры, используемые в упражнении

Алгоритм СonfGen будет использован для выполнения поиска, так как он значитель-
но быстрее, чем любой из методов MacroModel и, кроме того, позволяет генериро-
вать конформации, близкие к биоактивным. Без сомнения, то же позволяет делать 
и MacroModel, к тому же обуславливая гораздо более широкий спектр тонких на-
строек поиска и минимизации. Однако в целях экономии времени и CPU-ресурсов 
мы не будем применять его. Вы можете самостоятельно выполнить тот же поиск, 
используя MacroModel: Task > MacroModel > Conformational Search. 
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2.3.1. Подготовка структур

Импортируйте файл ConfGen_Linkers.mae из своей рабочей директории (Ctrl+I 
или File > Import Structures).

2.3.2. Конформационный поиск

Раскройте группу Phenyl-linker-Pyridyl и включите все структуры в Workspace. За-
тем откройте модуль ConfGen: Task > Bioactive Search. В открывшемся окне выберите 
Workspace напротив Use structures from, установите «50» как число генерируемых кон-
формаций, назовите работу так, как показано на рис. 2.19.

Рис. 2.19. Запуск поиска ConfGen

Нажмите Run. Расчет займет меньше минуты.

2.3.3. Анализ результатов конформационного поиска

Скройте свойства Potential Energy-S-OPLS/Relative Energy-S-OPLS и добавьте 
energy, relative energy через меню управления свойствами в Entry List. Затем выберите 
все группы среди результатов расчета ConfGen, щелкните ПКМ на заголовке столбца 
energy > Sort Selected (Ascending) (рис. 2.20).

Рис. 2.20. Сортировка

Щелкните ПКМ на любом месте в Workspace и выберите Clear Workspace. Вклю-
чите в Workspace самые низкоэнергетические конформеры для каждой из групп. На-
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жмите Ctrl+A > Presets > Apply Deafualt Custom Presets. Выполните выравнивание моле-
кулы с помощью Superposition с использованием Ph-NH2-Py в качестве референсного 
лиганда, шаблон SMARTS определите как атомы углерода пиридинового ядра.

Наложите лиганды друг на друга, чтобы увидеть различия. Щелкните ПКМ по за-
головку столбца energy > Show property in Workspace > Add.

Отразите в отчете:
1)	 структуры исследуемых соединений;
2)	 снимок Workspace с наложением конформаций с самой низкой энергией для 

всех четырех структур, а также значениями energy;
3)	 ответьте на вопрос: какой линкер позволяет получить конформацию с наи-

меньшей энергией и почему?

Вопросы к защите

1.	 Дайте определение понятиям «конформация», «конформационный поиск» 
и «минимизация энергии».

2.	 В чем заключаются суть, достоинства и недостатки систематического конфор-
мационного поиска?

3.	 В чем заключаются суть, достоинства и недостатки стохастического конфор-
мационного поиска?

4.	 Чему пропорциональна вероятность принятия конформации с энергией Ek+1 
в стохастическом поиске Монте-Карло, если Ek+1>Ek?

5.	 Приведите общее уравнение силового поля и охарактеризуйте каждый энерге-
тический термин.

6.	 Каким образом можно учесть влияние растворителя при выполнении конфор-
мационного поиска?

7.	 Какой недостаток метода наискорейшего спуска решается использованием 
подхода «сопряженных градиентов»?

8.	 Какой метод поиска используется модулем Coordinate Scan?
9.	 Для чего применяются подходы конформационного поиска в CADD?
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Лабораторная работа 3

ФАРМАКОФОРНЫЙ ПОИСК

Цель работы: Освоение основных подходов к фармакофорному моделированию 
и скринингу. 
Вам предстоит:
1)	 провести построение и валидацию фармакофорных гипотез с помощью лиганд- 

и структурно-ориентированных подходов;
2)	 выполнить фармакофорный скрининг с помощью полученных гипотез;
3)	 проанализировать его результаты.
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Теоретическое введение

Согласно официальному определению International Union of Pure and Applied 
Chemistry (англ. IUPAC), фармакофор – это совокупность стерических и электронных 
свойств, которые необходимы для обеспечения оптимальных супрамолекулярных вза-
имодействий со специфической биологической мишенью для индукции (или ингиби-
рования) ее биологического ответа [1].

Фармакофор (фармакофорную гипотезу) следует рассматривать как общий зна-
менатель группы молекул, которые обладают сходным фармакологическим профилем 
и распознаются одним и тем же участком белка-мишени. В фармакофорном модели-
ровании каждый тип атома (или группы атомов) в молекуле, проявляющий определен-
ные свойства, сводится к фармакофорным признакам (фармакофорным группам или 
сайтам). Эти структуры могут быть обозначены как доноры (D) или акцепторы (A) 
водородных связей, катионные (P), анионные (N), ароматические/циклические (R) 
или гидрофобные (H) центры. На рис. 3.1 вы можете увидеть пример фармакофорной 
модели для ингибитора BTK пиртобрутиниба (PDB ID: 8FLN [2]), полученного с по-
мощью ПО Phase [3–5].

Алгоритм Phase располагает сайт А на атоме, который несет одну или несколько 
неподеленных электронных пар, а векторный атрибут присваивается каждой идеали-
зированной оси водородной связи в соответствии с гибридизацией акцепторного ато-
ма (сайт D характеризуется аналогично).

Циклы, галогены, алкильные цепи длиной до четырех атомов рассматриваются 
как одна гидрофобная группа. Цепочки из пяти и более атомов углерода разбиваются 
на более мелкие фрагменты и каждый обозначается как отдельный сайт, местоположе-
ние которого представляет собой средневзвешенное положение неводородных атомов 
во фрагменте.

Отрицательно и положительно ионизируемые фрагменты моделируются как одна 
точка, расположенная на формально заряженном атоме или в центре группы атомов 
(возникающие ионизируемые центры автоматически распознаются Phase, представ-
ленные структуры не требуют явной ионизации).

Наконец, если пользователь того пожелает, ароматические кольца можно отли-
чить от других гидрофобных групп и обозначить как отдельный тип фармакофорного 
признака (т. е. R, а не H). В этом случае в центре каждого ароматического кольца по-
мещается точка сайта, а с ним связывается двунаправленный вектор, нормальный 
к плоскости кольца (рис. 3.2) [3].

Фармакофорная модель представляется в непривязанном к конкретной структу-
ре виде, описывается совокупностью сфер определенного радиуса и набором попар-
ных расстояний между ними. Радиус сферы является толерантностью фармакофорно-
го признака (рис. 3.3).

Любой фармакофор может быть также представлен в виде битовой строки; по-
добные представления называются фармакофорными отпечатками пальцев (фармако-
форными ключами). Длина ключа зависит от числа уникальных попарных связей меж-
ду признаками и заданных диапазонов расстояний (например, >1 Å, 1-3 Å, 3-6 Å, <10 Å 
и т. д.). Как можно увидеть на рис. 3.4, признак R16 находится относительно призна- 
ка D5 на дистанции в 9.55 Å – значит ячейка отпечатка, соответствующая диапазону 
9–13 Å, будет содержать значение «1» (иначе 0) [6].
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A Б 

В 

Рис. 3.1. Фармакофорная модель пиртобрутиниба: А – структура пиртобрутиниба; 
Б – способ связывания пиртобрутиниба в активном сайте BTK; В – фармакофорная гипотеза, 

основанная на взаимодействиях, наложенная на структуру пиртобрутиниба; 
красный пунктир – водородные связи, синий пунктир – стэкинговые взаимодействия
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Рис. 3.2. Примеры представления фармакофорных признаков

Рис. 3.3. Представление фармакофорной гипотезы

<3 <3 <3 <3 >13 >13 >13 >13 

Рис. 3.4. Фармакофорный ключ
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Фармакофорное моделирование чаще всего применяется для виртуального скри-
нинга с целью идентификации молекул, вызывающих желаемый биологический эф-
фект. Для этого исследователи создают фармакофорную модель (гипотезу), которая, 
скорее всего, кодирует правильную трехмерную организацию требуемых паттернов 
взаимодействий. В зависимости от того, насколько много известно о конкретном бел-
ке-мишени, доступны варианты построения такой гипотезы как на основе лигандов, 
так и на основе структуры рецептора. Затем происходит сравнение с фармакофорами 
соединений из библиотеки для скрининга. Те структуры, которые продемонстрирова-
ли наилучшее соответствие своих сайтов сайтам гипотезы, идентифицируются в каче-
стве хитов (рис. 3.5).

Рис. 3.5. Виды фармакофорного моделирования

Если структура мишени и лиганды, способные связываться с ней, неизвестны, 
использование подходов фармакофорного моделирования невозможно. Однако фар-
макофорные отпечатки пальцев могут быть использованы для расчетов метрик разно-
образия (несходства) при создании всевозможных виртуальных библиотек.

В случае наличия информации о потенциальной мишени интереса (и/или ком-
плекса «лиганд – мишень») можно применить подход моделирования фармакофоров, 
основанных на рецепторе (RBPM, англ. Receptor-based pharmacophore modeling). Типич-
ный рабочий процесс в данном случае включает в себя подготовку структуры белка, 
анализ способа связывания в активном сайте (или идентификацию потенциальных ак-
тивных сайтов), построение гипотезы и ее применение в ходе скрининга лигандов, сты-
ковки, сравнении и оценки сходства сайтов связывания. Важными фармакофорными 
признаками, которые не рассматривались нами до этого, являются исключенные объемы 
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(англ. Excluded volumes) – области пространства, в которых запрещено расположение 
атомов биологически активных соединений при выполнении моделирования. Это 
естественное продолжение концепции, согласно которой фармакофор отображает меж- 
молекулярные взаимодействия. Молекула, образующая потенциальный солевой мос- 
тик с каким-либо остатком белка, не должна занимать ту же область пространства, что  
и боковая цепь. Исключенные объемы представляются в виде жестких сфер заданного 
радиуса и являются чрезвычайно полезными при RBPM (что, однако, не исключает 
возможности их использования и при моделировании фармакофоров, основанных  
на лиганде).

В случае фармакофорного моделирования, основанного на лигандах (LBPM, англ. 
Ligand-based pharmacophore modeling), первоначально следует озадачиться поиском 
набора активных лигандов, на основе которых и будет строиться будущая гипотеза. 
Необходимо включать в первичный пул также неактивные соединения для облегчения 
идентификации важных фармакофорных признаков и валидации модели. Такой набор 
соединений называется обучающим.

Следующий этап заключается в проведении конформационного анализа, на-
правленного на получение низкоэнергетических трехмерных структур. Практически 
никогда не удается обойтись одной конформацией для одного соединения и при-
ходится иметь дело с ансамблями конформеров. В этом шаге кроется существенная 
проблема: биологически активная конформация может не соответствовать ни одному 
из локальных минимумов, отобранных алгоритмом. Другой негативный момент за-
ключается в том, что исчерпывающий поиск и особенно последующее многокомпо-
нентное выравнивание являются чрезвычайно дорогостоящими и нетривиальными 
процедурами. Обычно конформации, находящиеся близко друг к другу по значениям 
энергии или RMSD атомов, объединяются или часть из них устраняется.

В любом случае для полученного массива конформаций генерируются фарма-
кофорные сайты и выполняется процедура наложения. Суть этого процесса состоит 
в том, чтобы соединить набор активных лигандов, каждый из которых одинаково свя-
зывается с одним и тем же белком неизвестной трехмерной структуры для того, что-
бы общие черты истинного фармакофора стали очевидными. Набор фармакофорных 
свойств структуры какого-либо соединения выбирается в качестве эталона и относи-
тельно него выравниваются все остальные. Фармакофор, соответствующий эталону, 
считается отдельной фармакофорной гипотезой. Затем эталон меняется и наложе- 
ние выполняется снова до тех пор, пока не будут получены все возможные модели, 
т. е. потенциально любой лиганд из набора может дать начало фармакофорной гипо-
тезе. Упрощенно можно сказать, что лучшей гипотезой является та, на которую лучше 
всех накладываются фармакофорные сайты лигандов набора. Однако в действитель-
ности оценка гипотез представляет собой интересную процедуру, которая в каждом ПО 
реализована по-разному (как и собственно процесс идентификации гипотез) [7].

Процедуры генерации трехмерных структур и получения набора фармакофор-
ных свойств повторяются и для лигандов из скрининговой библиотеки. Затем каждый 
из них выравнивается и сравнивается с полученной ранее гипотезой. Концепция иден-
тификации хитов в таком скрининге похожа на таковую для ранжирования гипотез: 
чем лучше накладывается фармакофор какого-либо соединения с гипотезой-этало-
ном, тем больше вероятность того, что это соединение будет обладать должной биоло-
гической активностью (рис. 3.6) [6].



55

Лабораторная работа 3. ФАРМАКОФОРНЫЙ ПОИСК

Рис. 3.6. Рабочий процесс LBPM

Модуль Maestro Schrödinger Phase, используемый для задач фармакофорного мо-
делирования в этой работе, основывается на алгоритмах MacroModel для предваритель-
ной генерации конформаций. Полученные структуры фильтруются через энергетическое 
окно, как правило 5–10 ккал/моль, и проверку избыточности, где любые две структуры  
в пределах одной ккал/моль друг от друга считаются эквивалентными, если все соответ-
ствующие пары тяжелых атомов в двух структурах находятся в пределах заданного поль-
зователем расстояния (как правило, 1–2 Å). Любой k-точечный фармакофор представ-
ляется вектором n расстояний, где n = (k · (k–1))/2 (см. п. 2.3.1). Похожие фармакофоры 
объединяются в соответствии с их межсайтовыми расстояниями d, каждое из которых 
фильтруется через двоичное дерево решений, как показано на рисунке ниже. Таким обра-
зом, определенный фармакофор назначается n-мерному боксу, стороны которого равны 
по длине ширине терминального узла дерева, который обозначается как ɛ (рис. 3.7).

Рис. 3.7. Иллюстрация метода древовидного разделения, используемого для идентификации 
общих фармакофоров на основе межсайтовых расстояний. Это дерево имеет глубину 

четыре и разбивает расстояния в интервале (0, 8] Å на конечные узлы шириной 1 Å
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Каждый бокс в Phase содержит свою фармакофорную гипотезу. Для ее получения 
один из лигандов и его фармакофор среди общего набора принимается за эталонный, 
а все остальные выравниваются относительно него. Выравнивание в большинстве 
программных решений осуществляется с помощью метода наименьших квадратов, ко-
торый минимизирует RMSD между парами точек в пространстве.

Качество выравнивания Phase измеряется тремя способами: (1) показателем вы-
равнивания Ssite, который представляет собой среднеквадратичное отклонение (RMSD) 
координат точек сайтов; (2) показателем Svector, который представляет собой средний 
косинус углов, образованных соответствующими парами векторных признаков (ак-
цепторы, доноры и ароматические кольца) в выровненных структурах; и (3) показате-
лем объема Svol, основанным на перекрытии объемов Ван-дер-Ваальса неводородных 
атомов в каждой паре структур:

 

, 

, 

,   

,    

где cutoffRMSD – определяемое пользователем значение отсечки RMSD (по умолчанию 
равное 1.2); Ssite всегда принимает значение от 0 до 1 (RMSDi > cutoffRMSD);
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где nv – количество векторных признаков в гипотезе, 𝜃𝜃ij – угол между j-м векторным 
признаком в нереферентном фармакофоре и соответствующим векторным признаком  
в эталонном фармакофоре;
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где Volcommon,i представляет собой перекрывающийся объем между лигандом i и эталон-
ным лигандом, а Voltotal,i представляет собой общий объем, занимаемый обоими лиган-
дами. Общий Svol для гипотезы представляет собой среднее значение, полученное в ре-
зультате применения приведенной выше формулы ко всем неэталонным лигандам.

Суммарная же оценка гипотезы Phase S (в оригинальной литературе называемая 
Survial Score) определяется формулой

 

, 

, 
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,    

где 𝜔𝜔 – настраиваемые весовые коэффициенты, Ssel – селективность —эмпирическая 
оценка редкости гипотезы, т. е. того, какая доля молекул с большой вероятностью со-
ответствует модели, независимо от их активности по отношению к рецептору. Селек-
тивность определяется в логарифмическом масштабе, поэтому значение 2 означает, 
что 1 из 102 молекул, как ожидается, будет соответствовать гипотезе. Желательна более 
высокая селективность, поскольку она указывает на то, что гипотеза с большей веро-
ятностью будет уникальной для лигандов активного набора. Селективность – это лишь 
приблизительная оценка редкости, поэтому вам следует быть осторожными и не при-
давать ей слишком большого значения при общем рейтинге гипотез. 𝜔𝜔match – тер- 
мин, позволяющий награждать гипотезы, которые соответствуют большему количеству 
активных соединений (М – число активных лигандов, соответствующих гипотезе). 
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𝜔𝜔match��E – штраф, назначаемый в том случае, когда эталонный лиганд не соответствует 
самому низкоэнергетическому конформеру, а А – активность (все слагаемое 𝜔𝜔А А по-
зволяет штрафовать гипотезы, эталон которых не является самым активным лигандом 
в наборе).

В том случае, когда в обучающий набор включены неактивные лиганды, можно 
провести дополнительную валидацию гипотез. Алгоритм может штрафовать те моде-
ли, которым соответствуют неактивные соединения, вычитая из уже рассчитанного 
cуммарного S для каждой гипотезы оценку Sinactive. Расчет происходит точно так же, как  
и в формулах до этого, за исключением изменения показателя совпадения Ssite:

,    

где k – общее число сайтов неактивной молекулы, m – число сайтов неактивной моле-
кулы, совпавших с таковыми в гипотезе.

Если гипотеза содержит n сайтов, а неактвиный представитель обучащего набора 
только k, то эффективность наложения рассчитывается на основе выравнивания толь-
ко по k-точкам.

Финальная оценка PhaseHypoScore (Sadjust) представляет собой выражение:

.    

Функция оценки PhaseScreenScore, используемая при скрининге библиотек сое-
динений против гипотез, представляет собой просто усеченную до первых трех терми-
нов оценку PhaseHypoScore [3, 4].

Экспериментальная часть

3.1. Создание проекта

В своем личном каталоге создайте папку LW3. Дважды щелкните по ярлыку 
Maestro на рабочем столе. На верхней панели перейдите на вкладку File > Change Work- 
ing Directory. В открывшемся окне укажите путь к рабочей директории LW3 в своей 
личной папке.

Затем перейдите File > Save project as, задайте проекту имя LW3 в графе File name, 
укажите путь к рабочей директории в графе Location.

3.2. Фармакофорное моделирование, основанное на лигандах

3.2.1. Подготовка структур

Скопируйте файл at1.mae в рабочую директорию и импортируйте его в Maestro 
(File > Import или Ctrl+I). Файл содержит 25 подготовленных с помощью LigPrep ли-
гандов, которые будут использоваться для получения гипотез.
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3.2.2. Генерация фармакофорных гипотез

Включите все 25 структур в Workspace: для этого выделите группу, затем, щелкнув 
ПКМ по ее заголовку, выберите Include в открывшемся контекстном меню. Игнори-
руйте предупреждения программы (нажмите Continue во всплывающем окне). Как вы 
можете увидеть, лиганды не выравнены.

Заметка: несмотря на то, что Phase производит выравнивание структур при гене-
рации гипотез, иногда полезно выполнять предварительное выравнивание с по- 
мощью инструмента Flexible Ligand Alignment (для идентификации возможных био-
активных конформаций). В этой работе мы не будем выполнять предварительное 
выравнивание.

	

Откройте модуль генерации фармакофорных гипотез Phase: Task > Ligand-Based 
Virtual Screening > Develop Pharmacophore Hypotheses. В открывшемся окне раскройте 
список под Create pharmacophore model using и выберите Multiple ligands (selected entries) 
(не забудьте, что все лиганды должны быть выделены в Entry List). Программа будет 
производить расчет некоторое время (1–4 минуты), затем все фармакофорные сайты 
будут отображены в Workspace.

Для определения активных и неактивных соединений в наборе нажмите Define 
в разделе For Actives/Inactives Split (selected entries) (рис. 3.8).

Рис. 3.8. Создание фармакофорных сайтов и определение активных соединений

Выберем свойства и пороговые значения, которые будут использованы для клас- 
сификации соединений набора как активные/неактивные. В открывшемся окне Define 
Actives and Inactives в правой его части среди доступных свойств выберите pIC50-Exp, 
щелкнув по заголовку ЛКМ. Установите Set Active if activity как ≥ 7.30 и Set Inactive if 
activity как ≤ 5.00. Нажмите Apply > OK (рис. 3.9).

Заметка: вы также можете вручную указать лиганды, которые должны соответство-
вать гипотезе, установив метки в столбце Required Match для желаемых молекул.

	

Выберите пункт Find Best Alignment and Common Features в разделе Pharmacophore 
Method. Теперь Phase будет использовать только лучшие наложения при создании ги-
потез. Пункт Use Prealigned Ligands используется в случае, если вы выполнили вырав-
нивание до импорта структур в модуль создания гипотез.
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Рис. 3.9. Классификация соединений

Откройте панель настройки гипотез, нажав на кнопку Hypothesis Settings. Во вклад-
ке Features в разделе Number of features in the hypothesis установите диапазон сайтов в ги-
потезе как «5 из 6», а Preferred minimum number of features (предпочитаемое минимальное 
число сайтов) как «5».

В таблице, расположенной в нижней части, в столбце Minimum установите зна-
чение «1» напротив (D) Donor и (N) Negative. В разделе Feature presets установите Make 
acceptor and negative equivalent. Теперь Phase будет сохранять только те гипотезы, где 
есть как минимум один донор водородной связи и/или один акцептор/анионный 
центр (рис. 3.10).

Заметка: опция Exclude features from hypothesis (исключить сайты из гипотезы) по-
зволяет скрыть любые сайты, которые вы не хотите видеть в гипотезе Phase. Это 
может быть использовано для маскировки признаков в консервативном ядре, что-
бы «заставить» алгоритм «сосредоточиться» на более переменных областях серии 
соединений.

	

Создадим исключенные объемы. Перейдите на вкладку Excluded Volume и нажми-
те Create excluded volume shell. Выберите Actives and Inactives в разделе Create shell from 
и нажмите Save. Теперь Phase создаст исключенные объемы в тех областях, где отсут-
ствуют атомы активных структур, но присутствуют атомы неактивных (рис. 3.11).
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Рис. 3.10. Настройки количества сайтов для генерации гипотез

Рис. 3.11. Создание исключенных объемов

Вернитесь в окно Develop Pharmacophore Model, измените имя работы на «at1_dcph» 
и нажмите Run. Расчет занимает примерно 6–10 минут на четырех процессорах.

Когда расчет завершится, в Entry List будет добавлена группа at1_dcph, содержа-
щая 20 различных гипотез.
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Заметка: буквы в названии каждой гипотезы соответствуют тем сайтам, которые 
в ней содержатся. Например, ADRR – это гипотеза, включающая акцептор и донор 
водородной связи, два ароматических кольца. 

	

Раскройте группу DHNRRR_1 и закрепите запись DHNRRR_1 в Workspace двой-
ным щелчком ЛКМ по кнопке Include. Включите все лиганды из подгруппы Active. Об-
ратите внимание на соответствие всех сайтов гипотезы наложенным лигандам. Кроме 
того, активные соединения не занимают области Excluded Volumes. Выключите под-
группу Active. Аналогичным образом раскройте группу Inactive Partial Match и осмо-
трите лиганды (рис. 3.12).

Рис. 3.12. Наложение лигандов, соответствующих активной гипотезе DHNRRR_1

Отразите в отчете:
1)	 2D-карту фармакофора DHNRRR_1. Для этого оставьте в Workspace только за-

пись самой гипотезы DHNRRR_1, затем в строке избранных заданий выберите 
инструмент Measure и отобразите все расстояния между сайтами в Workspace. 
Для измерения расстояния кликните ЛКМ по сайтам, между которыми его 
надо определить. В отчете приведите нарисованную карту и снимок экрана 
Workspace с показанными расстояниями;

2)	 таблицу со значениями PhaseHypoScore для всех сгенерированных гипотез. 
Для этого откройте панель Project Table. В Property Tree (справа) снимите фла-
жок с пункта All. Через строку поиска найдите свойство PhaseHypoScore и по-
ставьте рядом с ним флажок. Выделите все группы с гипотезами. В верхней па-
нели нажмите Data > Export > Spreadsheet. Выберите формат Exel для экспорта  
и назовите файл по своему усмотрению. В таблице для отчета должны быть 
только гипотезы и значения скоринга для них.

3.2.3. Создание базы данных Phase

Импортируйте файл DUD-E_act_3chp_trainc.mae, содержащий лиганды, которые 
будут использованы для создания базы (Ctrl+I или File>Import). Затем выберите группу 
DUD-E_act_3chp_trainc в Entry List и откройте модуль создания скрининговых наборов 
Phase: Tasks > Ligand-Based Virtual Screening > Create Database.
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Заметка: на этом этапе нам будет необходимо создать базу данных, содержащую 
соединения для фармакофорного поиска с помощью Phase. В ходе создания такого 
скринингового набора Phase автоматически генерирует низкоэнергетические кон-
формации, выполняет создание фармакофорных сайтов и выравнивание, а затем 
удобно складирует данные в файлах формата .db. Вы можете использовать одну 
и ту же базу данных для поиска против различных гипотез. Phase способен рабо-
тать и с непредобработанными лигандами, однако предварительное создание базы 
очень сильно сокращает время скрининга. 

	

В открывшемся окне Create Phase Database перейдите на вкладку Input. Напро-
тив Choose task выберите Create new database для создания новой базы. Если вы пла-
нируйте дополнить существующий набор, следует выбрать Append to Existing database. 
Определите место сохранения базы данных, указав путь к своей рабочей директории 
в разделе Specify the database location on the job.

Выберите Project Table (selected entries) напротив Use ligands from, а в разделе 
Conformation Generation выберите Generate ligand conformers. Проверьте, чтобы число 
генерируемых конформаций было равно «50» (рис. 3.13).

Рис. 3.13. Установка входных настроек модуля 
создания базы данных Phase
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Рис. 3.14. Установка настроек фильтрации лигандов модуля 
создания базы данных Phase

Перейдите на вкладку Ligand Filtering. Выберите первые три пункта в разделе 
Filter Prepared Ligands. Теперь для всех соединений в наборе будут сгенерированы фи-
зико-химические свойства с помощью алгоритма QikProp, и соединения, содержащие 
реакционно-способные группы, а также не соответствующие правилам Липински, бу-
дут исключены. Вкладка Ligand Preparation отвечает за параметры подготовки лигандов  
с помощью интегрированного в Phase алгоритма QikProp. Все настройки автоматиче-
ски устанавливаются по умолчанию и не будут изменяться в этой лабораторной работе. 
Оставьте название задания «Phasebd_1» и нажмите Run. Расчет на 4 процессорах зани-
мает 5 минут (рис. 3.14).

3.2.4. Скрининг базы данных Phase

С помощью Ctrl включите в Workspace гипотезы DHNRRR_1, DHNRRR_2 
и ADHNRR_1 из группы at1_dcph. Откройте модуль скрининга Tasks > Ligand-Based 
Virtual Screening > Ligand Screening. В разделе Ligands to screen выберите File, за-
тем Browse и укажите файл, содержащий созданную вами базу данных. Нажмите Add 
Hypothesis > Workspace. В таблицу ниже будут автоматически добавлены включенные 
вами в Workspace гипотезы. Вы можете настроить число сайтов, которые должны со-
впасть, а также учесть исключенные объемы в соответствующих столбцах. В этой ра-
боте оставим без изменений эти параметры (рис. 3.15).



64

А.Ю. Кудинов, А.С. Бунев Основы молекулярного моделирования биологически активных веществ

Рис. 3.15. Импорт базы данных и гипотез в модуль скрининга

Откройте окно настроек скрининга, нажав Screening Settings. Перейдите на вклад-
ку Constraints и нажмите Pick features. В Workspace включите только DHNRRR_1 и вы-
берите сайты R10, R11 с помощью Ctrl. Затем нажмите Add Constraint. Повторите это 
для остальных гипотез (рис. 3.16).

Рис. 3.16. Настройка ограничений
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Заметка: на вкладке Constraints можно задать ограничения на расстояние, значения 
валентных и торсионных углов для комбинаций отдельных признаков в гипотезах, ис-
пользуемых при скрининге. Чтобы добавить ограничения к гипотезе, гипотеза должна 
отображаться в рабочей области. Выделение двух сайтов определяют ограничение 
расстояния, трех – ограничение угла, а четырех – торсионное ограничение.

	

Перейдите на вкладку Conformers и проверьте, чтобы был выбран пункт Use Existing 
Conformers. Нажмите Save. Назовите работу «at1_dcph_screen», затем нажмите Run. Рас-
чет на одном процессоре займет примерно 3 минуты.

Заметка: вкладка Conformers отвечает за настройки генерации конформаций. Так как 
мы используем готовую предобработанную базу данных, нам незачем еще раз про-
водить конформационный поиск, однако вы все равно можете провести его в режиме 
on-the-fly прямо во время фармакофорного скрининга, нажав Generate Conformation 
During Search.
Настройки, доступные на вкладке Features, по наполнению и смыслу аналогичны та-
ковым в модуле создания гипотез. Вкладка Scoring позволяет провести калибровку 
значений вкладов оценочной функции (рис. 3.17). 

Рис. 3.17. Параметризация оценочной функции 

Вкладка Groups позволяет провести группировку сайтов в гипотезе, а Criteria – на-
строить пороговые значения компонентов оценочной функции Phase, определяющие 
отбраковку лигандов. 

	

После завершения расчета раскройте группу at1_dcph_screen и подгруппу 
AHNRRR_1. Включите и зафиксируйте саму гипотезу AHNRRR_1 в Workspace, затем 
выберите всю подгруппу AHNRRR_1. С помощью клавиш «стрелка вправо» и «стрелка 
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влево», поочередно включая в Workspace лиганды, оцените степень их соответствия ги-
потезе. Добавьте в Entry List свойства PhaseScreenScore и Matched Ligand Sites. Озна-
комьтесь с результатами.

Отразите в отчете: ответьте на вопрос – почему лиганд CHEMBL480909 в группе 
DHNRRR_1 имеет значение PhaseScreenScore выше, чем CHEMBL14502, хотя демон-
стрирует худшее соответствие сайтов?

3.2.5. Создание фармакофорной гипотезы 
на основе структурно-разнообразного набора лигандов
Очистите Workspace. Выберите все лиганды группы DUD-E_act_3chp_trainc, ис-

пользовавшейся в предыдущем упражнении, и включите первую запись в Workspace.

Заметка: до этого мы генерировали гипотезы, основываясь на выравнивании струк-
турно схожих соединений. Нетривиальную задачу представляет собой получение ги-
потез из наборов, отличающихся разнообразием. Еще более сложной задачей являет-
ся выбор лучшей гипотезы из этого множества.

	

Откройте панель Develop Pharmacophore Hypothesis: Tasks > Ligand Based Virtual Screen- 
ing > Develop Pharmacophore Hypothesis. Выберите Multiple ligands (selected entries) в разделе 
Create pharmacophore model using. Фармакофорные сайты будут отображены в Workspace. 
Выберите Find best alignment and common features, затем откройте настройки гипотезы. 
На вкладке Features, установите Hypothesis should match at least как «25%» и Number of 
features in the hypothesis как «4 to 7». Проверьте, чтобы напротив Preferred minimum number 
of features было установлено значение «5». Установите критерий различий между гипоте-
зами (Hypothesis difference criterion) как «1.00» и нажмите Save (рис. 3.18).

Рис. 3.18. Настройки количества сайтов гипотез и различия гипотез
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В окне Develop Pharmacophore Hypothesis в разделе настроек конформационного 
поиска поставьте галочку у пункта Generate conformers, нажмите Options и установите 
«50» напротив Target number of conformers. Назовите задание как «lkha4_common» и на-
жмите Run. Расчет на 4 процессорах занимает ориентировочно 30 минут (рис. 3.19).

Рис. 3.19. Запуск задания

Для того чтобы просмотреть гипотезы, щелкните дважды по значку . После за-

вершения задания выберите группу lkha4_common. Нажмите на значок  рядом 
с заголовком группы. Выберите Analysis > Detect binding modes. Установите количество 
предполагаемых способов связывания (Proposed number of binding modes) в открывшем-
ся окне равное «3». Лиганды и гипотезы будут сгруппированы по способам связыва-
ния. Познакомьтесь с результатами кластеризации.

3.3. Структурно-ориентированный фармакофорный поиск

3.3.1. Подготовка структур

Загрузите и подготовьте структуру комплекса лейкотриен-А-4 гидролазы с (3S)-3-ами- 
но-4-оксо-4-[(4-фенилметоксифенил)амино]бутановой кислотой (PDB ID: 3CHP) [9]. 
В разделе Preprocess:

–	 замените (дополните) атомы водорода с помощью Replace Hydrogens;
–	 уточните порядки связей с использованием базы CCD;
–	 создайте корректные дисульфидные связи и координационные связи с метал-

лами;
–	 спрогнозируйте состояния протонирования с использованием алгоритма Epik 

(pH = 7.0±2).
Если препроцессинг белка был выполнен правильно, никаких проблем не бу-

дет идентифицировано после нажатия кнопки Check Structure в разделе Diagnose and 
Analysis. Не удаляйте подструктуры (YB801, ACT820, IMD850, 4BO901, ZN701) из со-
става комплекса. Выполните оптимизацию направлений водородных связей и мини-
мизацию согласно стандартному протоколу, описанному в лабораторной работе 1.

3.3.2. Автоматическая генерация фармакофорных гипотез

Включите в Workspace запись 3CHP – removed water, затем дважды щелкните ЛКМ 
по панели Presets. Структура в Workspace обновится и станет более удобной для работы.

Откройте панель разработки фармакофорных гипотез: Tasks > Browse > Ligand-
Based Virtual Screening > Develop Pharmacophore Hypothesis. Выберите Receptor-ligand 
complex (Workspace) в разделе Create pharmacophore model using. В качестве метода опре-
деления сайтов (Method) выберите Auto (E-Pharmacophore), затем в разделе выбора ли-
ганда: A:4BO (901). Откройте панель настройки гипотезы (рис. 3.20).
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Рис. 3.20. Создание гипотезы

Рис. 3.21. Настройки сайтов гипотезы и создание исключенных объемов
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Заметка: автоматический метод включает в себя использование терминов скоринго-
вой функции Glide XP [8] для определения сайтов, в наибольшей степени способству-
ющих связыванию. Вы можете вручную построить гипотезу, руководствуясь имеющи-
мися взаимодействиями с рецептором и собственными соображениями.

	

На вкладке Features выберите Donors as vectors. Затем создайте исключенные объ-
емы, перейдя на соответствующую вкладку, где выберите Create receptor-based excluded 
volume shell, оставив остальные настройки так, как они установлены по умолчанию. 
Нажмите Save (рис. 3.21).

Измените название задания на «lkha4_epharm_exvol» и нажмите Run. Расчет зай-
мет 3–5 минут.

3.3.3. Ручная корректировка фармакофорных гипотез
Включите в Workspace запись самой гипотезы lkha4_epharm_exvol, а также за-

пись комплекcа 3CHP – removed water. Осмотрите сайты и взаимодействия, опреде-
ленные Phase.

Заметка: в ряде публикаций отмечается взаимодействие между основной цепью 
остатка TRP311 и связанным лигандом [9, 10]. Поскольку этот сайт отсутствует в ранее 
созданной гипотезе фармакофора, мы можем добавить его вручную.

	

В разделе Method окна Develop Pharmacophore Model выберите Manual. Программе 
может потребоваться время (1–3 минуты) для перехода в режим ручной настройки 
(рис. 3.22).

Рис. 3.22. Переход в ручной режим

В появившемся ниже разделе Show Features перетащите ползунок до упора вправо 
(More). Откройте окно настройки гипотезы и создайте исключенные объемы, затем 
нажмите Save (рис. 3.23).

Отобразите ароматические водородные связи. Для этого в панели настройки

конфигурации Workspace нажмите на три точки над значком . Справа в разде-

ле Non-covalent bonds выберите Ligand-Receptor, затем кликните по Aromatic H-Bonds. 
В разделе Contacts/Clashes отключите отображение Bad Clashes для удобства работы  
в Workspace (рис. 3.24).
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Рис. 3.23. Настройки сайтов гипотезы и создание исключенных объемов

Рис. 3.24. Настройки отображения взаимодействий в Workspace

В панели Structure Hierarchy, нажмите на значок поиска и введите «TRP 311». Бу-
дет выполнен поиск среди всех остатков записи. Щелкните ЛКМ по строке TRP311 
среди результатов поиска, тем самым выбрав эту аминокислоту. В панели настройки 
фокусировки рядом с Fit нажмите на Fit view to selected atoms. Теперь фокус в Workspace 
будет смещен на выбранные атомы (рис. 3.25).

Вернитесь к панели Develop Pharmacophore Model, в разделе Choose features уста-
новите флажок напротив Add и выберите Donor in Workspace. Появится баннер, предла-
гающий выбрать атом.

Выберите атом водорода кольца R7 лиганда, участвующего в образовании аромати-
ческой водородной связи. Вектор сайта D7 появится в Workspace, а сам D7 будет добав-
лен в раздел Choose features панели Develop Pharmacophore Model (рис. 3.26).

Cкорректируйте направление вектора. Щелкните ПКМ по D7 и в открывшемся 
окне редактирования сайта (Edit Feature D7) поставьте галочку напротив пункта Manually 
reposition feature. C зажатой Shift (или Alt) с помощью колесика мыши (или перетаскива-
ния с зажатой ЛКМ) измените направление D7 так, чтобы оно совпадало с направле-
нием ароматической связи, отображенной в Workspace. Нажмите ОК (рис. 3.27).
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Рис. 3.25. Фокусировка на остатке TRP311 в Workspace

Рис. 3.26. Ручное добавление фармакофорного сайта в гипотезу

Рис. 3.27. Корректировка направления векторного компонента сайта
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В окне Develop Pharmacophore Model в разделе Choose features выберите оставши-
еся пять сайтов, назовите гипотезу «lkha4_manual» и нажмите Create. Сайт D3 может 
быть не обнаружен. Если вы столкнулись с такой ситуацией, его добавление не требу-
ется. Расчет займет 3–6 минут (рис. 3.28).

Choose features: 

Pick feature in Workspace 

Add Vorksp �е 

Hypothesis Settings ... 

Hypothesis name: 

lkha4_manual 

Рис. 3.28. Выбор сайтов и создание гипотезы

Для просмотра свойств сайтов в Workspace в Entry List напротив записи гипотезы 
lkha4_manual нажмите на значок «H», затем Show > Feature Properties (Гипотеза должна 
быть включена в Workspace) (рис. 3.29).

Choose features: 

Pick feature in Workspace 

Add Vorksp �е 

Hypothesis Settings ... 

Hypothesis name: 

lkha4_manual 

Рис. 3.29. Отображение свойств сайтов

Исключенные объемы также могут быть добавлены вручную. Хотя их генерация 
в автоматическом режиме происходит чаще всего правильно, иногда может возник-
нуть потребность в дополнительном создании такого рода сайтов. Добавим исключен-
ный объем вокруг HIP139. Для этого также выберите атомы остатка и сфокусируйтесь  
на них в Workpace. Напротив lkha4_manual нажмите на «H» и выберите Manage Excluded 
Volumes. В открывшемся окне Manage Excluded Volumes нажмите Selected Atoms. Объе-
мы будут созданы вокруг всех атомов остатка. Для удаления или изменения парамет- 
ров каждого сайта необходимо воспользоваться таблицей ниже. Выберите последнюю 
строчку и нажмите Delete. Нажмите Close (рис. 3.30).
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Рис. 3.30. Создание исключенных объемов в ручном режиме

Объедините гипотезы. Это действие позволяет комплексно оценить, какие сайты  
и свойства важны для получения самой точной модели и избавиться от избыточности. 
Включите обе гипотезы в Workspace, затем нажмите на значок «Н» рядом с каждой из них  
и выберите Show > Reference Ligand. В Workspace должны отображаться обе гипотезы и ре- 
ференсные лиганды для них. Вернитесь в окно Develop Pharmacophore Model и в разделе 
Create pharmacophore hypothesis using выберите Merged hypotheses (Workspace). В разделе 
Choose features для from lkha4_manual выберите сайты D3, N5, P6, и XVols, а для lkha4_epharm_ 
exvol выберите R6 and R7. Назовите работу «lkha4_merge» и нажмите Create (рис. 3.31).

Рис. 3.31. Создание объединенной гипотезы
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3.3.4. Фармакофорный скрининг

Импортируйте файлы DUD-E_Actives.mae и DUDE_Inactives.mae, содержащие 
лиганды, которые будут использованы при скрининге. Выберите в Entry List одно- 
именные группы и включите гипотезу lkha4_merge в Workspace.

Cледуя путем Tasks > Browse > Ligand-Based Virtual Screening > Ligand Screening, от-
кройте модуль Phase Ligand Screening, в разделе Ligands to screen выберите Project Table 
(selected entries). Нажмите Add Hypothesis и выберите Workspace. Гипотеза lhka4_merge 
будет добавлена в таблицу. В столбце Matches выберите «3 of 5». Откройте настройки 
скрининга. Перейдите на вкладку Groups. В Workspace с помощью ЛКМ выберите D1 
и R5, затем нажмите Create Group. Теперь лиганд, который не покажет соответствие 
хотя бы одному из сгруппированных сайтов, будет отклонен в ходе скрининга, даже 
если совпадут все остальные сайты. Нажмите Save (рис. 3.32).

Рис. 3.32. Настройки фармакофорного скрининга

Измените имя задания на «lkha4_screen» и нажмите Run. Расчет может занять до 
10 минут.

Визуализируйте и проанализируйте результаты так же, как вы делали это в случае 
лиганд-ориентированного фармакофорного моделирования.

Отразите в отчете:
1)	 2D-фармакофорную карту для lhka4_merge;
2)	 результаты скрининга в виде таблицы, в которой отразите значения Phase- 

SreenScore, а также Mathced Ligand Site;
3)	 рассчитанные значения чувствительности (SEN) и специфичности (SPC) 

для гипотезы lhka4_merge. Укажите количества ложноположительных (FP), 
истинно-положительных (TP), ложно- и истинно-отрицательных (FN и TN) 
результатов по формулам
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, 

, 

где TP (англ. True positive), TN (англ. True negative), FP (англ. False positive), FN 
(англ. False negative) – число соединений, классифицированных как истин-
но-положительные, истинно-отрицательные, ложноположительные и лож-
ноотрицательные соответственно.

Вопросы к защите

1.	 Сформулируйте определение понятия «фармакофор».
2.	 Сформулируйте определение понятия «фармакофорный сайт».
3.	 Какие виды фармакофорных сайтов вы знаете?
4.	 Какие атрибуты характеризуют фармакофорные сайты?
5.	 Что такое исключенные объемы и чем полезны признаки такого типа при вы-

полнении фармакофорного моделирования?
6.	 Что такое фармакофорный ключ?
7.	 Какой смысл несут в себе термины 𝑤eD𝛥E и 𝑤actA в составе оценочной функ-

ции PhaseHypoScore?
8.	 Когда фармакофорное моделирование может применяться в процессе откры-

тия лекарств?
9.	 Перечислите ограничения методов фармакофорного моделирования.

Рекомендуемая литература
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МОЛЕКУЛЯРНЫЙ ДОКИНГ
Цель работы: освоение основных подходов к проведению молекулярного докинга  
с жестким рецептором для нужд дизайна лекарств.
Вам предстоит:
1)	 подготовить структуры белка и рецептора для проведения молекулярного до-

кинга;
2)	 выполнить расчет сетки потенциалов (грид-бокса) для активного сайта рецеп-

тора, а также провести докинг нативного лиганда;
3)	 осуществить процедуру стыковки с использованием различных протоколов точ-

ности и сравнить результаты. 
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Теоретическое введение

Согласно определению, данному в Глоссарии рускоязычных терминов в меди- 
цинской химии: «докинг, молекулярный докинг (docking, molecular docking) – методы 
молекулярного моделирования, обеспечивающие быстрый поиск и оценку возможности, 
места и способа связывания (оптимального соответствия) между лигандом и сайтом связы-
вания биомишени» [1].

Большинство программных решений реализуют стыковку с жестким рецепто-
ром, в ходе которой геометрия аминокислотных остатков белка остается неизмен-
ной. С точки зрения конформационной подвижности лиганда можно выделить гибкий 
(flexible) и жесткий (rigid) докинг. В первом случае малой молекуле «позволяется» до-
полнительная конформационная подвижность, достигаемая путем изменения валент-
ных и торсионных углов, а во втором – нет, и разрешены только вращательные и по-
ступательные движения для всей структуры целиком.

Ранжирование поз происходит с помощью скоринговых функций – математи-
ческих выражений, позволяющих количественно оценить эффективность взаимодей-
ствий, стабильность/выгоду ориентации лиганда в сайте [2, 3]. Здесь и далее оценоч- 
ные функции обозначаются как 𝛥G, однако вы должны понимать, что получаемые значе-
ния не соответствуют истинным свободным энергиям связывания, а являются лишь их 
оценками.

Выделяют несколько типов скоринговых функций.
C помощью функций, основанных на силовых полях, энергию связывания вы-

числяют путем суммарной оценки ван-дер-ваальсовых и электростатических взаимо-
действий между всеми парами атомов «белок – лиганд», обычно учитывая энтальпийный 
эффект взаимодействия малой молекулы с мишенью, но пренебрегая энтропийным, 
хотя в ряде случаев энергия десольватации может учитываться с моделированием рас-
творителя в явном или неявном виде [4, 5]:

 , 

, 

где Evdw и Eelec – значения суммарных попарных вкладов ван-дер-ваальсовых и электро-
статических взаимодействий соответственно.

Эмпирические скоринговые функции приблизительно оценивают энергию свя-
зывания комплекса путем суммирования вкладов (термов) важных для связывания 
взаимодействий, таких как водородные связи, гидрофобные и электростатические 
контакты и т. д. Обычно уравнение эмпирической функции получается с помощью ре-
грессионного анализа на обучающем наборе комплексов «белок – лиганд» с известным 
сродством для получения значений и оптимизации коэффициентов энергетических 
термов [6]:

 , 

, 

где wn – веса энергетических термов, а �GvdW, �GHBond, �GPhob, �Grot – вклады ван-дер-ва-
альсовых, водородных связей, гидрофобных взаимодействий и торсионной энтропии 
лиганда, соответственно.

Knowledge-based (англ. KB) функции основаны на статистическом анализе взаи- 
модействующих пар атомов из доступных в PDB комплексов «белок – лиганд». Эти 
данные о парных контактах преобразуются в псевдопотенциалы, также известные как 
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потенциалы средней силы, которые описывают предпочтительную геометрию белок-ли-
гандных взаимодействий [7]:

, 

где kB и T – константа Больцмана и температура соответственно, а 𝜌ij(r) и 𝜌*
ij – плот-

ность парных контактов между атомами i и j на расстоянии r в текущем и референсном 
комплексах соответственно.

Большая часть программ требует предварительной генерации грид-бокса, огра-
ничивающего область стыковки, внутри которого также заранее рассчитываются 
атомные потенциалы взаимодействия с помощью различных зондов. Единожды рас-
считанная сетка рецептора будет затем использована для оценки конформаций всех 
лигандов.

Рабочий процесс алгоритма Glide [8–11], реализованный в ПО Schrödinger, вклю-
чает шаги, описанные ниже. Как уже говорилось ранее, на первом этапе генерируется 
грид-бокс, в ходе чего рассчитываются несколько типов молекулярных полей рецеп-
тора. Среди остатков, содержащих тиольные или гидроксильные группы, пользовате-
лем могут быть указаны те, которым будет позволено дополнительное вращение при 
выполнении стыковки.

Первоначальный конформационный поиск позволяет исчерпывающе исследовать 
конформационное пространство лиганда. Конформации представляются в виде жестко-
го ядра (англ. core) и прикрепленных к нему вращаемых групп (англ. rotable groups).

Полученные конформации затем проходят серию иерархических фильтров и оце-
нок, представленных ниже (рис. 4.1).

Рис. 4.1. «Воронка» Glide [8]

Для конформаций ядра выполняется поиск возможных положений и ориентаций. 
Поиск начинается с выбора точек сайта, которые может занимать ядро, определяемых  
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на сетке с шагом 2 Å. Чтобы сделать этот выбор, предварительно вычисленные рассто-
яния от точки сайта до поверхности рецептора сравниваются с расстояниями от цен-
тра лиганда до поверхности лиганда. Для гибкой стыковки центр лиганда определяется 
как середина двух наиболее удаленных друг от друга атомов. Линия, проходящая через 
эти атомы, называется диаметром лиганда. Glide позиционирует центр лиганда в точке 
сайта, если имеется достаточно хорошее совпадение расстояний.

На втором этапе исследуется размещение атомов, лежащих на заданном расстоя- 
нии от оси диаметра лиганда, для заранее заданного выбора возможных ориентаций 
диаметра (тест диаметра лиганда). Поза пропускается при наличии стерических столк- 
новений с рецептором.

Далее лиганд поворачивается вокруг диаметра и рассчитывается подмножество 
атомов, способных образовывать водородные связи с рецептором (тест подмножеств). 
Если эта оценка удовлетворительна, оцениваются все взаимодействия с рецептором 
c помощью ограниченной версии основной функции скоринга GreedyScore. Здесь же 
реализуется этап уточнения, в ходе которого лигандам позволяется жестко двигаться 
в пределах 1 Å и быть повторно оцененными.

Небольшое количество уточненных поз (обычно не более 400) минимизируется 
с помощью силового поля OPLSР [12]. Наконец, несколько поз с наименьшей энер-
гией, полученных таким образом, подвергаются процедуре поиска конформаций 
Монте-Карло и повторной минимизации. Финальный скоринг происходит с исполь-
зованием функции Glide GScore:

, 

где первый член (lipo-lipo) включает зависимую от расстояния оценку гидрофобных 
взаимодействий всех пар атомов лиганд-рецептор (lr), которые определяются как ли-
пофильные; второй (Hbond) кодирует энергетический терм водородных связей. Функ-
ции f, g и h дают полную оценку расстояниям ∆r или углам ∆α, когда те принимают 
значения в пределах определенных порогов. Основной вклад в GScore вносят энергии 
кулоновского и ван-дер-ваальсового взаимодействий (третий и четвертый члены). Пя-
тый член оценивает вклад полярных, но не имеющих водородных связей атомов в ги-
дрофобных областях. Термин metal-ion кодирует энергию взаимодействий лиганд-ме-
талл (lm); слагаемое solv.term неявно учитывает эффекты растворителя и десольватации 
лиганда, а последний терм назначает «штраф» за большое количество вращающихся 
связей [8].

Кроме того, алгоритм Glide позволяет проводить стыковку в трех режимах точности:
–	 HTVS (англ. Hight-throughput Virtual Screening) – предназначен для быстро- 

го скрининга очень большого количества лигандов. HTVS имеет ограничен-
ную конформационную выборку, а расширенные настройки для него недо-
ступны [13];

–	 SP (англ. Standard Precision) – более точный протокол, реализующий исчер-
пывающий поиск ориентаций лиганда в сайте, в том числе в режиме гибкой 
стыковки. Протокол SP установлен по умолчанию при открытии панели Glide  
в Maestro [13];
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–	 XP (англ. Extra Precision) – мощная и избирательная процедура, выполнение 
которой занимает больше времени, чем докинг, выполняемый на остальных 
протоколах. XP предназначен для повторной оценки поз лигандов, имеющих 
высокий балл по результатам HTVS/SP и отсеивания ложноположительных 
результатов. Рекомендуется сначала применить SP, затем взять от 10 до 30 % 
окончательных лучших поз и пристыковать их повторно с помощью XP [10].

При запуске стыковки в режиме повышенной точности пользователь может по-
лучить дополнительную информацию о значениях следующих энергетических терми-
нов скоринговой функции XP GScore (табл. 4.1):

Таблица 4.1

Дескрипторы XP [13]

Дескриптор Описание

GScore Полный GlideScore. Сумма всех дескрипторов

LipophilicEvdW Терм липофильности, определяемый по степени комплементарности гидрофобных 
поверхностей лиганда и рецептора

PhobEn Награда за размещение гидрофобных частей лиганда в локальных гидрофобных областях сайта

PhobEnHB Награда за водородные связи, образованные в локальных гидрофобных областях сайта

PhobEnPairHB Награда за коррелированные (парные) водородные связи, образованные в локальных 
гидрофобных областях сайта

HBond Дескриптор, кодирующий вклад водородных связей

Electro Дескриптор, кодирующий вклад электростатических взаимодействий

𝜋-Cat Награда за π-катионные взаимодействия

ClBr Награда за атомы Cl/Br, находящиеся в гидрофобном окружении, которые взаимодействуют  
с Asp или Glu

LowMW Награда для лигандов, обладающих небольшим молекулярным весом

Penalties Суммарный штраф за невыгодную ориентацию полярных групп лиганда, десольватацию 
и внутримолекулярные контакты лиганда

HBPenal Штраф лигандам с большим числом гидрофобных контактов и низкими показателями XP HBond

ExposPenal Штраф за группы лиганда, ориентирующиеся в область растворителя

RotPenal Штраф за вращающиеся связи

Экспериментальная часть

4.1. Создание проекта

В своем личном каталоге создайте папку LW4. Дважды щелкните по ярлыку 
Maestro на рабочем столе. На верхней панели перейдите на вкладку File > Change 
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Working Directory. В открывшемся окне укажите путь к рабочей директории LW4 в своей 
личной папке.

Затем перейдите File > Save project as, задайте проекту имя LW4 в графе File name, 
укажите путь к рабочей директории в графе Location.

4.2. Подготовка к молекулярному докингу

4.2.1. Подготовка структур

C помощью модуля Protein Preparation Workflow выполните загрузку и подготов-
ку комплекса фактора свертывания Ха (PDB ID: 1FJS [14]) с ингибитором ZK-807834  
(CI-1031) в соответствии со стандартным протоколом, описанным в лабораторной рабо-
те 1. Дважды нажмите на панель Presets для настройки удобной визуализации структур  
в Workspace. Выполните сплитирование (Ligands, Waters, Other). Подготовьте нативный 
лиганд с помощью модуля LigPrep. Используйте стандартный протокол (рН=7.0±2), 
имя задания: «ligprep_1fjs».

4.2.2. Генерация сетки потенциалов

Выделите запись подготовленного комплекса в Entry List, затем откройте мо-
дуль генерации сетки потенциалов: Tasks > Browse > Receptor-Based Virtual Screening > 
Receptor Grid Generation. В открывшемся окне на вкладке Receptor определите область 
для стыковки. Для этого в разделе Define Receptor поставьте галочки напротив пунктов 
Pick to identify the ligand (Molecule) и Show markers. Затем в Workspace щелкните ЛКМ 
по любому атому лиганда (рис. 4.2).

Рис. 4.2. Открытие модуля подготовки грид-бокса, определение лиганда и области стыковки
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Важно: определить область стыковки можно не только по координатам лиганда! Точ-
ки сайтов, расчитанные SiteMap [14], и координаты остатков также могут быть исполь-
зованы для этого. Однако гораздо важнее, что в случае построения сетки потенциалов  
на основе белково-лигандного комплекса малая молекула не должна учитываться 
при расчете. Указание лиганда позволяет вывести его из уравнения при генерации 
грид-бокса [13]. 

	

После определения лиганда его атомы будут подсвечены, а в Workspace отобразит-
ся область докинга в виде куба с ребрами пурпурного цвета. Центр куба соответствует 
центру масс молекулы ингибитора. Перейдите на вкладку Site. Проверьте, чтобы на-
против пункта Centroid of Workspace ligand (selected in the Receptor tab) стояла галочка. 
Откройте расширенные настройки. Установите длину ребра как «10 Å» (рис. 4.3). При 
этом в Workspace появится зеленый бокс меньшего размера, чем пурпурный. Этот бокс 
определяет область, в которой должен находиться центр масс стыкуемой молекулы, 
чтобы преодолеть начальные стадии докинга.

Рис. 4.3. Настройки области стыковки

Заметка: по мнению Адлера и коллег [15], солевой мостик, образующийся между ин-
гибитором и ASP189, наблюдаемый в кристаллической структуре комплекса, способ-
ствует эффективности лиганда. Установим ограничение именно для этой конкретной 
водородной связи.

	

Установим ограничения на образование водородных связей в ходе стыковки. 
Для удобства настоятельно советуем в панели Quick Select нажать на три точки, затем 
Residues в Interactions > Inverse. Таким образом, в структуре комплекса выделятся все 
остатки, которые не участвуют во взаимодействиях малой молекулы с рецептором. 
Скройте их.

Перейдите на вкладку Constraints > H-Bond/Metal. В Workspace выберите атом 
кислорода остатка ASP189 (рис. 4.4).
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Рис. 4.4. Создание ограничений

Запись будет добавлена в таблицу на вкладке, а сама карбоксильная группа под-
свечена. Назовите задание «glide-grid_1fjs» и нажмите Run. Расчет займет 5–6 минут.

4.3. Докинг нативного лиганда

Очистите Workspace. Выделите в Entry List заголовок нативного лиганда в группе 
split. Откройте модуль молекулярного докинга: Tasks > Browse > Receptor-Based Virtual 
Screening > Ligand Docking. В разделе Receptor grid нажмите Browse и выберите файл 
грид-бокса glide-grid_1fjs.zip. В открывшемся окне нажмите OK (рис. 4.5).

Рис. 4.5. Указание файла сетки потенциалов

Вы окажетесь на вкладке Constraints. Поставьте галочку в столбце Use напротив 
ASP 189. Теперь те позы, в которых лиганд не образует взаимодействия с этим остат-
ком, будут отброшены. Затем переместитесь на вкладку Settings, в разделе Precision 
выберите SP (standart precision), а в разделе Ligand sampling – flexible. Glide выполнит 
докинг в режиме стандартной точности с подвижным лигандом. На вкладке Output 
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поставьте галочку рядом с пунктом Compute RMSD to input ligand geometries. Расчет RMSD  
поможет нам количественно оценить, насколько точно Glide сможет воспроизвести 
кристаллическую конформацию лиганда (рис. 4.6).

Рис. 4.6. Указание ограничений, режима точности и подвижности лиганда

На вкладке Ligands выберите Files и укажите файл ligprep: -out.maegz в разделе Use 
ligands from. Измените имя задания на «glide_1FJS_cognate_Hbond» и нажмите Run. Рас-
чет на одном процессоре займет 5–10 минут (рис. 4.7).

Рис. 4.7. Запуск расчета стыковки



86

А.Ю. Кудинов, А.С. Бунев Основы молекулярного моделирования биологически активных веществ

Если позы найдены, то результаты расчета автоматически будут импортированы 
в Entry List. Первая запись лиганда в группе соответствует комплексу с самым лучшим 
значением скоринга. Нажмите на иконку рядом с заголовком группы, затем – View 
poses, в открывшейся панели Pose Viewer выберите Set Up Poses. Осмотрите сгенериро-
ванные позы.

Отразите в отчете: снимок Workspace с наложением лучшей позы среди резуль-
татов докинга и конформации кристаллического лиганда. Также приведите значения 
Docking Score, Emodel, Glide GScore и RMSD.

4.4. Докинг виртуальной библиотеки с использованием Glide

Импортируйте файл 50ligs_epik.maegz, выберите всю группу в Entry List. Осуще- 
ствите молекулярный докинг Glide с помощью модуля Ligand Docking. В разделе Use 
ligands from на вкладке Ligands выберите Project Table (selected entries). Запустите два за- 
дания Glide: одно – в режиме flexible, Glide XP (укажите Write XP Descriptor Information 
на вкладке Settings), второе –  в режиме flexible, Glide SP. Выберите на вкладке Constraints 
остаток ASP 189. Задачи назовите «glide-dock_50ligs_epik_f_XP» и «glide-dock_50ligs_
epik_f_SP» соответственно. Расчет суммарно займет не более часа. Оцените результаты 
стыковки после импорта.

Отразите в отчете:
1)	 таблицу, содержащую информацию о скоринге лигандов, для которых были 

найдены позы; значения скоринговых функций можно найти в Project Table > 
Property Tree: XP GScore и Glide GScore соответственно. Отсортируйте резуль-
таты по возрастанию значения функции (табл. 4.2).

Таблица 4.2

Результаты молекулярного докинга

XP точность SP точность

Лиганд XP GScore, ккал/моль Лиганд Glide GScore, ккал/моль

2)	 значения точности (АСС, англ. Accuracy), чувствительности (SEN, англ. Sensitivity)  
и специфичности (SPC, англ. Specificity), рассчитанные на основе результатов 
как XP, так и SP докинга. Считайте активными лиганды, обладающие значе-
ниями скоринга ≤ 7.000 ккал/моль:

, 

, 

, 
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	 где TP (англ. True positive), TN (англ. True negative), FP (англ. False positive), FN 
(англ. False negative) – число соединений, классифицированных как истин-
но-положительные, истинно-отрицательные, ложноположительные и ложно-
отрицательные, соответственно.
По вашему мнению, позволяет ли использование алгоритма Glide XP отсеи-
вать ложноположительные отклонения?

Вопросы к защите

1.	 Дайте определение понятию «молекулярный докинг».
2.	 Чем отличаются жесткий и гибкий (с точки зрения лиганда) подходы к сты-

ковке?
3.	 Дайте определение понятию «скоринговая функция».
4.	 Какие виды скоринговых функций вы знаете?
5.	 Зачем перед проведением стыковки выполнять расчет сетки потенциалов 

(грид-бокса)?
6.	 Какие требованию предъявляются к структурам лигандов и белка для выпол-

нения докинга?
7.	 Перечислите основные виды алгоритмов стыковки.
8.	 Зачем выполняется процедура нативного докинга?
9.	 Перечислите основные достоинства методов молекулярной стыковки в кон-

тексте открытия лекарств.
10.	Перечислите основные ограничения методов молекулярной стыковки в кон-

тексте открытия лекарств.
11.	Какие взаимодействия вносят наибольший вклад в энергию взаимодействия 

лиганда с белком?
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Лабораторная работа 5

ИДЕНТИФИКАЦИЯ 
САЙТА СВЯЗЫВАНИЯ

Цель работы: освоение основных подходов к поиску, аннотированию и оценке по-
тенциальных сайтов связывания в структуре белка.
Вам предстоит:
1)	 освоить инструмент оценки качества белковой структуры Protein Reliability Re- 

port; 
2)	 произвести поиск потенциальных сайтов связывания малых молекул на поверх-

ности киназного домена Bcr-ABL с помощью алгоритма SiteMap;
3)	 с помощью все того же модуля выполнить углубленную оценку одиночного сай-

та связывания;
4)	 проанализировать различия и сходства между сайтами связывания в апо- и хо-

ло-структурах киназных доменов Bcr-ABL.
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Теоретическое введение

Идентификация потенциальных мест связывания лигандов является нужной и по-
лезной процедурой в процессе структурно-ориентированного открытия лекарств как 
в случае, когда сайт связывания неизвестен, так и в случае, когда стоит задача дизайна 
аллостерического модулятора мишени.

Алгоритм SiteMap [1–3] позволяет провести быстрый, но исчерпывающий поиск  
по всей поверхности белка-мишени с целью идентификации, оценки и ранжирования 
всех потенциальных областей, в которых может связаться малая молекула.

На первом этапе SiteMap выполняет лишь обнаружение сайтов. Алгоритм поиска 
начинается с построения сетки с шагом в 1 Å вокруг всего белка или внутри области, 
выбранной пользователем. Каждая точка сетки затем классифицируется как располо-
женная «внутри» или «снаружи» рецептора путем сравнения квадратов расстояния до 
близлежащих атомов белка (по умолчанию 2.5 Å для классификации точки как рас-
положенной «внутри»). «Внешние» точки все равно исследуются для определения тех 
из них, что находятся в хорошем контакте с рецептором. Точки сетки, соответствующие 
обоим критериям, добавляются в список точек-кандидатов. Следующий шаг объеди-
няет точки в группы. Чтобы точка сайта рассматривалась как член группы, некоторое 
минимально допустимое количество точек-кандидатов (три по умолчанию) должно 
находиться в пределах заданного расстояния от нее (1.76 Å по умолчанию). Точки сай-
та, не попавшие ни в одну группу, отбрасываются. На последнем этапе группы точек 
сайта объединяются, когда длина разрыва между ними, измеряемая расстоянием наи-
большей близости, возникает в области растворителя и меньше или равна указанному 
расстоянию (6.5 Å по умолчанию).

Создание полей молекулярных взаимодействий осуществляется с помощью зон-
дов, оценивающих зависимые от расстояния электростатические и ван-дер-ваальсовы 
взаимодействия. Зонд, грубо моделирующий молекулу воды, представляет собой сфе-
ру радиусом 1.6 Å и глубиной потенциальной ямы 0.13 ккал/моль.

Сайты визуализируются на поверхности рецептора так, как показано на рисунке 
ниже (рис. 5.1).

A Б 

Рис. 5.1. Визуализация сайтов SiteMap: А – сайт связывания АТФ в каталитической субъединице PI3K𝛼 
с ингибитором (PDB ID: 5UBR [4]), показаны точки сайтов; Б – тот же сайт, но показаны 

гидрофобные области (желтые), карты доноров (синий) и акцепторов (красный) водородных связей
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Кроме того, SiteMap позволяет оценить сайты с помощью двух параметров: Site- 
Score и DScore:

, 

, 

где n – число точек сайтов, e – enclosure score, показатель «открытости» сайта для рас-
творителя, p – hydrophilic score, усредненный потенциал гидрофильности, определяе-
мый во время зондирования рецептора.

По сути, DScore является просто модифицированной версией SiteScore, параме-
тризованной на большем количестве комплексов [2, 3].

Заинтересованный читатель также может ознакомиться с работами [5, 6], в кото-
рых SiteMap используется по прямому назначению.

Экспериментальная часть

5.1. Создание проекта

В своем личном каталоге создайте папку LW5. Дважды щелкните по ярлыку 
Maestro на рабочем столе. На верхней панели перейдите на вкладку File > Change Work- 
ing Directory. В открывшемся окне укажите путь к рабочей директории LW5 в своей 
личной папке.

Затем перейдите File > Save project as, задайте проекту имя LW5 в графе File name, 
укажите путь к рабочей директории в графе Location.

5.2. Подготовка к поиску сайтов связывания

5.2.1. Подготовка структур

Выполните загрузку комплекса киназного домена Abl с иматинибом (PDB ID: 
2HYY [7]). Структура является тетрамером, удалите все цепи вместе с содержащимися 
в них лигандами, кроме цепи А.

Важно: при загрузке структуры в окне Get PDB поставьте галочку у пункта Diffraction 
data напротив Include. 

Выполним проверку «надежности» структуры с помощью модуля Protein Reliability 
Report: Tasks > Browse > Structure Analysis > Protein Reliability Report. В разделе Analyze 
выберите Region around ligand, нажмите Pick Ligand и выберите лиганд в Workspace.  
По умолчанию анализ проводится в области, удаленной от лиганда на 10 Å. Уста- 
новите Shell как «30 Å». В разделе Use diffraction data нажмите Browse и укажите путь  
к файлу 2HYY.cv, содержащему данные о значениях Fobs и прогнозируемых ошибках 
(Sigma). Измените имя задания на «2HYY_reliability_raw» и нажмите Run. Расчет займет  
не больше 5 минут. Новые записи будут добавлены в Entry List (рис. 5.2).
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Рис. 5.2. Запуск задания Protein Reliability Report

В появившемся баннере выберите Reliability Report и дождитесь открытия окна, 
затем в разделе Display results for chain выберите цепь A. Оцените проблемы, присут-
ствующие в структуре (рис. 5.3).

Рис. 5.3. Окно Protein Reliability Report
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Теперь выполните подготовку белка с помощью Protein Preparation Workflow. По-
ставьте галочку напротив пункта Fill in missing side chains using Prime в разделе Preprocess. 
Удалите кристаллографические артефакты, если они есть, но не воду. Выполните HBond 
Assigment и минимизацию (уберите все галочки в разделе Delete Waters).

Вернитесь к панели Protein Reliability Report. Включите подготовленный комплекс  
в Workspace, укажите лиганд, путь к файлу с дифракционными данными и установите 
Shell так, как делали это ранее.

Измените имя работы на «2HYY_reliability_prepared» и нажмите Run. Расчет зай-
мет не более 5 минут (рис. 5.4).

Рис. 5.4. Запуск задания Protein Reliability Report

Вновь оцените результаты с помощью диаграммы Protein Reliability Report. Об-
ратите внимание на то, что большая часть проблем была устранена, однако значение 
Binding Site RSCC (англ. Real Space Correlation Coefficient)1 все еще не находится в пре-
делах нормы. Нажав на соответствующий кружок, в правой панели вы сможете увидеть 
проблемные остатки.

Отразите в отчете: снимки экранов, на который содержатся диаграммы Protein 
Reliability Report до и после подготовки.

5.3. Анализ SiteMap

Загрузите файл рецептора в апо-форме BCRABL.mae, затем переименуйте запись 
белка как «2HYY - minimized_apo» и включите ее в Workspace.

Откройте модуль SiteMap: Tasks > Browse > Structure Analysis > Binding Site Detection. 
В разделе Task выберите Identify top-ranked potential receptor binding site. Остальные на-
стройки оставьте без изменений. Назовите задание как «sitemap-2HYY-minimized-apo»  
и нажмите Run. Расчет займет около 10 минут (рис. 5.5).

В случае успешного завершения расчета в Entry List будет добавлена новая груп-
па, каждая запись в которой соответствует идентифицированным сайтам и содержит 
точки, данные о поверхностях и областях. Сайты автоматически ранжируются от луч-
шего к худшему. Зафиксируйте в Workspace структуру комплекса и включите запись 
sitemap_2HYY-minimized-apo_site_1 (рис. 5.6).

1	 RSCC – это мера сходства между картой электронной плотности, рассчитанной непосредственно 
из структурной модели, и картой, рассчитанной на основе экспериментальных данных.
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Рис. 5.5. Запуск задания Site Map

Рис. 5.6. Наложение site1 на структуру подготовленного комплекса

Отразите в отчете:
1)	 наложение всех найденных сайтов на структуру рецептора. Для этого необхо-

димо будет прикрепить в отчет несколько снимков Workspace. Выделите запись 
комплекса, с помощью панели Style настройте отображение Ribbons, а так- 
же молекулярной поверхности (Surface). Скройте все атомы белка. Включите 
все найденные SiteMap сайты вместе со структурой белка. Подпишите сайты 
на рисунке;
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2)	 таблицу, содержащую информацию о SiteScore, DScore, Site Volume для каж-
дого из сайтов. Удается ли SiteMap ранжировать на первое место сайт связы-
вания иматиниба? Для этого сравните структуру подготовленного вами ком-
плекса с результатами анализа SiteMap для апо-формы (возможно потребуется 
выровнять белки).

Применим режим исследования конкретного сайта. Выберите в Entry List струк-
туру подготовленного комплекса. В панели SiteMap выберите Evaluate a single binding 
site region. Нажмите в Workspace на любой из атомов лиганда для определения обла-
сти сайта. Измените название работы на «sitemap_2HYY-minimized-holo», нажмите Run. 
Расчет займет 3–5 минут.

Отразите в отчете: таблицу, содержащую результаты анализа SiteMap для апо- 
и холо-структур, а также наложение карт сайтов. В чем сходства и различия сайтов 
в двух структурах (табл. 5.1)?

Таблица 5.1

Пример таблицы для сравнения результатов SiteMap

sitemap_2HYY-minimized-holo sitemap_2HYY-minimized-apo

Site Vol, Å3 SiteScore DScore Site Vol, Å3 SiteScore DScore

Вопросы к защите

1.	 Дайте определение понятию «сайт связывания».
2.	 Перечислите основные положения трех моделей, описывающих лиганд-бел-

ковые взаимодействия.
3.	 Опишите основные положения теории аллостерической модуляции.
4.	 Можно ли использовать SiteMap для обнаружения аллостерических сайтов 

связывания?
5.	 Какие зонды могут использоваться для построения полей молекулярного вза-

имодействия?
6.	 Какую оценку – SiteScore или DScore – стоит в первую очередь использовать 

для оценки сайтов?
7.	 Какие типы полей молекулярного взаимодействия рассчитывает SiteMap?
8.	 На каком этапе разработки лекарства может использоваться SiteMap?

Рекомендуемая литература

1.	 Schrödinger Release 2023-4: SiteMap. – New York : Schrödinger, 2023.
2.	 Halgren, T. A. Identifying and Characterizing Binding Sites and Assessing Drugg- 

ability // Journal of Chemical Informatics and Modeling. – 2009. – Vol. 49, № 2. – 
Р. 377–389.

3.	 Halgren, T. New Method for Fast and Accurate Binding-site Identification and Analy- 
sis // Chemical Biology & Drug Design. – 2007. – Vol. 69, № 2. – P. 146–148.

4.	 Discovery of 7-(3-(piperazin-1-yl)phenyl)pyrrolo[2,1-f][1,2,4]triazin-4-amine de- 
rivatives as highly potent and selective PI3Kδ delta inhibitors / L.-Y. Qin, Z. Ruan, 
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R. J. Cherney [et al.] // Bioorganic and Medicinal Chemistry Letters. – 2017. – Vol. 27, 
№ 4. – P. 855–861.

5.	 Structure-based assessment and druggability classification of protein–protein inter- 
action sites / L. Alzyoud, R. A. Bryce, M. Al. Sorkhy [et al.] // Scientific Reports. – 
2022. – Vol. 12. – Article number 7975.

6.	 A Computational Approach to Enzyme Design: Predicting ω-Aminotransferase Cataly- 
tic Activity Using Docking and MM-GBSA Scoring / S. Sirin, R. Kumar, C. Martinez 
[et al.] // Journal of Chemical Informatics and Modeling. – 2014. – Vol. 54, № 8. – 
Р. 2334–2346.

7.	 Structural Biology Contributions to the Discovery of Drugs to Treat Chronic Myelo- 
genous Leukaemia / S. W. Cowan-Jacob, G. Fendrich, A. Floersheimer [et al.] // 
From Molecules to Medicines : Structure of Biological Macromolecules and Its 
Relevance in Combating New Diseases and Bioterrorism / Edited by J. L. Sussman, 
P. Spadon. – Dordrecht, 2009. – P. 37–61. – (NATO Science for Peace and Security. 
Series A. Chemistry and Biology).
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Лабораторная работа 6

СОЗДАНИЕ И ФИЛЬТРАЦИЯ 
ВИРТУАЛЬНЫХ БИБЛИОТЕК 
СОЕДИНЕНИЙ

Цель работы: освоение основных подходов к созданию и подготовке виртуальных 
библиотек cоединений.
Вам предстоит: 
1)	 создать виртуальную библиотеку с помощью инструмента перечисления заме-

стителей R-Group Enumeration;
2)	 выполнить расчет физико-химических свойств, а также молекулярный докинг 

соединений набора с использованием алгоритмов QikProp и Glide соответ-
ственно;

3)	 осуществить аннотирование структур и свойств соединений, а затем провести 
фильтрацию библиотеки, применив инструмент Ligand Filtering. 
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Теоретическое введение
Начать теоретическое введение к данной работе следует с определений двух часто 

используемых в медицинской химии терминов – «виртуальная библиотека» и «хими-
ческое пространство».

Виртуальной библиотекой называют набор любых химических соединений в виде 
электронной базы. Структуры в ней могут быть представлены как в виде линейной 
нотации (.smi), так и в 2D- (.sdf) и 3D-форме (например, .maegz для файлов Maestro, 
.xyz и т. д.). Такие наборы впоследствии могут быть использованы в ходе виртуального 
скрининга, анализа QSAR, моделирования фармакофоров и т. д. [1, 2].

Сколько же соединений может быть в такой библиотеке? На момент написания 
данного лабораторного практикума электронная база данных Химической рефератив-
ной службы (англ. CAS, Chemical Abstract Service) представляет собой библиотеку, содер-
жащую примерно 204 миллиона известных органических веществ, сплавов, координа-
ционных соединений, минералов, смесей, полимеров и солей [3]. Увеличение скорости 
компьютерных вычислений и емкости памяти уже сейчас позволяет исследователям соз-
давать и подвергать скринингу виртуальные наборы, содержащие сотни миллионов струк-
тур. Хотя эти цифры кажутся большими, они составляют лишь небольшую часть от тех 
органических соединений, которые потенциально могут быть синтезированы [4]. На-
пример, Реймонд сообщил, что путем систематического вычислительного перечисления 
синтетически доступных и стабильных молекул, содержащих до 17 атомов C, S, N, O  
и галогенов, его группе удалось создать базу GDB-17 (англ.Generated database), вклю-
чающую 166.4 миллиарда структур [5, 6]. Общее же число молекул, удовлетворяющих 
правилам Липински [7], оценивается в ~1060 молекул [8]. Это больше, чем теоретически 
подсчитанное число звезд во Вселенной, и вряд ли человечеству когда-нибудь удастся ис-
следовать каждую из этих структур, даже ограничившись лишь методами молекулярного 
моделирования. Говоря об этом гипотетическом наборе соединений, обычно употребля-
ют выражение «химическое пространство лекарственноподобных соединений».

В самом широком смысле под термином «химическое пространство» понимают 
«дискретный набор возможных молекул химических соединений» [9]. Однако более 
точное определение будет звучать иначе: «химическое пространство – это множество 
химических объектов, между которыми определены отношения сходства» [10]. Два 
объекта, находящиеся рядом друг с другом в химическом пространстве, будут похожи 
(по физико-химическим свойствам, структуре или проявляемой активности – в зави-
симости от подхода к оценке подобия).

Некоторые большие коллекции органических соединений лекарственноподоб-
ных молекул представлены в табл. 6.1. Часть из них является коммерческими библио-
теками – в случае необходимости исследователи могут приобрести те структуры, кото-
рые представляют для них интерес.

Таблица 6.1

Перечень некоторых баз данных

База данных Примечание Размер Ссылка

PubChem Синтезированные молекулы из большого числа различных источников. 
Открытый доступ

116∙106 11

ChemSpider База данных Королевского химического общества. Открытый доступ 129∙106 12
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Окончание табл. 6.1

База данных Примечание Размер Ссылка

ZINC Открытое для скачивания химическое пространство соединений, 
готовых к стыковке. Большая часть молекул коммерчески доступна

1.4∙109 13

BindingDB Открытая база данных, содержащая данные об аффинности/активности 
биологически активных соединений

2.8∙106 14

ChEMEBL Открытая база данных известных соединений с аннотированием их 
мишеней, биологической активности, физико-химических свойств и т. д.

2.4∙106 15

DrugBank Аннотированная база данных одобренных лекарств 
с клиническими/ФК/ФД и др. данными. Открытый доступ

16.6∙103 16

ChemDiv Каталог коммерческих библиотек, часть которых содержит 
аннотированные скрининговые данные; база доступна для скачивания

1.6∙106 17

Enamine 
(Real Space)

Коммерчески доступное химическое пространство. Соединения в нем 
генерируются on-the-fly во время поиска, но доступны синтетически по тре- 
бованию. Поиск осуществляется через ПО BioSolveIT; Enamine предоставляет 
доступ также к другим коммерчески доступным наборам соединений

38∙109 18

Оценка сходства/несходства двух объектов химического пространства / библио- 
теки – субъективная мера хотя бы потому, что она зависит от типа молекулярного пред-
ставления: будь то физико-химические свойства, отпечатки пальцев, графы, фармако-
форы или молекулярные поверхности (рис. 6.1).

Рис. 6.1. Различные варианты представления молекул и, соответственно, подходов к оценке подобия
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Существует большое число различных метрик подобия. Самой известной из них, 
вероятнее всего, является коэффициент Танимото [19], отражающий отношение числа 
одинаковых элементов двух множеств к общему числу их элементов.

В случае графов, например, числителем в выражении для коэффициента является 
максимальная общая подструктура, а в случае фингерпринтов – одинаковые элементы 
двух векторов. С точки зрения теории множеств, определение коэффициента Танимо-
то представлено на рис. 6.2. Последнее выражение указывает на то, что данный индекс 
подобия является симметричной метрикой [20, 21].

Рис. 6.2. Графическое представление и математическое выражение 
коэффициента подобия Танимото

Некоторые другие метрики подобия/несходства, а также математические выра-
жения, соответствующие векторным представлениям химических объектов, представ-
лены в табл. 6.2.

Таблица 6.2

Метрики сходства/несходства

Метрика Математическое выражение* Ссылка

SDice

Коэффициент Дайса 22

SCos

Коэффициент косинусов 23

DEuc

Эвклидово расстояние
Метрика несходства

24

DHam

Расстояние Хэмминга
Метрика несходства

25

* a и b – число элементов (битов) бинарных векторов A и B; c – число общих элементов (битов) 
векторов; bi и ai – значения i-го дескриптора в вещественных векторах B и A соответственно.
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Разумеется, это не вся номенклатура метрик подобия. С некоторыми другими 
из них, в частности с ассиметричными индексами, вы можете познакомиться в соот-
ветствующей литературе [26].

Таким образом, немаловажным свойством, характеризующим библиотеки, яв-
ляется их разнообразие, т. е. мера структурного сходства/несходства ее компонентов 
между собой. Структурно-разнообразные наборы, охватывающие широкие области 
химического пространства, называются диверсифицированными библиотеками, и обыч-
но используются при первичном скрининге с целью идентификации хитов. Библио-
теки, содержащие похожие соединения, например имеющие один и тот же скаффолд 
или нацеленные на связывание с одной и той же мишенью, являются сфокусирован-
ными [10].

Любое соединение в библиотеке может быть описано комбинацией таких эле-
ментов, как скаффолд (англ. template, scaffold – остов, основа, ядро) – общий для со-
единений набора структурный мотив, служащий фундаментом для крепления всех 
остальных фрагментов; строительный блок (англ. building block) – вариабельная часть 
будущей молекулы, а также линкер, соединяющий их вместе (может отсутствовать). 
Точки крепления на скаффолде, линкерах и строительных блоках, как правило, марки-
руются (удобно представлять в виде структур Маркуша) (рис. 6.3).

Building Ыocks 

/�� �� /...______ �o��� 
N "t. О .rJ-
H /"1-. 

Linkers 

Template 

Рис. 6.3. Типы фрагментов, из которых могут состоять библиотеки соединений

Подходы к конструированию виртуальных библиотек многочисленны и имеются  
в том числе методы, позволяющие создать набор структур на основе сайта биомишени 
[27], но точно можно сказать, что библиотека не создается бездумным перечислени-
ем всех возможных комбинаций описанных выше фрагментов. В частности, могут от-
брасываться соединения, которые не соответствуют правилам Липински; также могут 
отбираться только те молекулы, которые смогут обеспечить заданный уровень разно-
образия. В случае если соединение не обладает желаемым значением того или иного 
физико-химического свойства, можно прибегнуть к биоизостерной замене [10].
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Помимо перечисления и отбора комбинаций фрагментов на основе маркиров-
ки точек конъюгации также можно применять подход реакционных трансформаций  
(англ. reaction-based enumeration), в ходе которого целевые молекулы библиотеки пред-
ставляют собой возможные продукты определенных реакций, для которых определя-
ются наборы возможных реагентов, содержащие вариабельные фрагменты [28].

На рис. 6.4 представлен пример составления сфокусированной библиотеки.

… … 

… 
Рис. 6.4. Принцип составления библиотек на основе reaction-based enumeration

Созданный набор должен быть подвергнут фильтрации для исключения соедине-
ний, не удовлетворяющих определенным правилам (например, правилам Липински), не-
желательных структур, структурных алертов (англ. structural alerts), а также тех cоедине-
ний, которые, как предполагается, не будут обладать должной активностью. Для решения 
последней задачи часто используют методы молекулярного докинга, анализа комплемен-
тарности формы между лигандом и сайтом мишени или фармакофорные подходы [29].

Под структурными алертами понимаются фрагменты и мотивы соединений би-
блиотеки, которые могут обусловливать нежелательную активность, токсичность или 
же приводить к неверной интерпретации результатов биологических анализов (PAINS, 
англ. Pan-assay interference compounds [30]). Удобно проводить отсеивание таких неже-
лательных лигандов на основе поиска подструктур с помощью нотаций SMARTS. Не-
которые примеры структурных алертов представлены на рис. 6.5.

На финальном этапе из полученного массива структур осуществляется отбор со-
единений в библиотеку. При этом важно соблюсти требуемый уровень структурного 
разнообразия, даже для сфокусированных наборов. Существует довольно много под-
ходов к тому, как отбирать соединения – с использованием кластерного анализа, ме-
трик разнообразия или разделения химического пространства.

В первом случае между всеми соединениями (1) рассчитываются значения попар-
ных расстояний, (2) алгоритм кластеризации разбивает структуры на определенные 
группы (кластеры), а (3) отбор нескольких соединений из каждого кластера в библио-
теку завершает процесс (рис. 6.6).
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Рис. 6.5. Структурные алерты и PAINS

Рис. 6.6. Некоторое химическое пространство, соединения в котором разбиты на 4 кластера

Как можно понять, методы, использующие кластеризацию, подразумевают пер-
воначальное разбиение исходного набора на подгруппы. Алгоритмы, основанные на 
разнообразии (DBCS, англ. Dissimilarity-based compound selection), не включают этот 
шаг и производят непосредственный отбор соединений. Типичный рабочий процесс 
в этом случае заключается в (1) выборе первой структуры и включении ее в библиоте- 
ку, (2) расчете расстояния (или другой метрики различия) между выбранной структу-
рой и соединениями исходного набора, (3) отборе соединения, наиболее непохожего 
на первое [31].

Двумя самыми распространенными методами отбора являются MaxSum (выби-
рает соединение i с максимальной суммой расстояний D до всех уже отобранных m 
соединений) и MaxMin (выбирает структуру i с максимальным расстоянием до бли-
жайшего соседа среди m соединений) [32] (рис. 6.7).
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Рис. 6.7. Отбор соединений с помощью подходов DBCS

Таким образом, MaxMin направлен на максимизацию минимального расстояния 
между любой парой различных элементов библиотеки [33], обеспечивая равномерный 
отбор молекул из химического пространства, в отличие от MaxSum, в случае исполь-
зования которого в библиотеку неизбежно будут попадать похожие соединения. С еще 
одним подходом – алгоритмом исключения сферы (англ. sphere exclusion algorithm), 
вы можете ознакомиться в [10, 32].

Основой подходов разбиения (англ. cell-based или partitioning-based methods) яв-
ляется разделение химического пространства2 на несколько областей (ячеек, англ. cell)  
и отбор из каждой одного или нескольких соединений. Ось каждого из свойств делится 
на серию диапазонов значений, чтобы дать серию «корзин» (англ. bins). Стоит отме-
тить, что «корзины» не должны быть равны по размеру, и что некоторые свойства могут 
(по крайней мере, теоретически) охватывать бесконечный диапазон (рис. 6.8).

Рис. 6.8. Разбиение химического пространства на 9 ячеек 
путем разделения каждого свойства на три диапазона значений (на три «корзины»)

2	 В данном случае речь идет обычно о низкомерном пространстве дескрипторов.
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Очевидно, что с точки зрения влияния повышения диверсифицированности соз-
даваемой библиотеки необходимо стремиться не к равномерному заполнению ячеек, 
а к заполнению наибольшего числа ячеек. Оценить равномерность заполнения можно  
с помощью такого параметра, как «энтропия» S:

,

где Ni – количество молекул в ячейке i, Nsel – количество отобранных молекул, а Ncells
 – 

общее количество ячеек в химическом пространстве [32].
Вопрос оптимизации отбора молекул из химического пространства выходит за 

рамки теоретического введения к данной работе, однако вы можете обратиться к ма-
териалам лекций, а также к [2, 10, 32] для более детального ознакомления.

В этой работе вам будет предложено самостоятельно создать библиотеки с помо-
щью перечисления строительных блоков, а затем провести фильтрацию и обогащение.

Экспериментальная часть

6.1. Создание проекта

В своем личном каталоге создайте папку LW6. Дважды щелкните по ярлыку 
Maestro на рабочем столе. На верхней панели перейдите на вкладку File > Change Work- 
ing Directory. В открывшемся окне укажите путь к рабочей директории LW6 в своей 
личной папке.

Затем перейдите File > Save project as, задайте проекту имя LW6 в графе File name, 
укажите путь к рабочей директории в графе Location.

6.2. Создание библиотеки с помощью R-Group Enumeration

6.2.1. Создание и подготовка библиотеки

Импортируйте файл Hit.maegz и включите структуру в Workspace. Включив мет-
ки атомов (Atom Labels>Element+Atom Number), выделите атом водорода H21 в пури-
новом ядре. Выбранный атом будет являться центром прикрепления всех заместите-
лей (рис. 6.9).

Откройте модуль создания библиотек R-Group Enumeration: Tasks > Browse > 
Enumeration and Ideation > R-Group Enumeration.

Заметка: R-Group Enumeration позволяет сгенерировать скрининговый набор путем 
систематического перечисления продуктов замещения выбранных пользователем 
атомов в целевом соединении на различные фрагменты. В этой работе мы будем ис-
пользовать встроенную в Schrödinger библиотеку Diverse_R-groups, однако вы всегда 
вольны создать собственную базу заместителей с помощью R-group Creator.
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Рис. 6.9. Выделение точки крепления заместителей

В открывшемся окне выберите Diverse R-groups (43) в столбце R-group Library. 
Убедитесь, что отмеченный атом Н21 отображается в качестве R1 (позиция 1). Измени-
те название задачи на «R-Group_Enumeration» и нажмите Run. Расчет обычно занимает 
не более 3 минут. Закройте панель Custom R-Group Enumeration (рис. 6.10).

Рис. 6.10. Запуск задания

По окончании расчета выделите всю группу в Workspace и выполните подготовку 
лигандов с помощью LigPrep (установите pH=7.0±2 и поставьте галочку напротив 
пункта Retain specified chiralities). Назовите работу «ligprep_enumeration». Расчет займет  
не более 6 минут.

6.2.2. Докинг библиотеки

Загрузите и подготовьте структуру комплекса CDK2/CycA (PDB ID: 5NEV [34])  
с помощью Protein Preparation Workflow в соответствии со стандартным протоколом, 
описанном в лабораторной работе 1. Удалите лишние ионы, гетероатомы и молеку-
лы, осуществите минимизацию и удаление всей воды. Обратите внимание, что данная 
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кристаллическая структура представлена в виде димера. Удалите цепи C и D. Суммар-
но расчет займет примерно 15 минут.

Рассчитайте сетку потенциалов, определив область стыковки по кристаллическо-
му лиганду и не устанавливая ограничений на взаимодействия с остатками сайта. На-
зовите задание «glide-grid_enumeration». Расчет займет 5–6 минут.

Выполните стыковку подготовленных лигандов библиотеки с помощью Ligand 
Docking. В качестве файла грида выберите полученную вами ранее сетку glide-grid_
enumeration.zip, а SP flexible – в качестве протокола точности. Назовите задание как 
«enumeration_SP». Расчет займет 10–15 минут.

6.2.3. Предсказание физико-химических свойств

Откройте модуль QikProp: Tasks > Browse > ADME and Molecular Properties > Ligand-
Based ADME/Tox Prediction. Выделите группу enumeration_SP_pv1 в Entry List. В разде-
ле выбора источника структур для предсказания (Use structures from) выберите Project 
Table (selected entries), поставьте галочку напротив пункта Fast Mode, назовите задание 
«qikprop_enumeration_1» и нажмите Run. Расчет займет несколько секунд (рис. 6.11).

Рис. 6.11. Запуск расчета свойств QikProp

Заметка: QikProp позволяет рассчитать более 20 различных физико-химических/био-
логических дескрипторов, включая LogP, проницаемость Caco-2 и log(IC50) блокиров-
ки HERG K+-каналов. Программа использует алгоритм, имитирующий моделирование 
статистической механики Монте-Карло, и регрессионный анализ для предсказания 
значений свойств. QikProp был разработан William L. Jorgensen и коллегами [35–37].

Отразите в отчете:
1)	 аннотирование свойств полученной библиотеки. Для этого получите графи-

ки распределения основных физико-химических свойств c помощью модуля 
Advanced Project Table: Task > Browse > Advanced Project Table Plotting. В каче-
стве типа графика выберите Histogram. Выделите группу, содержащую соеди-
нения библиотеки в Entry List. В открывшемся окне справа в разделе Property 
выберите QLogPo/w. Настройте цвет и ширину столбцов по своему усмотре-
нию. Полученный график сохраните. Повторите процедуру также для таких 
свойств, как PSA, acceptHB, donorHB, molMW. Включите графики в отчет. 
Прокомментируйте, все ли соединения библиотеки являются частью хими-
ческого пространства, определенного правилами Липински (рис. 6.12);
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Рис. 6.12. Построение графиков распределения физико-химических свойств

Рис. 6.13. Экспорт библиотеки в формате .csv
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2)	 структуры Маркуша для соединений библиотеки. Для этого воспользуйтесь моду-
лем R-Group Analysis: Task > Browse > R-Group Analysis. Выделите группу, содержащую 
соединения библиотеки в Entry List. В разделе Analyze structure from выберите Pro- 
ject Table (selected entries). Оставьте настройки Core definitions from по умолчанию 
и нажмите Start. Расчет займет 3–4 минуты. Окно, содержащее результаты анали-
за, откроется автоматически. В нем, выбрав Core 1 в качестве скаффолда, нажми-
те на кнопку SAR Table на нижней панели. Затем – Export CSV. Сохраните файл 
электронной таблицы, в которой будут содержаться нотации SMILES для всех за-
местителей. Используйте их для отрисовки структур в ChemDraw (рис. 6.13).

Как можно увидеть, библиотека требует фильтрации. Откройте модуль Ligand Filter- 
ing: Tasks > Browse > Ligand Preparation and Library Design > Ligand Filtering. Выберите в Entry 
List группу qikprop_enumeration_1_out, содержащую результаты расчета свойств. В разде-
ле Use structures from укажите Project Table (selected entries). В таблице Available properties, 
найдите и выберите свойство glide gscore(Impact). Затем в разделе Property установите 
значение критерия фильтрации glide_gscore < –8.5 и нажмите Add. Повторите процедуры 
для свойств RuleOfFive и PSA (RuleOfFive < 1 и PSA < 140). В разделе Filtering definitions and 
criteria должны отображаться следующие критерии фильтрации:

<-8.5 

<1 

# Filter criteria 
# 
r_i_glide_gscore 

i_qp_RuleOfFive 

r_qp_PSA <140 

Проверьте, чтобы были выбраны пункты All criteria are satisfied напротив Ligand mat- 
ches if и Retain напротив Matching ligand. Нажмите на значок шестеренки рядом с кнопкой 
Run (рис. 6.14).

<-8.5 

<1 

# Filter criteria 
# 
r_i_glide_gscore 

i_qp_RuleOfFive 

r_qp_PSA <140 

Рис. 6.14. Фильтрация лигандов



110

А.Ю. Кудинов, А.С. Бунев Основы молекулярного моделирования биологически активных веществ

В открывшемся окне Job Settings выберите Append new entries as a new group в раз-
деле Incorporate. Смените название задания на «ligfilter_enumeration_1». Нажмите Run. 
Расчет займет несколько секунд.

В результате будут отфильтрованы и импортированы только те структуры, кото-
рые показывают значение скоринга Glide SP лучше, чем –8.5 ккал/моль, соответству-
ют правилам Липински, а также имеют площадь полярной поверхности меньше 140 Å 
(рис. 6.15).

Рис. 6.15. Расширенные настройки задания

Отразите в отчете: аннотирование свойств библиотеки после фильтрации. Для 
этого получите графики распределения основных физико-химических свойств c по-
мощью модуля Advanced Project Table.

Вопросы к защите
1.	 Дайте определение понятию «виртуальная библиотека».
2.	 Дайте определение понятию «токсофор».
3.	 Почему PAINS являются нежелательными структурами? Приведите несколь-

ко примеров PAINS, поясните механизм, опосредующий возникновение лож-
ноположительных результатов.

4.	 Каким образом можно обеспечить должный уровень структурного разнообра-
зия создаваемой библиотеки?

5.	 Какие подходы к созданию виртуальных библиотек существуют?
6.	 Какие требования предъявляются к строительным блокам, используемым для 

построения библиотек?
7.	 К какому типу фильтров относится фильтр, отсеивающий соединения, содер-

жащие PAINS-фрагменты?
8.	 Как можно повысить уровень обогащения виртуальной библиотеки потенци-

ально активными соединениями?
9.	 В чем заключаются достоинства метода реакционных трансформаций в кон-

тексте создания виртуальных библиотек?
10.	Для чего в ходе создания виртуальных библиотек может применяться прием 

биоизостерной замены?
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Лабораторная работа 7

ОПТИМИЗАЦИЯ 
ВЗАИМОДЕЙСТВИЙ 
ЛИГАНДА С БЕЛКОМ

Цель работы: ознакомление с подходами к модификации соединений-хитов и ге-
нерации идей для SAR-оптимизации 
Вам предстоит: 
1)	 подготовить структуру комплекса ацетил-КоА карбоксилазы 2 с лигандом;
2)	 с помощью инструмента Ligand Designer определить направление для модифи-

кации структуры кристаллического лиганда;
3)	 сгенерировать библиотеку соединений на основе перечисления R-групп, а за-

тем осуществить ее молекулярный докинг.
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Теоретическое введение

Анализ способов связывания лиганда с рецептором играет одну из ключевых 
ролей при определении путей SAR-оптимизации. Визуально проинспектировав позу 
малой молекулы в активном сайте, вы можете обнаружить, например, незанятый ги-
дрофобный карман или аминокислотный остаток, с которым можно образовать до-
полнительное взаимодействие.

Schrödinger в своих пакетах ПО предоставляет Ligand Designer [1] – замечатель-
ный инструмент, позволяющий генерировать различные идеи для оптимизации взаи-
модействий «лиганд – мишень» путем модификаций малой молекулы и сразу же под-
вергать их проверке.

После анализа позы Ligand Designer позволяет отобразить следующие свойства:
–	 пространства для роста: свободные области между молекулярными поверх-

ностями лиганда и сайта рецептора;
–	 области растворителя;
–	 фармакофорные сайты рецептора, с которыми можно образовать взаимодей-

ствия: гидрофобные, ароматические, донорные и акцепторные признаки;
–	 стабильные и нестабильные молекулы воды (необходимо провести анализ 

WaterMap [2]) (рис. 7.1).

Рис. 7.1. Внешний вид Workspace в режиме анализа Ligand Designer: голубые области –  
пространства для роста; синие области – области растворителя; желтый пунктир – взаимодействия

Выбор пользователем какого-либо фармакофорного признака или области роста 
позволяет Ligand Designer проанализировать структуру лиганда и отметить сайты мо-
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дификации, которые будут использоваться для автоматизированного создания библио- 
теки с помощью набора R-групп. Для каждого соединения такой библиотеки затем 
будут спрогнозированы позы связывания и останутся только те малые молекулы, ко-
торые наиболее успешно заполняют свободное пространство или образуют наиболее 
выгодные целевые взаимодействия.

Кроме того, данный модуль позволяет контролировать ключевые физико-хими-
ческие свойства создаваемых соединений и проводить многопараметрическую опти-
мизацию (англ. MPO, Multi-Parameter Optimization) (рис. 7.2).

Рис. 7.2. Панель MPO

Как известно, коммерчески успешный, эффективный и безопасный препарат ха-
рактеризуется некоторым балансом параметров, включая аффинность, ADME, профиль 
безопасности. Достижение этого баланса, часто противоречивого, является серьезной 
проблемой. Таким образом, процесс открытия лекарств требует решения задач одновре-
менной оптимизации множества свойств [3]. Подходы MPO, решающие данную пробле-
му, основаны на объединении множества физико-химических, топологических и других 
параметров малой молекулы в единую оценку MPO Score.

Путь к расчету финальной оценки начинается с нормализации значений каж-
дого из свойств относительно диапазона от 0 до 1 с помощью логистической кривой 
(также называемой функцией Ферми [3] или функцией желанности, англ. desirability 
function [4]):

, 

где D и х – нормализованное и исходное значение свойства соответственно.
В простейшем случае логистическая кривая представляет собой сигмоиду, точки 

перегиба которой задаются двумя порогами (например, a и b), разделяющими значе-
ния свойства на три диапазона – желаемый (англ. good или desirable), в котором D = 1, 
пороговый (англ. marginal), в котором D монотонно убывает, и нежелательный, в кото-
ром D = 0 (рис. 7.3).
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Рис. 7.3. Логистическая кривая с двумя точками перегиба

В варианте кривой, показанной на рис. 7.3, низкие значения свойства x≤a яв-
ляются желаемыми, в таком случае показатель степени экспоненты удобнее предста-
вить в виде a(x – b). В противном же случае – в виде a(b – x). Если предпочтительным 
является диапазон значений, лежащий посередине, форма кривой должна задаваться 
четырьмя порогами (рис. 7.4).

Рис. 7.4. Кривая с четырьмя точками перегиба

Когда свойства нормализованы, каждому из них назначается вес и суммарное зна-
чение MPO Score рассчитывается как среднее геометрическое:

, 

где wi – весовой коэффициент свойства i, Di – нормализованное значение свойства i.
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Рис. 7.5. Настройки вкладов и порогов MPO

Подробнее с подходами MPO заинтересованный читатель сможет ознакомиться 
в [5]. Панель настройки функции MPO Score Ligand Designer позволяет настроить зна-
чения порогов, диапазон желаемых значений, а также важность (т. е. вес) в ручном ре-
жиме (рис. 7.5) [3].

Экспериментальная часть

7.1. Создание проекта

В своем личном каталоге создайте папку LW7. Дважды щелкните по ярлыку 
Maestro на рабочем столе. На верхней панели перейдите на вкладку File > Change Work- 
ing Directory. В открывшемся окне укажите путь к рабочей директории LW7 в своей 
личной папке.

Затем перейдите File > Save project as, задайте проекту имя LW7 в графе File name, 
укажите путь к рабочей директории в графе Location.

7.2. Оптимизация взаимодействий с использованием Ligand Designer

7.2.1. Подготовка структур белка и лиганда

С помощью модуля подготовки белка импортируйте и подготовьте комплекс аце-
тил-КоА карбоксилазы 2 (PDB ID: 5KKN [6]) в соответствии со стандартным прото-
колом. Удалите цепь B вместе с ее лигандом. Выполните сплитирование подготовлен-
ного комплекса (Into Ligands, Water, Other). Переименуйте белок и лиганд как «ACC 
Acceptor» и «ND-022» соответственно.

Подготовьте сетку потенциалов для нативного лиганда (не указывая ограничений 
на взаимодействия), а затем выполните его стыковку в активный сайт с использова-
нием протокола flexible Glide XP.
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7.2.2. Анализ Ligand Designer

Включите структуры ACC Acceptor и ND-022 в Workspace. Затем откройте модуль 
Ligand Designer: Tasks > Browse > Lead Optimization > Ligand Designer. Нажмите Analyze 
Workspace. Записи, содержащие лиганд и белок, для удобства работы будут автомати-
чески добавлены в новую группу в Workspace. Расчет займет ориентировочно две ми-
нуты (рис. 7.6).

Рис. 7.6. Запуск анализа Ligand Designer

В разделе Display выберите Ligand-Receptor Interactions, в Workspace будут добав-
лены фармакофорные сайты рецептора, которые потенциально могут образовывать 
взаимодействия с лигандом (рис. 7.7).

Рис. 7.7. Внешний вид Workspace при запуске Ligand Designer
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Выберите в Workspace фармакофорный сайт, соответствующий LYS 678, нажмите 
ОК в появившемся баннере. Можете воспользоваться Structure Hierarchy для быстро-
го поиска остатка. На бензольном кольце лиганда выберите выходной вектор так, как 
показано на рис. 7.8.

Рис. 7.8. Внешний вид Workspace при запуске Ligand Designer

Нажмите Enumerate во всплывшем баннере в верхней части Workspace. Расчет зай- 
мет 5–10 минут. (рис. 7.9).

Рис. 7.9. Запуск задания Enumeration в Ligand Designer
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Заметка: Ligand Designer выполнит достраивание лиганда с помощью библиотеки  
R-групп, а затем предскажет их ориентацию в сайте с помощью грубой стыковки; струк-
туры, позы для которых найти не удастся, будут отброшены (рис. 7.10). Нажав зна-
чок фильтра рядом с Enumerate, вы cможете отфильтровать результаты по различным 
свойствам. Щелкнув ЛКМ по значку шестеренки, вы сможете настроить библиотеку 
для перечисления. По умолчанию Ligand Designer выбирает библиотеку, созданную 
для выбранного вами типа перечисления. Если вы измените библиотеку и нажмете 
Save, то она будет сохранена в качестве библиотеки по умолчанию (а шестеренка бу-
дет выделена синим цветом, что указывает на то, что используется пользовательская 
библиотека). 

 
Рис. 7.10. Постпроцессинг Enumeration в Ligand Designer

По завершении расчета в Entry List будут добавлены лиганды, прошедшие стыков-
ку. В панели многопараметрической оптимизации (англ. Multi-Parameter Optimization, 
MPO) обратите внимание на радиальную диаграмму распределения свойств. Настроим 
относительные веса параметров, нажав на значок шестеренки в верхней правой части 
панели. В открывшейся таблице в разделе Scoring Function выберите Druglike, нажмите 
ОК. Теперь график в панели MPO будет обновлен (рис. 7.11).

Рис. 7.11. Настройки вкладов MPO
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Проведем анализ поз для достроенных лигандов. В Structure Hierarchy выберите 
LYS 678 и сфокусируйтесь на нем в Workspace. При необходимости включите отображе-
ние взаимодействий. Находясь в панели Ligand Designer, дважды нажмите на клавишу 
«стрелка вправо» – структура лиганда ND-022_1 теперь будет показана в Workspace. 
Обратите внимание, что график MPO теперь обновлен (рис. 7.12).

Рис. 7.12. Отображение лигандов для анализа поз

С помощью клавиши «стрелка вправо» вы можете поочередно включать в Work- 
space и другие лиганды, а также отмечать некоторые по своему усмотрению нажатием 
на значок звездочки (рис. 7.13).

Рис. 7.13. Выделение понравившихся лигандов

Отсортируйте лиганды, выбрав Sort by MPO и нажав Sort в разделе Post-processing. 
Выделите ND-022_3 среди отранжированных структур.

Попытаемся улучшить соединение-лидер. В разделе Display выберите 2D/3D Edit- 
ing и, находясь в режиме редактирования, замените гидроксил на аминогруппу так, как 
показано на рис. 7.14. Затем нажмите Predict Pose и закройте окно редактора.
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Рис. 7.14. Внесение изменений с помощью 2D-Sketcher

Заметка: вы можете редактировать лиганды Ligand Designer либо через 2D-Sketcher, 
либо через панель 3D-Builder. Любые изменения, внесенные вами, будут автоматиче-
ски отражаться в Workspace.

7.3. Пост-процессинг с помощью Glide XP

Выделите все лиганды, для которых Ligand Designer нашел позы (в том числе для 
оптимизированного через 2D-Sketcher), дублируйте их как несгруппированные (ПКМ > 
Duplicate > As ungrouped entries). Выполните их стыковку в ранее подготовленный вами 
грид-бокс в режиме flexible Glide XP.

Отразите в отчете:
1)	 насколько отличаются позы, предсказанные Ligand Designer от поз, предска-

занных Glide XP? В отчете приведите снимки Workspace с наложением поз, где 
лиганды должны быть выделены разными цветами, а также приведены струк-
туры соединений. Приведите значения RMSD, полученные с помощью моду-
ля Superimpose Structure. Сделайте выводы о точности предсказания способа 
связывания Ligand Designer;

2)	 таблицу следующего содержания (табл. 7.1):
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Таблица 7.1

Пример таблицы для отчета

Лиганд XP GScore, 
ккал/моль XP GScore ранг MPO Score MPO Score ранг

1 2 3 4 5

	 Cтолбцы 3 и 5 обозначают позицию лиганда в списке при сортировке по зна-
чению соответствующей функции. Изменился ли порядок ранжирования ли-
гандов? Удалось ли добиться скоринга лучше, чем у нативного лиганда?

Вопросы к защите

1.	 Какие подходы к созданию виртуальных библиотек используются в Ligand 
Designer?

2.	 На каком этапе разработки лекарств может использоваться Ligand Designer?
3.	 Дайте определение понятию «пространство для роста» (англ. grow space).
4.	 Какие физико-химические свойства используются для расчета MPO Score?
5.	 Какие заместители (в первом приближении) не стоит располагать в областях 

сайта, доступных для растворителя?
6.	 Какие фармакофорные признаки используются в Ligand Designer?
7.	 Для чего используются отсечки (threshold) в MPO скоринге?
8.	 Какие вычислительные инструменты могут быть использованы для дальней-

шей оценки «идей», полученных в результате работы с Ligand Designer?

Рекомендуемая литература

1.	 Ligand Designer // Schrödinger : [сайт]. – URL: www.schrodinger.com/science-
articles/ligand-designer/ (дата обращения: 28.11.2024).

2.	 Role of the Active-Site Solvent in the Thermodynamics of Factor Xa Ligand Binding / 
R. Abel, T. Young, R. Farid [et al.] // Journal of American Chemical Society. – 2008. – 
Vol. 130, № 9. – P. 2817–2831.

3.	 Ligand Designer : User Manual. – New York, 2023.
4.	 Moving beyond Rules: The Development of a Central Nervous System Multiparameter 

Optimization (CNS MPO) Approach To Enable Alignment of Druglike Properties /  
T. T. Wager, X. Hou, P. R. Verhoest, A. Villalobos // ACS Chemical Neuroscience. – 
2010. – Vol. 1, № 6. – P. 435–449.

5.	 Segall, M. D. Multi-Parameter Optimization: Identifying High Quality Compounds 
with a Balance of Properties // Current Pharmaceutical Design. – 2012. – Vol. 18, 
№ 9. – P. 1292–1310.

6.	 Acetyl-CoA carboxylase inhibition by ND-630 reduces hepatic steatosis, improves 
insulin sensitivity, and modulates dyslipidemia in rats / G. Harriman, J. Greenwood, 
S. Bhat [et al.] // Proceedings of the National Academy of Sciences of the United 
States of America. – 2016. – Vol. 113, № 13. – Р. 1796–1805.
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Цель работы: ознакомление с подходами к стыковке ковалентных лигандов. 
Вам предстоит: 
1)	 подготовить кристаллическую структуру человеческого катепсина L для задач ко-

валентной стыковки;
2)	 выполнить докинг нативного лиганда в режиме Pose Prediction с помощью мо-

дуля Covalent Docking;
3)	 подготовить сфокусированную библиотеку ковалентных лигандов и провести их 

стыковку в режиме Virtual Screening с помощью модуля Covalent Docking;
4)	 самостоятельно предложить ряд структурных модификаций для необратимо- 

го ингибитора EGFRT790M и проверить свои идеи с помощью ковалентной сты-
ковки.
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Теоретическое введение

Ковалентные лиганды являют собой уникальный класс биологически активных 
молекул, которые связываются с мишенью не только за счет водородных связей, соле-
вых мостиков, гидрофобных взаимодействий и т. д., но и образуют полноценную кова-
лентную связь с остатками рецептора [1].

Взаимодействие ковалентных лигандов со своими мишенями происходит в два 
этапа. На первом, как и в случае обратимо связывающихся лекарств, образуется ком-
плекс малой молекулы с рецептором, стабилизированный классическими нековалент-
ными взаимодействиями. На втором реактивный фрагмент лиганда ориентируется от- 
носительно реакционно-способной аминокислоты белка и между ними происходит 
реакция, ведущая к образованию полноценной химической связи.

Лиганд считается связывающимся необратимо, если константа скорости образо-
вания ковалентного комплекса k2 больше константы скорости диссоциации k-2 (в про-
тивном случае лекарство считается обратимым ковалентным лигандом) (рис. 8.1).

Рис. 8.1. Связывание ковалентных и нековалентных лигандов

Как правило, реактивными фрагментами лигандов являются электрофильные 
центры, такие как 𝛼, 𝛽-ненасыщенные карбонильные соединения, акриламиды, эпок-
сиды, нитрилы, цианоакрилаты и др. (рис. 8.2).

Lys, Gln, Ser, Thr, Tyr и особенно Cys представляют пул нуклеофильных аминокис-
лот, на взаимодействие с которыми могут нацеливаться ковалентные лиганды [2, 3].

В качестве примеров ковалентных лекарств можно привести осимертиниб, не-
обратимый ингибитор киназной активности рецептора эпидермального фактора рос- 
та [4], CCW-16 – ингибитор E3 убиквитинлигазы RNF4 [5], ибрутиниб, ингибитор ти- 
розинкиназы Бруттона [6] (рис. 8.3).
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Рис. 8.2. Ковалентно-реактивные группы лигандов

Рис. 8.3. Примеры лекарств, ковалентно связывающихся со своими мишенями

Фокусируясь на молекулах, нацеливающихся на остатки цистеина для необра-
тимого связывания с мишенями, можно отметить, что большая часть боеголовок обе-
спечивает образование ковалентной связи по реакции сопряженного присоедине- 
ния по Михаэлю или посредством алифатического нуклеофильного замещения (SN2). 
На рис. 8.4 представлен механизм связывания для структур, содержащих акриламид 
в качестве реактивного фрагмента.

Необратимое ингибирование как терапевтическая стратегия обеспечивает ряд пре-
имуществ перед использованием привычных нековалентных малых молекул. Так, для 
эффективного неравновесного связывания часто требуются меньшие концентрации 
биологически активного вещества. Следовательно, более мягкие режимы дозирования 
могут улучшить PK-профиль препарата. Также стоит отметить, что чувствительность 
препарата к потенциальным точечным мутациям аминокислот сайта (задействован-
ным в нековалентном связывании) обычно снижается. Более того, появляется возмож-
ность связываться в неглубоких карманах рецепторов, что потенциально расширяет 
пул мишеней, активность которых можно модулировать.
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Рис. 8.4. Связывание акриамидной боеголовки с тиольной группой Cys

Однако необратимое связывание не является предпочтительной стратегией в том 
случае, когда требуется кратковременная инактивация целевого белка.

Также следует с осторожностью относиться к реакционной способности кова-
лентных лигандов. Гиперреактивные лиганды могут быть вовлечены в нецелевое свя-
зывание и стать причиной возникновения токсических эффектов, мутаций или неже-
лательных реакций иммунной системы [7].

Так или иначе, дизайн ковалентных ингибиторов без сомнения является актуаль-
ной и развивающейся областью медицинской химии.

Однако рядовые программы стыковки не подходят для прогнозирования поз 
связывания таких лигандов из-за отсутствия алгоритмов учета образования и оценки 
энергетических вкладов образования ковалентных связей. Кроме того, в целом работа 
с реакцией между нуклеофильным остатком белка и электрофильным лигандом требует 
явного рассмотрения электронного состояния, в первом приближении не может быть 
описана классическими межмолекулярными потенциалами [8].

Тем не менее существует довольно широкий пул решений проблемы ковалент-
ной стыковки. Например, GOLD определяет атомы в лиганде и белке, которые будут 
участвовать в образовании ковалентной связи и выполняет первичный нековалентный 
докинг так, чтобы эти атомы находились рядом [9]. Autodock предлагает подход с ис-
пользованием «гибкой боковой цепи», в котором ковалентно связанный с остатком 
лиганд рассматривается как часть рецептора и минимизируется [10].

Следует также отметить, что любое ПО для ковалентной стыковки требует от поль-
зователя четкого понимания сайта (т. е. реактивного остатка) и механизма реакции 
между белком и лигандом. Алгоритм CovDock, реализованный в ПО Schrödinger, пред-
лагает следующие типы возможных реакций (табл. 8.1). Реактивные атомы лигандов, 
равно как и остатки рецептора, задаются с помощью нотаций SMARTS.

Пользователь может добавить необходимые ему реакции, если не обнаружит их 
среди предопределенных шаблонов. Кроме того, паттерны фрагментов малых молекул 
также могут быть изменены [11].

Таблица 8.1

Шаблоны реакций CovDock

Реакция SMARTS лиганда Остаток рецептора

Beta Lactam Addition [O-0X1]=[C]1[C][C][N]1

Cys, SerBoronic Acid Addition [B]([O])[O]

Conjugate Addition 
to Alkyne (aryl activated) [C]#[C]-[c]
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Окончание табл. 8.1

Реакция SMARTS лиганда Остаток рецептора

Conjugate Addition to Alkyne 
(carbonyl activated) [C-0X2]#[C-0X2][C-0X3]=[O-0X1]

Cys, Ser
Conjugate Addition to Alkene 
(nitrile activated) [C,c]=[C,c]-[C,c]#[N,n]

Disulfide Formation [S;X2;H1] –

Epoxide Opening [C;r3][O;r3][C;r3] Cys, Ser, His

Imine Condensation [C](=[O])-[C] Lys

Ion Pair to Covalent Bond Lig Minus 1,[-1] –

Ion Pair to Covalent Bond Lig Plus 1,[+1] –

Michael Addition [C,c]=[C,c]-[C,c,S,s]=[O]
Cys, Ser

Nucleophilic Addition to a Double Bond [C,c]=[O,S]

Nucleophilic Addition to a Triple Bond [C]#[N] Cys, Ser, Lys

Nucleophilic Substitution [F,Cl,Br,I] Cys, Ser, Lys

Phosphonate Addition [P]-[O;H1,-1] Cys, Ser

Рабочий процесс модуля CovDock представлен на рис. 8.5 [12, 13].

Рис. 8.5. Рабочий процесс CovDock [12]

Когда определена область стыковки, выбран реактивный остаток и тип реакции, 
выполняется первичный нековалентный докинг Glide. Чтобы избежать столкновений  
с белком и минимизировать конформационную ошибку, реактивный остаток мутируют 
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в аланин. Позиционное ограничение в Glide удерживает боеголовку лиганда в преде-
лах 8 Å от С-𝛽 атома реакционноспособного остатка. Все положения лигандов с Glide- 
Score ±2.5 ккал/моль от наименьшего значения выборки сохраняются.

Реактивный остаток мутируют обратно и для него выполняется ограниченный 
конформационный поиск, направленный на идентификацию набора стабильных ро-
тамеров. Каждый выбранный способ связывания проверяется на предмет того, нахо-
дятся ли два атома, которые в конечном итоге образуют ковалентную связь, в пределах 
5 Å друг от друга. Любая поза, не удовлетворяющая этому критерию, отбрасывается.

Ковалентный комплекс образуется, учитываются все изменения в порядке связи  
и протонировании лиганда.

Комплексы минимизируются в вакууме для восстановления нормальной длины 
связей, устранения стерических столкновений и релаксации структуры с помощью мо-
дели Prime. Повторно рассчитывается значение GlideScore в режиме score-in-place.

Эмпирическая оценочная функция основывается на усредненном GlideScore, по-
лученном на двух этапах моделируемого процесса реакции: при первичном докинге пре- 
реактивных видов лиганда и при оценке финальных поз [12].

Подробнее про применение ковалентного докинга в открытии лекарств можно 
прочитать в работах [14–16].

Экспериментальная часть

8.1. Создание проекта

В своем личном каталоге создайте папку LW8. Дважды щелкните по ярлыку 
Maestro на рабочем столе. На верхней панели перейдите на вкладку File > Change Work- 
ing Directory. В открывшемся окне укажите путь к рабочей директории LW8 в своей 
личной папке.

Затем перейдите File > Save project as, задайте проекту имя LW8 в графе File name, 
укажите путь к рабочей директории в графе Location.

8.2. Ковалентный докинг

8.2.1. Подготовка структур белка и лиганда

C помощью модуля подготовки белка импортируйте из PDB файл комплекса 
сериновой протеазы – человеческого катепсина L – вместе с лигандом (PDB ID:  
5MQY [17]). Импортируйте только цепь А. В разделе Preprocess выберите пункты Fill 
in missing loop using Prime и Cap Termini. Остальную подготовку выполните в соответ-
ствии со стандартным протоколом. Можете выбрать режим Interactive (на ваше усмо-
трение) (рис. 8.6).

В строке избранных заданий откройте Ligand Interaction Diagram для того, чтобы 
лучше познакомиться со способом связывания ковалентного лиганда. Нажатие на зна-
чок шестеренки в панели 2D Workspace – Ligand Interaction Diagram откроет доступ к ле-
генде. В структуре должна остаться вода. Не забудьте закрыть окно (рис. 8.7).
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Рис. 8.6. Подготовка структуры комплекса для ковалентной стыковки

Рис. 8.7. Диаграмма, показывающая способ связывания лиганда в сайте



131

Лабораторная работа 8. КОВАЛЕНТНЫЙ ДОКИНГ

Отразите в отчете: снимок Workspace, в котором покажите области S1-S3, ориен-
тируясь на 2D-диаграмму. Для удобства можете отобразить молекулярную поверхность 
сайта связывания, для этого в строке избранных заданий щелкните по Surface (Binding 
Site), в открывшемся окне в разделе Surface Type выберите Molecular surface, снимите га- 
лочку у пункта Ligand (чтобы сгенерировать только поверхность рецептора), Style и Color 
Scheme можете настроить на свое усмотрение. Нажмите ОК (рис. 8.8).

Рис. 8.8. Отображение молекулярной поверхности активного сайта

Импортируйте файл лиганда для докинга 5MQY_Prepared_ligand_modified.maegz 
(File > Import или Ctrl+I). Включите структуру подготовленного комплекса в Workspace 
и выберите запись лиганда в Entry List. Лиганд был модифицирован путем замены ена-
минового фрагмента на нитрил и подготовлен с использованием LigPrep.

Перейдите в модуль ковалентного докинга: Tasks > Browse > Glide > Covalent Docking. 
В открывшейся панели Covalent Docking выберите Project Table (selected entry) рядом 
с Use ligands from. В разделе выбора остатка для стыковки Reactive Residue нажмите кноп-
ку Pick и затем выберите CYS 25 в Workspace. Аминокислота подсветится в Workspace 
и A:25 появится в строке рядом с Reactive Residue. По аналогии нажмите Pick и выдели-
те нативный лиганд в разделе Centroid of Workspace ligand. Лиганд будет считан и обо-
значен как А:301. После совершения всех процедур в Workspace появится фиолетовый 
куб (похожий на тот, что создается при генерации сетки потенциалов), ограничиваю-
щий область стыковки, а остаток цистеина будет подсвечен (рис. 8.9).

Переместитесь на вкладку Reaction и выберите Nucleophilic Addition to a Triple Bond 
в качестве реакции.

Отразите в отчете: механизм образования ковалентной связи между лигандом 
и остатком CYS 25.

Переместитесь на вкладку Docking. В разделе Docking Mode выберите высокоточ-
ный режим предсказания позы (Pose Prediction (Thorough)). Установите количество поз 
лиганда равным «1» (Output poses per ligand reaction site). Измените название задания 
на «5MQY_Pose_Prediction» и нажмите Run. Расчет займет ориентировочно 20–30 ми-
нут (рис. 8.10).

В случае успешного завершения задания стыковки в Entry List будет автомати-
чески импортирована группа 5MQY_Pose_prediction-out, содержащая запись 5MQY – 
prepared_ligand modified, соответствующую комплексу, полученному в результате ко- 
валентного докинга. Включите эту структуру в Workspace. Также включите структуру 
подготовленного комплекса, который не был подвергнут стыковке. Дважды щелкните  
по панели Presets (рис. 8.11).
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Рис. 8.9. Определение реактивного остатка и лиганда для ковалентной стыковки

Рис. 8.10. Установка точности стыковки и запуск задания
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Рис. 8.11. Наложение лигандов

Отразите в отчете: снимок Workspace, демонстрирующий наложение кристалли-
ческого комплекса и комплекса, полученного после стыковки. Также приведите значе-
ния cdock_score и Prime energy.

Проведем теперь ковалентный докинг в менее точном, но быстром режиме Virtual 
Screen. Для этого первоначально создадим небольшую скрининговую библиотеку, в ко- 
торой будут перечислены различные заместители, направленные на оптимизацию свя-
зывания в области сайта S2.

Импортируйте файл template.scaffold.mae, включите в Workspace и выделите в Entry 
List структуру Template_Scaffold. Выделите атом углерода, прикрепленный к аминному 
азоту и обращенный в область S2 (рис. 8.12).

Рис. 8.12. Выделение точки прикрепления заместителей

Откройте модуль создания библиотек: Tasks > Browse > Custom R-Group. В столб-
це R-Group Library раскройте выпадающий список, выберите file и откройте файл биб- 
лиотеки CovDock_Tutorial_Ligands_for_S2_Pocket.mae. Измените название работы на 
«S2_Pocket_Enumeration» (рис. 8.13).
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Рис. 8.13. Запуск процесса создания библиотеки

Подготовим лиганды библиотеки. Выделите всю группу S2_Pocket_Enumeration. 
Откройте модуль подготовки малых молекул, выставьте настройки так, как показано 
на рисунке ниже, измените название работы на «Ligprep_Enumeration» и нажмите Run. 
Расчет займет не более 5 минут (рис. 8.14).

Рис. 8.14. Подготовка лигандов библиотеки

Отразите в отчете: аннотирование полученной библиотеки. Для этого рассчитай-
те физико-химические свойства с помощью модуля QikProp, постройте графики рас-
пределения с помощью Advanced Project Table Plot. Отразите структуры лигандов (так, 
как было описано в предыдущих работах).
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После завершения расчета приступим к ковалентной стыковке. Выделите всю  
группу ligprep_Enumeration_Prepared-out1, модифицированный лиганд 5MQY_Prepared_ 
ligand modified в Entry List, а структуру подготовленного рецептора включите в Workspace. 
Откройте модуль ковалентной стыковки. В разделе Use ligands from выберите Project 
Table (selected entry).

Все настройки определения рецептора, остатка и типа реакции остаются теми же, 
что были использованы ранее для докинга в режиме Pose Prediction. По умолчанию 
Covalent Docking запоминает их, но при необходимости самостоятельно выставьте так, 
как было описано ранее.

Переместитесь на вкладку Docking и установите в разделе Docking Mode режим 
Virtual Screening (Fast). Измените название работы на «5MQY_Virtual_Screening_S2_
Pocket». Нажмите Run. Расчет займет ориентировочно 50–70 минут. При необходи-
мости получите разрешение преподавателя на использование прегенерированных ре-
зультатов (рис. 8.15).

Рис. 8.15. Запуск задания стыковки в режиме Virtual Screening

В случае успешного завершения расчета группа, содержащая комплексы для 38 ли- 
гандов, будет импортирована в Entry List. Выделите ее и откройте модуль Pose Viewer: 
Tasks > Glide > Pose Viewer, затем нажмите Set Up Poses. Визуально осмотрите позы.

Отразите в отчете: таблицу со значениями cdock_affinity и Prime Energy. Удалось ли 
лигандам библиотеки показать лучший скоринг по сравнению с нативным? Опираясь 
на сравнение режимов связывания, ответьте на вопрос, почему удалось / не удалось.

8.2.2. Задание для самостоятельной работы

Вам предстоит выполнить стыковку небольшой библиотеки аналогов афатиниба 
(рис. 8.16) [18, 19] в активный сайт киназного домена EGFR, несущего мутацию T790M.
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Рис. 8.16. Структура афатиниба, необратимого ингибитора EGFR

Найдите в PDB комплекс мутантного EGFR с афатинибом, импортируйте его 
в Maestro и подготовьте с помощью Protein Preparation Workflow в соответствии со стан-
дартным протоколом. В разделе Preprocess выберите пункты Fill in missing loop using 
Prime и Cap Termini. Вся структурная вода и посторонние молекулы должны быть 
удалены.

Дублируйте запись подготовленного комплекса в Entry List (ПКМ > Duplicate > 
In place), затем выделите атомы, участвующие в образовании ковалентной связи между 
афатинибом и CYS 797 в Workspace, и удалите ее, используя модуль Build. С помощью 
все того же модуля восстановите структуру тиольной группы CYS 797 (рис. 8.17).

Рис. 8.17. Удаление ковалентной связи между белком и лигандом
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Сплитируйте запись дубликата и добавьте двойную связь в молекулу афатиниба, 
используя 2D-Sketcher. Выполните подготовку молекулы нативного лиганда в соответ-
ствии со стандартным протоколом, используя алгоритм LigPrep.

Осуществите нативный докинг подготовленного лиганда с помощью модуля Co- 
valent Docking. На вкладке Receptor в разделе Enclosing Box центрируйте область сты-
ковки на реактивном остатке CYS (Centroid of selected residues) и увеличьте длину ли-
гандов, которые могут быть пристыкованы (см. пункт Dock ligands with lenght), до 30 Å. 
Запустите задание в режимах Virtual Screening и Pose Prediction (для данного режима 
дополнительно выполните расчет энергии связывания с помощью MM-GBSA).

Отразите в отчете: наложение кристаллического и полученного в результате до-
кинга комплексов. Также приведите значения скоринга.

Сгенерируйте библиотеку структур для докинга с помощью модуля Custom R-Group 
Enumeration. Ваша задача – оптимизировать структуру афатиниба для повышения 
его растворимости. Самостоятельно выберите фрагмент молекулы для модификации,  
но учтите, что вносимые вами изменения не должны привести к потере способности 
образовывать ключевые взаимодействия. Вы можете использовать готовые библиоте-
ки R-Group или создать свою. При необходимости, выполните фильтрацию.

Отразите в отчете: аннотирование структур и физико-химических свойств создан-
ных вами соединений. Обязательно укажите рассчитанные QikProp значения свойств, 
характеризующих растворимость.

Осуществите ковалентный докинг соединений в активный сайт EGFR в режиме 
Virtual Screening. Номинируйте несколько соединений (не более 10) в качестве хитов. 
Свой выбор объясните. Повторно пристыкуйте отобранные лиганды к EGFR в режиме 
Pose Prediction c дополнительным выполнением оценки MM-GBSA.

Отразите в отчете: таблицу с результатами следующего содержания (табл. 8.2).

Таблица 8.2

Результаты ковалентной стыковки

Код соединения

Режим точности

Virtual Screening Pose Prediction

Prime Energy, 
ккал/моль

Prime Energy, 
ккал/моль

Cdock affinity, 
ккал/моль

MM-GBSA 𝚫Gbind, 
ккал/моль

Вопросы к защите

1.	 Зачем мутировать реактивный остаток на Ala в ходе ковалентного докинга?
2.	 Зачем в выражение для расчета CovDock Affinity включают значение GlideScore 

как до, так и после образования ковалентной связи?
3.	 Чем режим Pose Prediction отличается от режима Virtual Screening?
4.	 Какой информацией о структуре рецептора / механизме ингибирования необ-

ходимо владеть, чтобы выполнить ковалентную стыковку?
5.	 Какие достоинства стратегии ковалентного ингибирования вы можете вы- 

делить?
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6.	 Какие недостатки стратегии ковалентного ингибирования вы можете выде-
лить?

7.	 С какими аминокислотами могут образовывать связь ковалентные ингибито-
ры? С помощью каких хемотипов?

8.	 Чем ковалентные ингибиторы отличаются от нековалентных с точки зрения 
кинетики связывания?
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УЧЕТ КОНФОРМАЦИОННОЙ 
ПОДВИЖНОСТИ РЕЦЕПТОРА 
В МОЛЕКУЛЯРНОМ ДОКИНГЕ

Цели работы: освоение основных подходов к молекулярной стыковке, позволяю-
щих учесть конформационную подвижность рецептора.
Вам предстоит: 
1)	 подготовить кристаллический комплекс нитроэфирредуктазы PETN с низкомо-

лекулярным лигандом;
2)	 на основе информации о значениях температурных факторов провести стан-

дартный молекулярный докинг Glide со смягчением ван-дер-ваальсовых и элек-
тростатических потенциалов;

3)	 с помощью модуля Induced Fit Docking выполнить индуцированную стыковку.
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Теоретическое введение

Белки являются структурами, которые меняют свою конформацию под влия-
нием условий внешней среды или при взаимодействии с другими молекулами. Такая 
конформационная гибкость имеет решающее значение для многих клеточных про-
цессов, таких как передача сигналов, иммунный ответ и ферментативный катализ.

Подвижность белка во многом опосредуется термическими колебаниями его 
структуры в клеточной среде, которые происходят в широком диапазоне временных 
масштабов (от пс до с) и с различными амплитудами, включая движения основной 
и боковых цепей или даже перегруппировки целых доменов [1].

Фокусируясь на взаимодействии белков с малыми молекулами, нельзя не отме-
тить эволюцию взглядов на процесс связывания лиганда с рецептором с точки зрения 
подвижности последнего.

Концепция «замок-ключ», предложенная Фишером в 1984 году в попытках объяс-
нить явление субстратной селективности ферментов, является самой простой моделью  
и предполагает, что белки распознают «свои» лиганды за счет взаимодополняемости 
молекулярных поверхностей (форм) активных сайтов и малых молекул [2].

Однако при проведении сравнения между апо- и холо-формами ферментов мож-
но заметить порой существенные различия, что свидетельствует об изменении струк-
туры макромолекулы при формировании белок-лигандных комплексов. С учетом того, 
что и лиганд как правило характеризуется динамическим поведением, можно говорить  
о взаимной «подгонке» конформаций партнеров по связыванию друг под друга. Объ-
ясняющая такое поведение белков модель индуцированного соответствия была описана 
Кошландом в 1958 г. [3].

Наконец, в конце XX века появилась на свет концепция, предполагающая, что 
белки существуют в виде ансамбля, включающего несколько конформационных состо-
яний, между которыми колеблется белок. Причем вероятности занятия каждой из кон-
формаций определяются их относительными свободными энергиями, в соответстви 
с распределением Больцмана. Встреча с партнером по связыванию смещает распре-
деление в сторону одного или нескольких вполне определенных состояний, приводя 
к образованию конечной структуры комплекса. Эта концепция, названная моделью вы- 
бора конформаций или моделью сдвига популяции (англ. conformational-selection (popula- 
tion shift) model), постулирует, что холо-структура существует еще до события связыва-
ния [4, 5].

Схематично три описанных выше взгляда на процесс связывания лигандов с ма-
кромолекулами показаны на рис. 9.1.

Ключевой задачей вычислительных методов в контексте структурно-ориенти-
рованного дизайна лекарств является прогнозирование правильного способа связы-
вания малой молекулы в сайте биомишени. Большая часть алгоритмов стыковки на 
сегодняшний день реализует подход «жесткий рецептор – гибкий лиганд», в котором 
не учитывается конформационная подвижность белка [6]. Если структура рецептора 
существенно не меняется при связывании лиганда, то такой подход к стыковке имеет 
место быть, однако в противном случае приходится учитывать индуцированную малой 
молекулой подвижность белка.
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Рис. 9.1. Модели связывания лигандов с рецепторами. 
Адаптировано из Comprehensive Medicinal Chemistry III [1]

В некоторых случаях можно применить подход уменьшения ван-дер-ваальсовых 
радиусов атомов белка/лиганда или даже удаления некоторых боковых цепей в актив-
ном сайте, таким образом «освобождая» место для лиганда в связывающем кармане и 
снижая вероятность возникновения нежелательных столкновений (англ. clashes) [7]. 
Выбрать остатки для масштабирования или обрезки можно с помощью значений 
B-фактора, отражающего зависимые от температуры атомные вибрации, т. е. являю-
щегося мерой локальной конформационной подвижности белка (рис. 9.2).

Однако такой подход, очевидно, не позволяет получить конкретного понимания  
о белок-лигандных взаимодействиях, которые могут возникнуть в результате взаим-
ных конформационных изменений малой молекулы и мишени.

Решить проблему можно с помощью метода индуцированной стыковки (англ. 
IFD, Induced-Fit Docking), суть которого заключается в явном учете как подвижности 
лиганда, так и подвижности белка при предсказании и оценке поз.

Schrödinger Maestro включает модуль Induced-Fit Docking, позволяющий прово-
дить IF-стыковку.

Оригинальный алгоритм (Standard sampling) производит удаление некоторых бо-
ковых цепей (англ. trimming side chains) белка и смягчение потенциалов Ван-дер-Вааль-
са, таким образом предоставляя лиганду больший «простор» для размещения в сайте 
связывания. Выбор аминокислот для обрезки может происходить как автоматически 
(в зависимости от значений В-фактора, площади поверхности, доступной для сольва-
тации, наличия солевых мостиков), так и в ручном режиме.
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Рис. 9.2. Структура CDK2 (PDB ID: 1PXJ [3]): цвета петель, 
листов и спиралей, а также атомов белка отражают подвижность 

(красный – высокий B-фактор и высокая подвижность; синий – низкая)

Затем следует стыковка малой молекулы в «расширенный» сайт с помощью ал-
горитма Glide [8] с сохранением максимум 20 поз на лиганд (80 в режиме Extended 
sampling), которые проходят через процедуру предсказания конформации боковых це-
пей [9] (будет предсказана конформация всех остатков, находящихся на расстоянии 
не более чем 5 Å от лиганда). Дополнительно выполняется минимизация энергии ком-
плексов. Структура рецепторов в каждой позе теперь отражает индуцированное соот-
ветствие конформациям лигандов.

На заключительной этапе реализуется повторная стыковка Glide с генерацией 
поз, находящихся в пределах энергетического окна в 30 ккал/моль относительно луч-
ших поз, полученных после минимизации, а также расчет IFD Score:

, 

где Prime Energy соответствует энергии комплекса, полученного после предска- 
зания конформации остатков и минимизации, а Glide GScore – значение скорин- 
говой функции Glide, рассчитанное во время второй итерации докинга (рис. 9.3) 
[10, 11].

Подробнее о применении методов индуцированного докинга в процессе дизайна 
лекарств вы можете узнать, ознакомившись с работами [12–14].
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Рис. 9.3. Рабочий процесс Induced-Fit Docking

В этой работе вам будет предложено предсказать позы лигандов в сайтах бел-
ков, при этом попытавшись учесть подвижность, опосредованную индуцированным 
соответствием, как с помощью докинга со смягченными потенциалами, так и с по-
мощью IFD.

Экспериментальная часть

9.1. Создание проекта

В своем личном каталоге создайте папку LW9. Дважды щелкните по ярлыку 
Maestro на рабочем столе. На верхней панели перейдите на вкладку File > Change Work- 
ing Directory. В открывшемся окне укажите путь к рабочей директории LW9 в своей 
личной папке.

Затем перейдите File > Save project as, задайте проекту имя LW9 в графе File name, 
укажите путь к рабочей директории в графе Location.

9.2. Смягчение ван-дер-ваальсовых 
и электростатических потенциалов

C помощью модуля Protein Preparation Workflow загрузите структуру комплекса 
нитроэфирредуктазы PETN (англ. Pentaerythritol tetranitrate) в комплексе с циклогекс-
2-ен-1-оном (PDB ID: 1GVQ [15]), но не производите подготовку.

Отобразите в Workspace элементы вторичной структуры в виде лент с помощью 
панели Style. Нажмите Color Atoms и выберите Atom PDB B factor (Temperature factor). 
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Теперь структура будет раскрашена в соответствии с температурными факторами: си-
ний – низкий B-фактор, низкая подвижность и высокая определенность, красный, 
соответственно, наоборот (рис. 9.4).

Рис. 9.4. Отображение цветовой кодировки структуры в зависимости от значения B-фактора

В панели Quick Select нажмите на … и выберите пункт Binding site + Ligands. В па-

нели Style выберите  (Display only selected atoms), нажмите Apply Labels > Edit Custom

Label > Add и выберите PDB B Factor (Temperature). Теперь атомам лиганда и остатков 
сайта связывания будут присвоены метки с численными значениями температурно- 
го фактора. Скройте отображение вторичной структуры для выбранных остатков сай- 
та (рис. 9.5).

Рис. 9.5. Отображение меток атомов

Отразите в отчете: снимки Workspace, демонстрирующие целую структуру PETN 
редуктазы, а также сайта связывания отдельно в цветовой кодировке согласно значениям 
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B-фактора. Сделайте вывод о том, какие части белка характеризуются высокой степенью 
подвижности, а какие – низкой.

Важно: учитывайте, что малоподвижные остатки в ядре белка имеют значение 
B-фактора, приблизительно равное четырем, а масштабировать потенциалы ката-
литических остатков крайне нежелательно!

Подготовьте структуры белка с помощью Protein Preparation Workflow в соответ-
ствии со стандартным протоколом, описанным в лабораторной работе 1. Удалите воду  
и выполните минимизацию.

Откройте модуль генерации сетки потенциалов, определите область стыковки  
и циклогексанон в качестве лиганда. Находясь на вкладке Receptor, откройте расши-
ренные настройки Advanced Settings. Основываясь на значениях B-фактора, выберите 
остатки, потенциалы которых будут подвергнуты масштабированию (рис. 9.6).

Рис. 9.6. Генерация сетки потенциалов

В разделе Per-atom scale factors выберите Specify for selected atoms. Установите 
значение VDW scale factor равным «0.8», а Charge Scale factor – равным «1». Выберите 
остатки, для которых будет применено масштабирование. Нажмите Pick и выберите 
Residues в выпадающем списке. Выделите в Workspace выбранные вами остатки и на-
жмите ОК.

Альтернативно, можно не выбирать остатки в Workspace, а перечислить их с по-
мощью выражения ASL: уберите галочку у пункта Pick, нажмите Select, а в открывшей-
ся панели Atom Selection перейдите на вкладку Residues, где выберите Residue number 
и укажите номера интересующих вас остатков. Затем нажмите Add и ОК (рис. 9.7). Вы-
ражение ASL должно принять вид:

res.num 1, 100, 200, 1000 

Смените имя задания на «Scaled_grid» и нажмите Run. Удалите все настройки мас-
штабирования и запустите расчет для стандартной сетки потенциалов, назвав задание 
«Standard_grid». Общее время расчет займет не более 10 минут.
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Рис. 9.7. Настройки параметров масштабирования

Импортируйте структуру пикриновой кислоты (picric_acid.maegz) и дважды вы-
полните молекулярный докинг с помощью модуля Ligand Docking, используя протокол 
flexible Glide SP, указав в качестве грид-боксов созданные на предыдущем шаге сет-
ки. Задания назовите «SP_f_standard» и «SP_f_scaled» соответственно. Расчет займет 
не более 15–20 минут.

Для оценки результатов стыковки импортируйте из PDB и подготовьте (в соот-
ветствии со стандартным протоколом) структуру комплекса редуктазы PETN с пикри-
новой кислотой (PDB ID: 1GVS [16]).

Отразите в отчете:
1)	 наложение структур, полученных в результате двух запусков Glide, и кристал-

лического комплекса пикриновой кислоты с редуктазой. Лиганды обозначьте 
разными цветами, укажите значения Glide SP;

2)	 ответ на следующий вопрос: достоверно известно, что редуктаза PETN также 
способна связывать такие молекулы, как преднизолон и прогестерон. Можно 
ли будет использовать прием смягчения потенциалов в таком случае?

Заметка: для ответа на второй вопрос необходимо найти в PDB комплексы PETN с дан-
ными соединениями, импортировать и подготовить их, а затем выполнить их наложе-
ние, используя в качестве референса структуру 1GVS (с помощью модуля Binding Site 
Alignment и/или Protein Structure Alignment). Дополнительно можно провести расчет 
SiteMap (режим анализа: Single binding site) для нахождения объемов сайтов. Моти-
вируйте ответ снимками Workspace. 
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9.3. Индуцированный докинг

9.3.1. Импорт и подготовка структур

Импортируйте и подготовьте структуру комплекса CDK2 с ингибитором (PDB IDs: 
1PXJ [8]), выполнив достраивание петель с помощью Prime.

Заметка: данная запись PDB содержит структуру упомянутой выше киназы с неболь-
шим ингибитором (практически фрагментом). Достоверно известно, что оккупировать 
сайт CDK2 могут молекулы гораздо большего размера. В этой работе вам предстоит 
предсказать позу связывания лиганда CDK2, представленного на рис. 9.8 [18].

Рис. 9.8. Структура 2-оксииндол-содержащего ингибитора CDK2

C помощью модулей 2D-Sketcher и LigPrep создайте и подготовьте структуру изо-
браженного выше лиганда.

9.3.2. Выполнение индуцированной стыковки

Включите в Workspace структуру подготовленного комплекса 1KE8, а в Entry List 
выделите подготовленный лиганд. Откройте модуль индуцированной стыковки: Tasks > 
Browse > Receptor-Based Virtual Screening > Induced Fit Docking.

На вкладке Receptor в разделе Box Center определите область стыковки: выбери-
те пункт Centroid of Workspace ligand, поставьте галочку напротив Pick, а затем нажмите 
на любой атом лиганда в Workspace. Границы грид-бокса будут отображены в Workspace 
аналогично тому, как это происходит при генерации стеки потенциалов в модуле 
Receptor Grid Generation. Выберите Project Table (1 selected entry) в разделе Set Ligand 
to be docked (рис. 9.9).

Перейдите на вкладку Glide Docking для установки настроек стыковки. Выбери-
те стандартный протокол в верхней части окна. Поставьте галочку напротив пункта 
Trim Side Chains, выберите автоматический режим выбора остатков (Automatic (based on 
B-factor)) (рис. 9.10).

Переименуйте задание как «InducedFit_CDK2» и нажмите Run. Расчет на одном 
процессоре занимает около часа. С разрешения преподавателя импортируйте файл 
с готовыми результатами расчета.

Визуально осмотрите позы. Также вы можете отобразить в Entry List значения 
IFD Score, Glide GScore и Prime energy для лучшего понимания энергетики получен-
ных комплексов.
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Рис. 9.9. Настройки области стыковки

Рис. 9.10. Настройки обрезки цепей

Отразите в отчете:
1)	 ответ на следующий вопрос: удалось ли предсказать правильную позу связы-

вания для лиганда? Импортируйте и подготовьте комплекс CDK2 (PDB ID: 
1KE8), содержащий 2-оксииндольный лиганд. Выполните выравнивание крис- 
таллической и полученных в ходе IFD структур. Также отразите значение ско-
ринга и ранг позы, показывающей лучшее соответствие;

2)	 результат следующего эксперимента: попробуйте выполнить стыковку с ис-
пользованием приема смягчения потенциалов. Согласно значениям B-факто-
ра, выберите остатки для масштабирования VDW радиусов на 30 %. Приведите 
снимок Workspace с наложением полученной структуры и белкового комплек-
са из кристалла.

Вопросы к защите

1.	 Основные положения теории об индуцированном соответствии лиганда и ре-
цептора.

2.	 Объясните физический смысл B-фактора.
3.	 В чем заключаются достоинства алгоритма индуцированного докинга, пред-

ставленного в данной работе?
4.	 В чем заключаются недостатки и ограничения алгоритма индуцированного 

докинга, представленного в данной работе?
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5.	 Какие еще есть методы молекулярного моделирования, позволяющие учиты-
вать подвижность рецептора?

6.	 Из каких компонентов складывается значение скоринговой функции IFD Score?
7.	 Какие части белка наиболее сильно подвержены конформационным измене-

ниям?
8.	 Опишите алгоритм, с помощью которого осуществляется индуцированная сты-

ковка в ПО Schrödinger.
9.	 На что нужно обращать внимание при выборе боковых цепей для удаления?
10.	Какое место занимают подходы индуцированной стыковки в процессе откры-

тия лекарств?
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Лабораторная работа 10

ПРЕДСКАЗАНИЕ ЭНЕРГИИ 
СВЯЗЫВАНИЯ МЕТОДОМ MM-GBSA

Цель работы: ознакомление с методами предсказания энергии связывания лиган-
да с белком-мишенью с помощью подходов обобщенной механики Борна. 
Вам предстоит: 
1)	 подготовить структуру фактора свертывания крови Xa и провести молекуляр-

ный докинг библиотеки лигандов;
2)	 произвести расчет свободной энергии связывания на основе полученных поз 

методом MM-GBSA с помощью модуля Prime;
3)	 проанализировать соответствие рассчитанных и определенных эксперимен-

тально значений 𝛥Gbind.
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Теоретическое введение

Возможность соотнести структуру белково-лигандных комплексов (полученных, 
например, с помощью методов молекулярной стыковки) с их аффинностью связыва-
ния представляет собой задачу фундаментальной важности [1]. Однако возникает за-
кономерный вопрос: как подойти к оценке свободной энергии связывания лиганда 
с рецептором? Простой подсчет вкладов взаимодействий может не дать результатов –  
сродство не коррелирует с количеством образующихся водородных связей, площадью 
поверхности гидрофобных взаимодействий или многими другими простыми терма-
ми [2]. Кроме того, в первом приближении, расчет свободной энергии должен вклю-
чать не только оценку энтальпийного вклада в связывание (который и обусловлен 
возникновением нековалентных взаимодействий), но также и энтропийного, описы-
вающего изменение степеней свободы лиганда/рецептора при образовании комплекса  
и сольватации/десольватации:

 

, 

, 

где ∆H – изменение энтальпии, ∆S – изменение энтропии, T – абсолютная температура.
На первый взгляд кажется, что скоринговые функции (в особенности эмпири-

ческие и основанные на силовых полях) при ранжировании поз в докинге произво-
дят учет как штрафа за потерю конформационной энтропии лиганда при связывании, 
так и грубый учет растворителя [3, 4]. Однако оценки алгоритмов стыковки являют- 
ся лишь оценками и далеко не всегда коррелируют с экспериментальными значения- 
ми [5, 6] (при том что позы генерируются относительно правильно).

Довольно логичный подход к оценке ∆Gbind может быть представлен следующим 
выражением:

 

, 

, 

где Etot,PL, Etot,freeL, Etot,freeP – энергии комплекса, свободных лиганда и белка соответ-
ственно.

С учетом того, что как лиганд-белковый комплекс, так и его компоненты по от-
дельности, существуют в водной среде, необходимо производить расчет их энергий 
с учетом влияния среды.

Подход к такой оценке можно осуществлять путем явного моделирования моле-
кул растворителя (например, с помощью симуляций молекулярной динамики); однако 
следует помнить о вычислительной дороговизне таких методов [7].

Другим способом является неявное представление растворителя, основанное на 
замене реальной водной среды, состоящей из дискретных молекул, бесконечным кон-
тинуумом с определенными зависимыми от расстояний диэлектрическими свойства-
ми [8]. В таком случае выражение для расчета энергии комплекса и свободных белка 
с лигандом примет вид:

, 

, 

, 

где Evac представляет потенциальную энергию молекулы в вакууме (газовой фазе), 
а ∆Gsolv определяется как свободная энергия перехода молекулы из вакуума в раствори-
тель, т. е. свободная энергия сольватации.
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В то время как вычисление потенциальной энергии в газовой фазе не представляет 
особых проблем и осуществляется с помощью классических подходов молекулярной ме-
ханики, вопрос расчета энергии сольватации требует более подробного рассмотрения.

В общем случае ∆Gsolv можно аппроксимировать как сумму энергии сольватации не-
заряженной молекулы (∆Gnonpolar) и свободной энергии поляризации (∆Gpolar – электростати-
ческая составляющая). Неполярный вклад в общую энергию, кодирующий образование 
полости в среде растворителя, считают пропорциональным площади поверхности молеку-
лы, доступной для растворителя (англ. SASA, Solvent-accessible surface area) [9, 10]:

, 

, 

, 

где 𝜎 – коэффициент пропорциональности.
Расчет электростатической составляющей можно провести, основываясь на урав-

нении Пуассона-Больцмана [11] (англ. PB, Poisson-Boltzmann), однако его решение 
для макромолекулярных систем требует больших вычислительных затрат, а потому ис-
пользуется некоторое число аппроксимаций.

Одним из приближений является обобщенная модель Борна (англ. GB, Generalized 
Born), которая подразумевает рассмотрение молекулы растворенного вещества в ка-
честве совокупности сфер со значением внутренней диэлектрической проницаемости 
меньше, чем диэлектрическая проницаемость среды:

, 

где 𝜀in и 𝜀out – значения диэлектрической проницаемости внутри поверхности сфер 
и снаружи соответственно, q – частичные заряды на атомах i и j, rij – расстояние между 
теми же атомами, а 𝛼 –эффективные Борновские радиусы атомов, которые могут быть 
интерпретированы примерно как расстояние от каждого атома до поверхности моле-
кулы, образованной сферами [12].

Расчет эффективных радиусов Борна сильно влияет на точность модели и не бу-
дет рассмотрен здесь, но заинтересованный читатель сможет подробнее ознакомиться  
с этим вопросом в [9, 13].

Сам метод неявного учета сольватации с помощью модели Борна сокращенно 
именуют MM/GBSA (англ. Molecular Mechanics/Generalized Born surface area, молеку-
лярная механика с обобщенной моделью Борна и площадью поверхности).

Модуль Prime [14, 15], используемый в данной работе, позволяет оценить сво-
бодную энергию связывания лиганда как раз с помощью данного подхода. В каче-
стве входной структуры требуется либо экспериментально определенные координаты 
комплекса, либо поза, полученная в ходе докинга. Модель сольватации VSGB (англ. 
Variable-Dielectric Solvation Generalized Born) позволяет провести оценку энергетики 
как раз с помощью MM/GBSA:

, 

, 
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где ∑bonds – вклад энергии деформации связей, r, r0 – текущие и равновесные значе- 
ния межатомных расстояний между непосредственно связанными атомами; ∑angels – 
вклад энергии искажения валентных углов, 𝜃0 – текущие и равновесные значения  
валентных углов; ∑tors – вклад энергии искажения торсионных углов, n – период, 
𝜙, 𝛿 – текущие и равновесные значения торсионных углов; ∑electro – вклад энер-
гии всех попарных электростатических взаимодействий qi,j, rij, 𝜖 – частичные заря-
ды атомов i и j, расстояние между атомами i и j и диэлектрическая проницаемость; 
∑vdW – вклад энергии всех попарных ван-дер-ваальсовых взаимодействий Aij, Bij – 
коэффициенты вкладов отталкивания и притяжения, rij – расстояние между атома- 
ми i и j; Esol – терм, учитывающий сольватацию с помощью модели GBSA; ∑Ecorr – 
термы коррекции.

Последние позволяют точнее оценить такие взаимодействия, как, например, 
энергию водородных связей или стэкинга (пример для водородной связи – ниже):

, 

, 

где i и j – тяжелые атомы, участвующие в образовании водородной связи, r0 – 
оптимальное расстояние между атомом водорода и атомом-акцептором, 1.94 Å), 
θ0 – оптимальный угол связи, 160°), r и θ – текущая длина и угол, а 𝛼 – коэффи- 
циенты, связанные с типом тяжелых атомов, участвующих в образовании водород-
ной связи.

Подробнее о поправочных компонентах и в целом о модели VSGB можно узнать  
в оригинальной публикации [16].

В заключение стоит отметить, что значения энергии связывания, полученные ме- 
тодом MM/GBSA, не являются абсолютными и вряд ли будут четко коррелировать 
с экспериментально определенными [17], однако расчет Prime в большинстве случаев 
позволяет верно ранжировать лиганды по увеличению сродства и прекрасно подходит 
для повторного скоринга и обогащения результатов стыковки [18, 19].

Расчет абсолютных значений лучше производить методами возмущений свобод-
ной энергии (англ. FEP, Free Energy Perturbations) [20–22], которые гораздо лучше со-
относятся с экспериментами, но и гораздо более вычислительно затратны.

Экспериментальная часть

10.1. Создание проекта

В своем личном каталоге создайте папку LW10. Дважды щелкните по ярлыку 
Maestro на рабочем столе. На верхней панели перейдите на вкладку File > Change Work- 
ing Directory. В открывшемся окне укажите путь к рабочей директории LW10 в своей 
личной папке.

Затем перейдите File > Save project as, задайте проекту имя LW10 в графе File 
name, укажите путь к рабочей директории в графе Location.
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10.2. Проведение виртуального скрининга

10.2.1. Импорт и подготовка структур

Загрузите из PDB и подготовьте структуру комплекса фактора свертывания крови 
Ха (PDB ID: 2B0H [23]). Не удаляйте цепь В и ион Са2+, а затем выполните расчет сетки 
потенциалов.

Импортируйте файл leadseries_prepped.maegz, содержащий подготовленные ли-
ганды, которые будут использоваться для скрининга.

10.2.2. Первичный виртуальный скрининг с использованием Glide SP

Откройте модуль стыковки Ligand Docking, укажите Entry List (selected) в качестве 
источника лигандов и путь к файлу грид-бокса (не забудьте выделить группу leadseries_
prepped). Выполните стыковку в режиме точности SP flexible. Расчет займет не более 
часа при расчете на одном процессоре. Вы можете изменить число доступных CPU 
и число подзаданий в разделе Job Settings для уменьшения времени выполнения зада-
ния. Также вы можете использовать файл с готовыми результатами скрининга (с разре-
шения преподавателя).

Отразите в отчете:
1)	 таблицу с результатами стыковки, в которой приведите структуру соединения, 

значение Glide GScore, экспериментально определенные значения рKi [23],  
а также ранги соединений. Сортировку выполните по возрастанию значения 
скоринговой функции (табл. 10.1);

Таблица 10.1

Результаты скрининга

Номер соединения Glide GScore, 
ккал/моль

Ранг Glide 
GScore Exp. pKi

Exp Affinity,  
nM/L Ранг Exp

2)	 начения фактора обогащения EF (10%):

, 

где Nhits,10% и Nhits,100% – число молекул-хитов в первых 10 % рейтинга и общее чис-
ло хитов в наборе, Ntotal,10% и Ntotal,100% – общее число соединений в первых 10 % 
рейтинга и в наборе соответственно.

10.2.3. Оценка с помощью MM-GBSA

Проведем повторную оценку и ранжирование результатов виртуального скри-
нинга с помощью модуля предсказания энергии связывания Prime. Откройте панель 
Prime MM-GBSA: Tasks > Browse > Lead Optimization > MM-GBSA.
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В разделе Structures выберите Take complexes from a Maestro Pose Viewer file, за-
тем нажмите Browse и дважды кликните по файлу с результатами докинга. Измените 
название задания на «prime_mmgbsa_SP», нажмите Run. Расчет займет около 2 часов 
на одном процессоре. Вы можете изменить число доступных CPU и число подзадач  
в разделе Job Settings для уменьшения времени выполнения задания. Также вы може- 
те использовать файл с готовыми результатами скрининга (с разрешения преподава- 
теля) (рис. 10.1).

Рис. 10.1. Запуск расчета MM-GBSA Prime

Отразите в отчете:
1)	 дополненную столбцами со значениями MM-GBSA dGbind и рангами отно-

сительно предсказанных энергий связывания табл. 10.1. Сортировку выпол-
ните по возрастанию dGbind;

2)	 значения фактора обогащения (10 %); удалось ли добиться улучшения обога-
щения?

3)	 диаграмму рассеяния экспериментальных значений сродства (pKi) и MM-GBSA 
dGbind. Для этого воспользуйтесь модулем построения графиков в Project Table. 
Выбрав группу, содержащую результаты расчета Prime, откройте Project Table, 
затем Plots > New Scatter Plot (рис. 10.2). 
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Рис. 10.2. Модуль построения графиков и диаграмм

	 Выберите необходимые свойства для отображения на оси X и Y. Не забудьте по-
ставить галочку у пункта Best fit line. Укажите уравнение прямой и R2 в отчете.

Вопросы к защите

1.	 Чем опосредован энтальпийный вклад в свободную энергию связывания ли-
ганда?

2.	 Чем опосредован энтропийный вклад в свободную энергию связывания ли-
ганда?

3.	 В чем заключаются преимущества и недостатки явного моделирования рас-
творителя?

4.	 Из каких компонентов складывается энергия сольватации лиганда? Поясните 
смысл каждого из них.

5.	 Изложите суть подхода обобщения Борна при оценке вклада поляризации 
в энергию сольватации.

6.	 Что такое эффективный радиус Борна?
7.	 Почему значения большей части эмпирических оценочных функций не по-

зволяют верно предсказать энергию связывания, хотя термины учета сольва-
тации и энтропийные штрафы включены в уравнения, а коэффициенты вкла-
дов взаимодействий получены методами регрессии на выборках комплексов 
с экспериментально определенными значениями аффинности?

8.	 Дайте определение понятию «фактор обогащения» и приведите формулу для 
его расчета.

9.	 К какому типу оценочных функций можно отнести функцию, осуществляю-
щую расчет свободной энергии комплекса «белок – лиганд» в Prime?
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Приложение А

Таблица

Название, трехбуквенные и однобуквенные коды 
20 протеиногенных аминокислот, а также аннотирование типов 
взаимодействий, которые могут образовывать их боковые цепи 
(количество «+» показывает относительную силу того или иного 
взаимодействия)

Название Трехбуквенный 
код

Однобуквенный 
код

Гидрофобные 
взаимодействия

Водородные 
связи

Солевой 
мостик

Аланин Ala A + – –

Аргинин Arg R + +++ +++

Аспаргин Asn N – +++ –

Аспаргиновая 
кислота Asp D – ++ +++

Цистеин Cys C + + +

Глутамин Gln Q + ++ –

Глутаминовая 
кислота Glu E + ++ +++

Глицин Gly G + – –

Гистидин His H – +++ +

Лизин Lys K ++ +++ –

Лейцин Leu F +++ – –

Изолейцин Ile I +++ – –

Метионин Met M ++ – –

Фенилаланин Phe F +++ – –

Пролин Pro P ++ – –

Серин Ser S + + –

Треонин Thr T ++ + –
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Окончание таблицы

Название Трехбуквенный 
код

Однобуквенный 
код

Гидрофобные 
взаимодействия

Водородные 
связи

Солевой 
мостик

Триптофан Trp W ++ + –

Тирозин Tyr T ++ + –

Валин Val V ++ – –
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Приложение Б

Образец оформления титульного листа к бланку отчета

МИНИСТЕРСТВО НАУКИ И ВЫСШЕГО ОБРАЗОВАНИЯ РОССИЙСКОЙ ФЕДЕРАЦИИ
федеральное государственное бюджетное образовательное учреждение высшего образования

«Тольяттинский государственный университет»

Институт машиностроения, химии и энергетики
(Наименование института)

Центр медицинской химии
(Наименование кафедры, центра, департамента)

ОТЧЕТ

о лабораторной работе № __
«Название лабораторной работы»

по дисциплине
«Основы молекулярного моделирования биологически активных веществ»

Выполнил:
Студент группы	 _______________________________	 __________________________________________________________
		  Шифр группы	 Фамилия И. О.

Проверил:
Преподаватель	 _______________________________	 __________________________________________________________
		  Личная подпись	 (ученая степень (при наличии), ученое звание (при наличии),

			 
Фамилия И. О.)

Тольятти 20__
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Приложение В

Образец оформления бланка отчета

Цель работы: ознакомление с процессами анализа молекулярной динамики, освоение 
основных подходов к проведению молекулярного докинга и т. д.

Ход работы:

1.	 В личном каталоге создана новая рабочая директория 
«working_directory» и проект «working_project.prj»…

2.	 Установлена переменная среды SCHRODINGER=/opt/schrodinger…
3.	 Загружен и подготовлен комплекс мишени интереса с ингибитором 

(PDB ID: …) (добавлены атомы водорода, с помощью алгоритма Epik 
учтено состояние протонирования при рН = …)

4.	 …

Используемые модули:

Protein Preparation Workflow – подготовка белков…
Receptor Grid Generation – создание сетки потенциалов…

Cодержательная часть отчета

Ответы на поставленные вопросы, графики и диаграммы, рисунки и таблицы.

Выводы:

В ходе выполнения лабораторной работы…
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